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Foreword

Punjab School Education Board, since its inception has been engaged in an
endeavour to prepare text books on various subjects at school level. This textbook is
one in the series and is designed to focus on student-centered learning for the students
of Computer Science. The book has been developed as per recommendations of
Punjab Curriculum Framework 2013 based on National Curriculum Framework-2005,
according to which the school life of the students needs to be linked to the outside
world. The book is step forward to move from the traditional book-based learning to
activity-based learning.

The need for study of Computer Science as a subject in increasing day by day
because in the age of scientific and technological advancement computer education
improves the work efficiency in every field related to socio-economic life. With the
advancement of communication and information technology, computerization is being
done in every department. Computer Education has become mandatory to have
access to information from various departments, e-governance and internet access
in various aspects of modern life such as education, business, health, transportation
and many more.

Keeping in view such requirements, Punjab School Education Board has
implemented the guidelines of the Punjab Government to make the Computer Science
subject as a compulsory subject from Class VI to XIl. Every effort has been made to
include requisite information according to level of class Ninth in this book. Hopefully
this book will be useful for students and teachers.

Punjab School Education Board acknowledges the sincere efforts made by
writers, translators and vetters for the preparation of this book. Board also welcomes
comments and suggestions for any further improvement.

Chairman
Punjab School Education Board
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NETWORKING

,_[ Objective of this Chapter: } 5

1.1 Newwork

1.2 Need of Networking

1.3  Advantages and Disadvantages of Network
1.4 Components of Computer Networks

1.5  ‘Iypes of Netwarks

1.6 Network Topologies

1.7 Data Communication

INTRODUCTION

We have studied about working with standalone computer. Only single user can do work on
standalone computer at a time. To perform complex tasks, that may require a team work to
perform different activities to complete the task, we need to connect our computer with other
computers. Such an interconnection between computers forms a Computer Network. These
networks help us 1o communicate and share files among a group of users connected to the Network.
In this chapter, we are going to study various concepts of networking in detml.

L1 NETWORK :

A network is the group of two or more
computers that are linked in order to share
resources such as printers, files and other
resources, It also allows communication
among different users within a network,
The computers in a network may be linked
through any communication media, such
as: cables, telephone lines, radio waves,
satellites or infrared light beams. Network

is capable of sharing Software and Wodem Printur
Hurdwure resources among users within i Fig 1.2 Computer networking
network,

In general, network connections between computers ure created using cables (wires), However,
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connections can be created using radio signals (wireless / wi-fi), telephone lines (and modems)
or even for very long distances, via satellite links.
Note: A computer that is not connected {0 a network is known as a standalone computer.

1.2 NEED FOR NETWORKING: The ability to exchange data and communicate efficiently is
the main purpose of networking. Some of other common usesof Networking are given below:

Remote F‘nntlng

Qg

Privacy modes

F:te Transfer di

K / / Taamwu_rk
% @,ﬁ

Security

Remgcte Access

J

t [

Fig. 1.2 Need for Networking

—

Remote Access 1o computer or other terminals,

Ensured privacy among all the users of network.

Sharing hardware devices like printer, scanner, moderm etc.

File sharing across the network.

Sharing of software or operating programs on remote systems.

Make information easier to access and maintain among network users.
Multiple users can play games from different locations.

Multiple users can share the Internet connection.

W S g I B iR K

Communication via email, video conlerencing, instant messaging, etc.

100. Secured centrally access and backup of data among network users.
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1.3 ADVANTAGES AND DISADVANTAGES OF NETWORKS

Advantages of Networks:

Disady
.
.
.

Sharing files,data and information: You can share data, programs and different
resources with it. It is only possible because all the files are stored on server (Central
computer, Server allows sharing of these files)

Sharing Hardware and software: vou can share hardware and software within
network easily.For example. a printer can be shared among the users in a network so
that there’s no need to have individual printers for each and every computer in the
orgamzation.

Fast Communication : Network provides a very fast communication media e.g. E-
mail 18 used as a fastest way of communication in different offices.

File Integrity: File integrity remains continuous due to network. It saves much time.
Network helps in fust saving and sharing of files.

Cost effective: We can share costly input and output devices like printer with network.
Thus, it reduces the cost of system.

Reliability: Network ensures use of many resources to us ¢.2. when hardware fails,
information can be recovered from other computer with the help of network.

Flexibility: Tt provides more flexibility because there is a possibility of connecting
devices of different organizations in it.

Backup: It is difficult to get back up of a file from different computers. But it is easy
to take backup from server if we are linked with nerwork.

Security: Network provides security to ug. Network user can be restricted to access
files or applications.

Speed:Sharing and transferring files within networks is very fast which saves time
and money.

antages of Networks:

Network Failure: All the central facilities may fail due 1o network failure.
Management: For managing entire network, technical experts are required.
Security: There are security threats in a network. Data can be misused in network.

Expensive to Build: Building a network is costly. especially for Large scale
organizations. Cost of cables and other hardware equipment is very high.

1.4 COMPONENTS OF COMPUTER NETWORKS:

A computer network consists of several components. Each of these components is very important
for the proper functioning of & network. Computer network components include the major
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parts that are required to install a network both at the office and home level. Before exploring the
networking process, we should be familiar with its parts so that we could choose and buy the
right component that fitz with oor network system.

a. Computer: The purpose of a network is to interconnect computers. The first step for setting
up a network is to identify computers and users who want to participate in the network. There are
two types of computers which are used for ¢reating a network:

s Ulient: Client 15 a normal compuater sysiem. These computers are connected w a
network for shating various types of resources.

e Server: Server is a powerful computer system. It helps in sharing of resources or
information in the nerwork. It controls all other nodes within a network.

Server

Clisnt Cilient

Fig 1.3 Client/Server
Note: A Node can be a Computer, Printer, Switch, Scanner or any other device connected to the
network for sharing purpose,

b. Network Interface Card: A Network Interface Card(NIC) is a Printed Circuit Board (PCB).
It is installed on the motherboard inside a system-unit so that a computer can be connected to a
network. It should be hitted in each chent and server compuiter,

There are two types of network cards:

o  Ethernet Card: The Ethernet NIC uses Ethernet cables and connectors as a medinm
to wransfer data

e  Wireless Card: In wireless card, the connection is made using such an antenna that
employs radio wave technology.

4 B NETWORKING




Network Interface Card Wireless Card

Ethernet Cable

Etherneat Part

Fig: 1.4 Network Interface Cards

c.HUB / Switch: A networking Hub/Switch is a device that allows us to connect multiple
computers to a single network. In simplest form. a hub works by duplicating the data packets
received at one port and making it available to all other ports, therefore allowing data shanng

between all the devices connected to the hub/switch.

= §

Pri ht
rker = swl'lm Fila aarvar
21 ™ =
Falll
_H _."' '\-\.‘\.
e M et
MNuofwork wseng Muxbwark Lsiing Motwork using
Fig 1.5 Hub/Switch Fig 1.6 Network using Hub/Switch

d. Router: A router is a hardware device designed to receive, analyze and forward incoming
data within a network or to another network. 1t decides the forwarding-route for cach incoming

data-packet of the network,

Fig 1.7 Router
¢. Transmission Media: Transmission media is a communication channel that carrics the

intormation from the sender to the receiver. They are of two types:

e Guided Media: Ttis a wired media, such as Twisted Pair Cables, Coaxial Cables, and

Optical Fiber etc,
¢  Unguided Medias It is a wireless media, such as Microwave signals, Satellites etc.
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1.5 TYPES OF NETWORKS:

There are several different types of computer networks. Computer networks can be characterized
by their size as well as their purpose. The size of a network can be expressed by their geographical
arca and the number of computers that are connected to a network. Networks can cover anything
from a handful of devices within a single room to millions of devices spread across the entire
globe.

Networks may be small or large based on its size, complexity and Distribution area. On the basis
of their size, Networks can be categorized as follows:

1. PAN(Personal Area Network)

2. LAN (Local Area Network)

3. MAN (Metropolitan Area Network)

4. WAN (Wide Area network)

1.5.1 Personal Arvea Network

A Personal Area Network or PAN, is a computer network g
organized around an individual person within a single 9
building. This could be inside a small office or residence. i _."'
Personal area networks can be constructed with cables * e '
or it can be wireless. It refers to the interconnection of ' """" ' "
information technology devices or gadgets (include T
laptop computers, PDAs, cell phones, printers) within ‘ ‘@
the environment of an individual user (typically within -
10 meters).

Fig. 1.8 PAN

1.5.2 Local Area Network (LAN):

A LAN is a network that is used for
communication among computer
devices, usually within an office
building or home. LAN's enable
sharing of resources such as files or
hardware devices that may be needed
by multiple users. It is limited in size,
typically gpanning a few hundred
meters, and no more than a mile. Tt is
fast, with speeds from 10 Mbps to 10
Gbps. Tt Requires little wiring, Fig 1.9 LAN

typically a single cable connecting to

each device. Tt has lower cost compared to MAN's or WAN's, LAN's can be either wired or
wireless. Twisted pair, coaxial or fiber optic cable can be used in wired LAN’s. Tt is suitable to
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bus, ring or star topologies. Generally Coaxial Cable on Twisted Pair transmission media is
used in these networks,

1.5.3 Metropolitan Area Network (MAN);

This type of network is distributed in a city, college campus or large area just like a Cable TV
network. A MAN is optimized for a larger geographical area than a LAN, ranging from several
blocks of buildings to entire cities. A MAN might be owned and operated by a single organization,
but it usaally will be used by many individuals and organizations, Many LANs may be inter-
connected in this type of network. A MAN often acts as a high-speed network to allow sharing of
regional resources. A MAN typically covers an area of range between 5 to 30 km diameter.
Examples of MAN: Telephone company network that provides a high-speed DSL to customers
and cable TV network.

Fig 1.I0MAN Network of Building-3

1.5.4 Wide Area Network (WAN):

WAN covers a large geographical arca sach as a country. continent or even the entire world.
WAN can contain multiple smaller networks, such as LANs or MANs. In this network,various
types of communication media such as - telephone lines, satellites. microwave signals etc. are
used, These transmission media are linked with Router. Router is a device which determines the
route of information from sender to receiver. The world’s most popular Wide Area Network is
the Internet.
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1.6 NETWORK TOPOLOGIES:

Network topology is the arrangement of the elements such as links, nodes, etc.of a
ComputerNelwork. The term Topology refers to the way in which the vanous nodes or computers
of anetwork are linked together. Ii descrnibes the actual layout of the computer network hardware.
Topology determines the data paths that may be used between any pair of devices of the
network. Two or more nodes conneet to a link; and two or more links form a topology.

L

Link

between computers

Node-1

= -
MNode-2

Fig 1.11 WAN

Computer Network
Topology

de-1

_cha-a

Fig 1.12 Link vs. Topology

The selection of a Network Topology depends on the choice of media and the access method
used. The following factors are considered while selecting a topology:

Cost

Reliability
Scalability
Bandwidth capacity
Ease of installation

Ease of troubleshooting

NETWORKING




L.6.1 Types of Network Topologies:

Following figure shows the different types of topologies:

MNetwork Topologies

G ) oo o) (o) o) e

1.13 Networks Topologies

1.6.2.1 Bus Topology:

Bus Topology 15 the simplest type of network topology.In this type of topology, all the nodes
(Clients, Servers and other Devices) are connected to the single cable with the help of T-
connectors. This central cable is the backbone of the network and is known as Bus. Every
workstation communicates with other devices through this Bus. Terminators are placed at both

ends of the bus cable to prevent signal bouncing.

When a signal 18 broadcasted from the source, itis ransmitied to all other nodes connected to the
bus cable. Although the message is broadcasted, but only the intended recipient, whose MAC/IP
address matches, accepts it. If the MAC /1P address of machine doesn’t march with the intended

address, machine discards the signal.

Node-2 Node-4

P ol

s T-Connector
Terminator

Cable Wire

(Bus) R - a—

Node-3 Node-5
Fig 1.14 Bus Topology

Advantages of Bus Topology:

Any new cornputer can be attached easily,
It is a cheaper topology.
If one computer fails, others are not affected.

Cable requirement are least as compared to other network topologies.

NETWORKING



e Used in small networks.
s Itis easy to understand the layout and connectivity,
Disadvantages of Bus Topology:
*  I{ the main ceniral bus fails, the entire network breaks down.
¢  The efficiency of network is reduced with the increase in number of computers.
e Cable length is imited.
s It is slower than some other topologies.
s Terminators are required at both ends of the backbone cable
e Difficult to idenufy the problem if the entire network breaks down
1.6.2.2 Ring Topology:

In Ring Topology, all the computers are logically linked in the form of a ring. In this type of
topology, each node is connected with two adjacent (Neighboring) nodes. All wraffic travels
either clockwise or anticlockwise around the ring. Ar the time of accepting data, each node
checks its address, If address matches with the node,

node will accept it. Otherwise, data will be rejected by the node. There are two kinds of ring
topologies:

1. Single Ring - In single ring network, a single cable connects all the devices and data
travels only in one direction. Each device waite for its turn and then transmits data.
When the data reaches at its destination, another device can transmit data.

2, Dual Ring: This topology uses two rings to send the data in both directions, i.e.
clockwise and anti-clockwise. Thus, it allows more packets to be sent over the network.

Node-2

Fig 1.15 Ring Topology
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Advantages of Ring Topology:

e Very systematic network where every device has access to the data and the opportunity

to ransmit data.

e  Performs better than a bus topology under heavy network load.

e  Does not require a central node to Toanage the connectivity between the compuiers.

e [tiseasier to locate the problems with device and cable i.e. fault isolation is simplified.

If one device does not receive a signal within a specified time, it can issue an alamm.

Disadvantages of Ring Topology:
*  Failure of ene computer can affect the enore network.
¢ Difficul to troubleshoot.
*  Adding or removing Computers disrupts the network
* A ring network requires more cable than a bus network.

1.6.2.3 Star Topology:

In Star Topology, all the nodes are connected to a central device. This central device can be a
Hub, a Router or a Swiich. This Hub/Swiich 12 the central node of network and all other nodes
are connected o this cenral node. Nodes in star iopology cannot have a direct connection with

each other. They have to be linked via hub.

Node-1

HUB/Switch -

o

Node-4

- ==
Node-3

Fig 1.16 Star Topology
Advantages of Star Topology:

o [tis easy Lo setup and connect,
e  Failure of one computer does not affect the other.

*  More nodes can be connected easily.

NETWORKING
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o  [tis easier to find faults in network.
o [iasy to troubleshoot.
e [Fasy to modify.
Disadvantages of Star Topology:
o  Failure of hub results in falure of entire network.
o Cost of installation 18 high.
e Performance depends on the capacity of central device.
« (Cable requirements are more as compared to some other network topologies.

I.6.2.4 Mesh Topology:

In Mesh Topology, each node is directly connected to other nodes in the network. A mesh topology
can be a fully or partially connected mesh topology:

* In afully connected mesh topology, each computer in the network has a direct
connection to all the other computers in that network,

e In apartially connected mesh topology, at least two computers i the network have
connections to other computers in that network.

MNoda-3 Mode-4

Fig 1.17 Mesh Topology
Advantages of Mesh Topology:

* Data can be transmitted from different devices simultaneously, This topology can
withstand high traffic.

e I any of the components fails, there is always an alternate route available. So, data
transfer doesn’t get alfected.

e  Expansion and modification in topology can be done without disrupting other nodes,
Disadvantages of Mesh Topology:
e Installation and configuration process is difficult.

* (Cabling cost is more,

12 § NETWORKING



1.6.2.5 Tree Topolegy:

A Tree topology is a special type of structure where many nodes are connected in hierarchical
structure like the branches of a tree.In Computer Nerworking, tree topology is known as a
combination of a Bus and Start network topology. Tree network topology is the simplest topology
in which only one route exists between any two nodes on the network. The pattern of connection
resembles a tree in which all branches spring from one root, hence Called Tree Topology.

- e - a— - — - — ==
Node-4 Node-5 Node-6 MNode-7 Node-8

Fig 1.18 Tree Topology
Advantages of Tree Topology:
o Ttisan extension of Star and bus Topologies.
* Expansion of Network is possible and easy,

o We can divide the whole network into segments (star networks), which can be easily
managed and maintained.

e Error detection and correction is easy.
o [f one segment is damaged, other segments are not affected
Disadvantages of Tree Topology

e  Because of its basic structure, tree topology, relies heavily on the main bus cable, if
it breaks whole network goes down.

e The maintenance becomes difficult when more nodes are added.
e Scalability of the network depends on the type of cable used.
* It has higher cabling cost in setting up a tree structure.

1.6.2.6 Hybrid Topology:

A hybrid topology is a type of network topology that uses two or more other network topologies,
including bus topology, mesh topology, ring topology, star topology and tree topology.It is a
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mixture of any two or more topologies. In the following figure, Bus, Star and Tree topologies are
conngecied 1o form a Hybrid Topology.

ode-2 Node-3

Bus
== Topology
5

JNDde'ﬁ :Jnd e-9

Fig 1.19 Hybnd Topology

Advantages of Hybrid Topelogy:

e  Reliable as Error detecting and troubleshooting is easy.

e  Scalable as size can be increased easily.
Disadvantages of Hybrid Topology:

o (Complex in design.

o Costly.
1.7 DATA COMMUNICATION

Data communication is the exchange of data between two or more computers (a sender/source
and a receiver/destination) with the help of communicaton medium. The device that transmits
the data is known as sender/ source and the device that receives the transmitted data is known as
receiver/destination.Data communication must fulfil following three conditions:

1. Delivery: Network should deliver the data at intended destination,

2.  Accuracy: Data communication should be free from fault.

3. Time limit: Data should reach at destination without any delay.
1.7.1 Components of Data Communication

There can be many varieties of components that may involve in Data communication. Some of
the essential components of data communication are as follows:

1. Sender: Sender prepares information (data) and sends it

2,  Medium: It carries the information from sender Lo veceiver. It can be guided or unguided

media.
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3. Receivers: Receiver receives the information sent by the sender.

4. Protocol: These are the set of rules that manages data transmission between sender
and receiver

Medium -
Receiver

Fig 1.20 Data Communication
1.7.2 Modes of data transmission:

Modes of data transmission refer to the direction of flow of data between sender and receiver.
Modes of data transmission are given below:

Transmission
mode

r - T . 1
I Simplex | Half-Duplex | I Full-Duplex ‘
| mode mode mode .

1. Simplex: In this mode of data transmission, communication is in one direction only.
In this type of data transfer mode, only sender can broadcast information and receivers
can only receive the broadcasted information. No receiver can send any type of
information to anyone. Example: television communication.

g Uni-directional Transmission -
>

? - s —
ender Receiver
Fig 1.22 Simplex Mode

2. Hall duplex: Tn this mode of data transmission. information can flow in both directions
but not at the same time. In other words, if information is sent by one node then
second can only receive it or vice versa as shown in the following figure. Example:
walky-talky svstem used by police and army.

Bi-directional Transmission
-
‘ ——

o= - l:Dﬂ'B side ata tIITIE:I - f—
Sender Receiver

Fig 1.23 Half-duplex Mode
NETWORKING - 8 15




3. Full duplex: In this mode of dala transmission, information can be transmitied in
both directions at same time as shown in following figure. It provides fast
communication between nodes. Example: Telephone System:

Bi-directional Transmission
-~ r s

— (Both sides at a time) ——
™ =

ender Receiver

Fig 1,24 Full-Duplex Mode

POINTS TO REMEMBER

1. A network is a group of two or more computers that are linked in order to share
resources such as printers, files and olher resource.

2. A computer that is not connected to a network is known as a standalone computer.

3. A computer network consists of several components like Computer, Network Interface
Card, HUB/Switch, Router etc.

4. On the basis of 1ts area of distribution, network 1s divided into some categories like
PAN(Personal Area Network), LAN (Local Area Network), MAN (Metropolitan Area
Network) andWAN (Wide Area network).

5. Apersonal area network, or PAN, is a computer network arganized around an individual
person within a single building.

6. A LAN is anetwork that 1s used for communicating among computer devices, usually
within an office building or home.

7. AMAN is distributed to a city, college campus or large area just like Cable TV network
it is also single. Many LAN; are connected in it.

8. A WAN covers a large geographic area such as country, continent or even whole of
the world, WAN can contain multiple smaller networks such as LANs or MANS.

9. Network Topology refers to the way in which the various nodes or computers of a
network are linked together.

10. Some examples of Network Topologies are Bus, Ring. Star, Mesh, Tree and Hybnd.

11, Data communication is the exchange of data between two or more computers (a sender/
source and a receiver) with the help of communication medium.
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E3,

14.

Components of Data Communication are Sender, Medium, Receivers and Protocol.

a Hub. a Router or a Switch.

EXERCISE

Oue: 1 Muoltiple Choice Question @

I

is a group of two or more computers that are linked in order to share
resources such as printers, files, and other resources.

A, Network B. Internet
C. Wireless D. Topology
Which of the following is the smallest type of network?
A.MAN B.WAN
C.LAN D. None of these

is a device that allows you to connect multiple computers to a single
network,
A, HUB B. BUS
C. Ring D. Star
In network lopology, a single backbone cable is shared by all the devices.
A, BUS B.TREE
C.MESH D.STAR

prepares information and sends it.

A. Protocol B. Receiver
C, Sender D. Hub

Que:2 Write True/False

1
1

m
v

We cannot Share hardware or Software among network devices.
LAN covers a large geographic area.
In full duplex, information can be transmitied in both directions.

Protocols are set of rules by which data transmission takes place between nodes,
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Ome:3 Write the Full Forms:

I
m
m
IV
Vv

LAN

MAN

WAN

PAN

NIC

Que:4 Short answer type questions

I -

Write the names of any four Network Topologies.
Define Network Interface Card (NIC).

Write the name of components of data communication.
Write a short note on HUB.

What are the two types of ring topologies?

Omne:s Long Answer type guestions

I
m
m

IV

What is Network? Explain its advantages and disadvantages.

Explain the various components of computer network.
Write abowr different types of networks.
Explain the various modes of daia transmission?
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| Lab Activity |

1. Give the name of different Topologies mn the given diagram:

[[ NETWORK j

() o

2. Identify the following topology and write the name of varnious components of the
given lopology.

) (C—

[ 2 /( [—
n
Name of Topology:
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INTERNET APPLICATIONS

r—[ Objective of this Chapter: } -

2.1  Introduction to Internet

2.2 E-mail

2.3 CAPTCHA Code

2.4 Concept of Downloading and Uploading
25 Cloud Networking and Cloud Printing
2.6 Google Apps

2.7 Digi Locker

2.8 Internet Threats & Security

2.9 Cyber Crime & Cyber Ethics

21 INTRODUCTION TO INTERNET

The Internet is the global system of interconnected computer networks that communicates between
various networks and devices. It is a network of networks that consists of private, public, academic,
business, and government networks of local to global scope, linked by a broad array of electronic,
wireless, and optical networking technologies.

Internet is a worldwide collection of computer networks, cooperating with each other to exchange
data using a common software standard through telephone wires and satellite links. Internet
users can share information in a variety of forms. One can surf for any kind of information
reparding various topics such as Technology, Health & Science, Social Studies, Geographical
Information, Information Technology, Products ete. over the internet with the help of any search
engine.

Apart from communication and source of information, the internet also serves a medium for
entertainment, For example: Online Games, Songs Videos, Social Networking Apps etc, Internet
also provides a concept of electronic commerce that allows the business deals to be conducted
on clectronic systems. The Internet allows us to use many services like Internet Banking, Online
Shopping, Online Ticket Booking, Online Bill Payment, email etc.
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2.2 E-MAIL

Email, stands for “electronic mail” is one of the most commonly used features
over the Internet. It allows us to send and receive messages to and from
anvone with an email address, anywhere in the world.

Email 15 a way of sending electronic messages or data from one compuier
user lo one or more recipients. Various webmail services are as [ollows:

1.  Gmail
2. Yahoo! Mail Fig 2.1 E- mail
3. Rediff Mail
4. Hotmail
23 CAPTCHA CODE

A CAPTCHA stands for "Completely Automated Public Turing test to tell Computers and Humans
Apart”, It ig a type of test used in computing to determine whether or not the user 15 human.

CAPTCHA codes are mostly used on the signup or login pages of websites, A CAPTCHA is a
technique that proiects websites by generating and grading tesis that humans can pass but current
computer programs cannot. For example, humans can read distoried text as the one shown below,
but current computer programs can’i.

1'64& Ve

Type the characters above:

Fig 2.2 CAPTCHA

2.4 CONCEPT OF DOWNLOAD AND UPLOADING

Downloading is a process of receiving data/file from a remote computer (sérver) to the computer
of the user (client). We can use this option to download amy media from the internet such as
Study Material, E-Books, Images, Songs & Videos.

Uploading is a process of sending data/file from a local computer (client) fo a remote computer
(Server). We can upload our files like Notes, Pictures, Video Lectures etc Google Drive, Social
Media Sites, Youtube etc.
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2.5 CLOUD NETWORKING & CLOUD PRINTING

The term Cloud refers to a Network or Internet. In other words, we can say that Cloud is
something, which is present at remote location. Cloud can provide services over public and
private networks, i.e., WAN, LAN or YPN. Applications such as e-mail, web conferencing,
customer relationship management (CRM) execute on cloud.

Cloud Networking: Cloud networking refers to manipulating, configuring and accessing the
hardware and software resources remotely. It offers online data storage, infrastructure, and
application.

Fig 2.3Cloud Networking

Cloud networking offers platform independency, as the software is not required (o be installed
locally on the PC. In cloud networking it is simple (o add more hardware and software. Cloud
networking provides the ability to scale up and down when additional users are added and when
the application requirements change.

Cloud Printing:

Cloud Printing enables users to print documents and other materials on any device associated
with the cloud (network). We can connect all our devices including our computers, laptops,
tablets, phones etc. to one particular printer. We can print straight from any of the devices those
are not directly connected to the printer but connected to the cloud network using Internet.

Fig 2.4 Cloud Printing
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Cloud printing services allows the user 1o print from any web-connected device by routing print jobs
between your computer, smartphone or tablei and sends them o an intemet connecied printer. Ii also
allows users to quickly discover printers and print from their own device without the need 1o set up
driver installations. Users can create content and send the file 1o a cloud printing service provider via
whatever device they choose, which then routes the file to a cloud-attached printer at alocation selected
b the user.

2.6 GOOGLE APPS

Apps is an abbreviation for application. An app 0 o~ Q
is a picce of software/program. It can work on a
the Inteymet, on our computer or on our phone or Account search Maps

other electronic device. The word “app™ is a more

modern usage, but this is really the same thing as

—— = D
Google refers totheir online services as apps,but ~ YouTube Forms
they also sell a specific suite of services known

as Google Apps. M u '

Google Appeis a suite of Web-based applications

from Google that includes e-mail, calendar word @™ Chat

processing, spreadsheet and presentations. Let's

have alook al the common google apps: e I 3
Comtacts Drive Calendar

L.6.1 Gmail

*Google Mail’ or *Gmail’ is a [ree email service & ‘ & o

provided by Google. In many ways. Gmail is like
any other web-based emuil service: You ¢cun send
and receive emails, block spam, create an address
book, and perform other basic email tasks. Butit a B n
also has some more unique features that help o
muike it one of the most popular email services

on the Web. Fig 2.5 Google Apps

2.6.1.1 Creating new acenunt

Translate Photlos Duo

Sheets Shides

In this section, we'll study about how to get started with email by creating an account in Gmail.

Note: We ure using Chrome as our browser; however other browsers such as Internet Explorer and
Firefox will look similar,
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Follow these step-by-step instructions to create a Gmail account
s Open the internel browser.
o Type www gimail.com in the address bar:

&« C B www.gmail.com |

Google

Fig 2.6 Gmail
Note: You can also click on "Gmail® link at the top right comer of the google homepage.

_

€ 5 C f§ © wwwpoogesom LB
Google

Cusiples Saparrhs f'on Fesley) Luchoy

Fig 2.7 Google Home Page
We'll now be in the "Sign in’ section.
. o 'i_{lt
One account. All of Google.

Shgry v Lo @it ilirnen B Carsil

(ML

Pisiverwrl

T T T A T TR

o4 m®m 2 -0

Fig 2.8 Creale New Account and Sign In
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As we don’t have a Google account yet, we need to create one. Click Create an account. To set up

our new account, Google needs some information about us —

e Our first and lasiname.,

» The ‘choose your username’ is the unique email address that we wish to create, which

will be placed before * @gmail.com’.

Because it needs to be unigue, Google e
may have to check the availability of any
name that we decide on to make sure that —
no one already has it. Type an email name
into the ‘choose your username’ box, | prate 15 uoe oy et amal addess
Once we finalize our ernail address, it'sa Create 3 password
good idea o make anote of it so that we
can refer to it until we remember it. Confum your passuwerd
»  We'll need to give a password so that we
can log in securely 1o our account. We '__ ’ ~
should try to set a password with at least
8 characrers long to be secure. Use leters i
and numbers to make the password more
Pyl Wakile prone
secure and difficalt to guess. We'll need —=
to re-gnier our password in the “Confirm
i g Yorsr cLmend emadl sdaress
your password” box to ensure its
ACCUTACY.
Loz St
« Then fill Birthday (Month, Day, Year), Ursims Samtee d
Select Gender (Male/Female), Enter
Mobile phone number and any other E
e-mail address (if exist). Fig. 2.9 openi i1 acoount
Once we have completed this page fully,
clicking Next Step will take us to the next Page,
Google Ui v cnm oot i =
; )
Welcome, Test
==
B« o2 @
Fig 2,10 Continue to Gmail
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We will now have set up our account. Click “Continue to Gmail” to go to our inbox and get
started.

2.6.1.2 Log-in to Gmail account:
Follow these step-by-siep instructions to Login a Gmail account
¢  Open the miernet browser.
e Typewww.gmail com in the address bar;
e  Type the email or phone in the textbox and Click on Next button as shown in the Fig 2.11

= Type the password that you choose for your Gmail account in a textbox and the click on
Next button as shown in the Fig 2,12

Gogle Go gle
Sign n Welcome

Contirud Yo Gmall

o |

Forgot sl e LET WOldF DilaswEn @

@ sshiminghalZiSgmail,com ~

Vo pENELITE A Tt J | RGO age
Ml y ) comrpipe ¥ Ll 5 uss ivcsds o page i (eivalsly

Learm rrvane

RN — “

Fig 2.1] Login—-User ID Fig 2.12 Login—Password

2.9, 1.3 How to send E-muail?

To send an email, click
“Compose Mail" located above
the folder list. An eniry form
appears in the Gmail interface.

Fig 2.13 Compose Mail
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=1 inbox

= = ' ff B nopassoaeil.googie.comy mailf T T 1 ®inbeon T o AZ0Fc b @ T = =

Gox lglﬁ‘ | a | = O e

Gmail - - o e - -3A3 o » o

. b {3) arrrasigPornmil cam EES
Statred
Impenct at B GH R E Sy et

Sant sl Lk wh 5 i o

Orafi (2) TEXT HEREA
v Categories

¢ Circles

b
KMare =

Fig 2.14 Send Mail
The Recipients:
o In the “To:™ box, type the address of the person we want to write an email to. For
multiple recipients, separate the addresses with commas.

s  Cemeans “carbon copy”. To add/view the “Ce:" recipients, click on Cc option and type
the addresses of people who are not the main recipients of the message, but we sull want to
send a copy to.

s  Beestands for “Blind Carbon Copy™, To add/view the “Bee:” recipients, click on Bec
option and type the addresses of people we want to send a copy of the mail to, without
knowing other recipients.

The Subject:
o In “Subject:", enter the subject of the email.
Body Contents of Gmuail:

e  Type the message in the window shown below the Subject field, By default, Gmail
will send a message in HTML format. When we finish typing our mail, click the
*Send” button to send it immediately or we can save it as a draft.

Attach Mle(s) with email message:

e  Inthe new message window, click the paper-clip icon to add an attachment. From the
Open dialog box, select the {iles we wish to attach, then click “Open".We can see the
list of attachment added to our message in the message window,
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Fig 2.15 Window to Lipload an Attachment
2.6.1.4 How to Read I-mail?

All received emails are stored in the inbox. The number of unread messages is indicated to the right of
the “Inbox" folder, Gmail automatically checks if new messages arrived. To read any email, just click on
the email that appears at the right side of the Gmail Interface

By default, a single message is summed up in one line:
o  Dispatcher
=  Subject
o  The first words of the message

e Dispatch/Receiving date (or lime)

e r—

L e I T
By oy e i e o o P | gy 5 2

L T T [EEl !

Bl b s

T T Sl o= ST Ju—

RN e 1 L 1 Y S i S —
o | s [ T

e A
A S
[

VRt | e i (o PR e ST e R g e b e e

o a1
[
S, s L P it i

e

i e N S T T T mai PR e—

Fig 2,16 Reading mails
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2.6.2 Google Calendar:

Google Calendar is a time-management web application and mobile app created by Google. Users are
required to have a Google Accountin order to use this app. Google Calendar allows multiple calendars to
be created Each calendar can be shared, either read-only or with full edit control, and either with specific
people or with everyone (public calendars). Google Calendar allows users to create and edit events.
Events can have a start time and stop time, with an option for an “All-day event”. Reminders can be
enabled for events, with options available for type and time,
= a f ] way 4 0 Fobrusry 2022 a8 8 - #

=

-
2%
e ]

.......

+
i
B
L
B
Bt
2i

-------

Fig 2.17 Google Calendar
2.6.3 Google Maps:
Google Maps is a web mapping service developed by Google. Tt offers satellite imagery,

street maps, 360° panoramic views of strects (Street View), real-time traffic conditions
(GoogleTrallic), and route planning for traveling by foot, car, two-wheeler, or public

transportation. Google Maps for Android and 108 devices Google Maps
0 O e L EETY T S P a® W)
B e M e A e —_— s [ Sy
-— e m'ﬂ"
= D Wonoess | PiSessews | g | mess | @os | @ fenese | Does o *q....q ’h
- agllll R ST ] "F PRGTRL  — ie o
. - __’..uu-.. £ s #
0 oZZ=u, TS = = NS == -
e "L‘ .._. Q Sl a o s |
<. ?‘_:-:_: o h-"‘.t . _-u,:' i .:'ﬂ s
"o R of Pl b ﬁ X ‘:_
) N $ PGl T Ay e
= NS N
) W e WL B0 ¢ o e I
W b ke i nd s =k et . g -
-."'-.'.".f “i:' il / Sl ok Ern ’ o — u:.:‘—q.
l-“l o :;I.:ql:' ! 2 ‘lcl—--uhhﬂ ™ _h_::-‘; e
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Fig 2.18 Google Maps
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was released in Septerber 2008 having features GPS, urn-by-mum navigation along with dedicated
parking assistance.

1.6.4 Google Iranszlate:

Google Translate is a noultilingual neural machine translation service developed by Google, 1o translate

text, documents and websites from one language into another. Google Translate is a free service that
translates words, phrases, and web pages between English and over 100 other languages.

Gozgle = Bl

Transiyts 8
ORI T hﬂmm-m
|y e s e |0 g ot el ¥ |Rrrvend dmrdaminoplated ol
|
' I-C

g LTl ! G el 0 e AL Gy BT e Uit B e e

Fig 2.19 Google Translate
2.6.5 Google Docs

Google Docs is an online word processor that allows us to create and format text documents online.
Using google docs, we can collaborate also with other people in real time. Google Docs
allows us to create and edit text documents right in our web browser, no special software
is required. Even better, multiple people can work at the same time and we can sec
people’s changes as they make them, and every change is saved automatically.

Gl il g rem don v

Fig 2.20 Google Docs
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2.6.6 Google Sheets

Google Sheets is a web-based online spreadsheet application that enables the users
to create, update and modify spreadsheets and share the data online in real time.
Google Sheets allows us to format spreadsheets online and simultaneously work
with other people.

2.6.7 Google Slides

Google Slides is an online presentation app that allows us to show off our ideasin a
visual way, Google Slides allows us to easily collaborate and share presentations
with text, photos, audio. or video files. It can be accessed in a web browser from
any device with an internet connection.

2.6.8 Google Form

Google Forms is free online software that allows us to create surveys, quizzes, The
collected information through these forms can be automatically entered into a
spreadsheet.

2.6.9 Google Sites

Google Sites allows us o create a website without having to know how to code it
our self. The great thing about Google Sites is that we get to choose who can and
can’t access our site, So, whether we want external visitors to be able to visit our
sile or we want (o give collaborative editing privileges to certain users, we can easily
do that with just a few clicks using Google Sites.

2.6.10 Google Pholos

Google Photos is a photo sharing and storage service developed by Google.
It was announced in May 2015. It works for both Android and 108 devices,
and provides an automatic backup for our media, It organizes pictores and
videos automartically and provides also the feature of sharing media with

5
F= =%
| 4
% S

others, Google Photos
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2.6.11 Google Lens

Google Lens is an Al-powered technology that uses your smartphone camera ==
and deep machine learning to not only detect an object in front of the camera 1

|
lens, but understand it too, It can perform various actions such as scanning, .
translation, shopping, and more. Google Lens offers the following features: ‘ .
s (Google Lens facilitates to translate text by pointing our phone at
text. This can also work offline.

« liallows Smart Text Selection as we can peint our phone’s camera at text, then highlight
that text within Google Lens, and copy it to use in our phone.

« Tiallows Smart Text search as when we highlight text in Google Lens, we can also search
that text with Google. This is handy if we need to look up a definition of word, for instance.

» It works for just about any item we can think of, accessing shopping or reviews,
« Google Lens allows us o just scan the questions and come up with answers.

e Google Lens facilitates to detect and identify our surroundings.

2.6.12 Google Meet:

Google Meet is a video conferencing service from Google. It's a great solution
for both individuals and businesses to have meetings through audio and video
calls, Google Meet is available on the web, phones and tablets for Android
and iOS. Google Meet is a handy app to conduct online school classes.

Meet

2.6.13 Google Play Store:

Google Play Store is Google’s online store for use on Android-powered

smartphones, iablets, Google TV and similar devices. We can use it Lo =
purchase and download apps, music, books. movies and similar contens.

The Google Play store, which comes pre-installed on Android devices,

allows users 1o purchase, download and install applicatons from Google

and third-panty developers.

1014 Geogle Drive

Google Drive is a service offered by Google that allows us to store and
share files online. The service was launched on April 24, 2012 and provides
15 GB of free storage. Additional storage can be purchased for a monthly
fee.
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2.6.14.1 Benefits of Google Drive

Google Drive allows us to send large files to our colleagues, clients and friends directly
from our Gmail account,

Google Drive allows us to access our files remotely. With Drive, all our files become available
on the web.

Google Drive has its own mobile application which gives us acecess to our files on our
iPhone or smartphone, no matter where we are.

Google Drive has an efficient built-in search engine which allows us to find content easily
with a keyword. We can also look for files by owner or by file type.

Google Drive is equipped with an OCR (optical character recognition) function, which
allows us to search for words or expressions in scanned documents. For example,
finding someone’s name in an old newspaper article that was scanned and saved on
Google Drive is possible.

Google Drive allows users to open various types of files, like.ai (Adobe Illustrator)
and even .psd (Photoshop) files.

2.6.14.2 How to share file(s) from google drive?

1.  Open your Google Drive

2. From the list of files and folders shown on the Google Drive, Select the name of a file
or folder thai we want to share and click the share icon af the top.

& Drive [ 7= @ @ i
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3. Under “People and groups™ in the sharing box, type the email addresses of the people
or Google Groups that we want to share with. We can also scarch for contacts by
typing them into the box.
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e Share with people and groups =
Add people and groups

Abc User (you)
abc@omail com

Eend feedbich 1o Devgle m

e Get link

Restricted Only people added can open with this link ;
; . Copy link
Change to anyong with the link l

4. Choose the type of access we want to provide for these nsers by clicking the dropdown
arrow to the right of the text box:

° Share with people and groups

O - - X

B oty peopde

hessage

B How to Share @ Google Doc

T Memilemm 12 Gpuule Cancal -

Fig 2.21 Share File — Access Levels
. Editor: Users can edit the file or folder and share it with others
. Commenter: [Jsers can view and add comments to the file, but can’t edit the file.

. Viewer: Users can see the file or folder but can't edit or comment on it

5. After setting the access level, click on Send button. The users will receive an email letting
them know we've shared the file or folder with them.

6, Il we want to share multiple files at once, add the files to 4 felder in Drive and then share the
entire folder with the people we want 1o share the files.
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2.7 DIGILOCKER

Digil ocker is an Indian digitization online service provided by the Ministry
of Electronics and Information Technology (MeitY'). Government of India L
under its Digital India initiative. Digilocker provides an account in cloud
to every Aadhaar holder to access authentic documents/certificates such
as driving license, vehicle registration, academic mark sheet in digjtal format
from the original issuers of these cemificates. It also provides 1GB storage
space to each account to upload scanned copies of legacy documents. =
In the current s¢enario, the various Education Board including Punjab D Igl Locker
School Education Board also facilitates students to download their R SR TS
certificates of Class X and XII from DigiLocker and share them with Fig 222
agencies as required.

2.7.1 Ohjectives of Digital Locker

The key objectives with which the Digilocker was introduced by the Government of India are as
follows:

o  ToEnable digial empowerment among the citizens of the country.

»  Tominimize the physical usage of documents and enable the feature of e-signing by making
documenis available electronically.

« DigiLocker will increase the anthenticity of documents by online upload and reduce the
existence of fake documents.

«  Web portals and mobile applications shall be made available for casy access.
»  Reduce the administrative overhead of Government departments and agencies.

¢  With the availability of documents online on the cloud, residents can easily access the
documents anylime and anywhere.

«  Facilitates sharing of documents casily.

»  Ensure privacy and authorized access to user’s data.

28 INTERNET THREATS & SECURITY
An Intemmet threat is any threat that uses the World Wide Web to facilitate cybercrime. Intemet
threats are also known as Web threats, These threats use multiple types of malware and frauds.

Sources of these threats can be links sent by an email or malware attachments etc. Cyber criminals
steal information for subsequent sale.

INTERNET APPLICATIONS B 35



2.8.1 Internet Threats:

The Internel is indeed private and secure, but (here are 4 number
of serious security risks. Some of the common internet threats are

as follows:

Virus: VIRUS stands for Vital Information Resources
Under Siege. A computer virus is a computer program
that cause damage 10 a computer software, hardware
or data. [t can also replicate itself into other computer
programs, Once a virus 1s present on a computer, it typically performs some type of
harmful action, such as corrupting data or
files.

Fig 2.23 Virus

Spyware: Spyware is a malicious program
designed to enter our device, It collects the
data and forward it to a third party without
our consent. Once the spyware program is
installed, it starts collecting information
without our knowledge.

Some spyware programs are relatively
harmless and collect very generic
information that does not personally identify Fig 2.24 Spyware

us. Other harmful spyware programs may record our actual keysurokes, including passwords.
Such spywares may search through any of our files looking for something that looks like a
credit card number etc. These types of spyware programs can definitely be harmful.

Spyware often enters our system when we install some type of free sofiware from an
untrusted source. Since we autherized the installation, conventional protection methods,
such as antivirus software, do not
prevent spyware from getting installed
in this manner.

Trojan horse: A Trojan horse, often
shortened to Trojan, is a type of
malware designed to provide
unauthorized, remote access 1o a user's
compuier.

Trojan horses do not have the ability to
replicate themselves like viruses;
however, they cun lead to viruses being Fig 2.25 Trojan horse
installed on a machine since they allow
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the computer 1o be controlled by the Trojan creator. The term gets its name from the Greek
story of the Trojan War, when the Greeks offered the Trojans a peace oftering in the form
of alarge wooden horse. However, once the Trojans wheeled the horse behund their closed
gates and might fell, the soldiers hidden

inside the horse climbed cutand opened  gosmsnsnn T

Lo@ @ e
the city gates, allowing the Greek army o | g
infiltrate Troy and capture the city. hien 1 h
Trojan horse sofiware operaies the same E E ; E E ? i
way, where Trojan is our computerand = =8 iy
the horse is the malware application. e =t | o
Phishing Scams: Phishing is an ¢-mail E 5 E : .:.':', E

traud method in which the wrongdoer o s s

send legitimate-looking email in an attempt - A

to gather personal and financial

o T g Fig 2.26 Phishing Scam

These messages appear to come from well-known and truseworthy Web sites, The message
tricks people into providing sensitive information, such as their login details. A typical scam
consists of a message that describes some issue with our account and requires us to login to
our account to confirm something. The message looks very official, using logos and formal
language, just like we would expect from a genuine source. When we follow the link, the
webpage looks very real - but if we look closely, the Internet address is actually not the
official one. Financial institations don't send out these types of messages.

2.8.2 Internetl Security:

By the mean of Internet Security, we refer to the software or preventive measures which are used o
protect our computer from the internet threats like malicious activities, Some of the common wols and
techniques used for this purpose are given below:

Anti-virns: The best way to deal with the intemet threats such as a computer virus is to use
antivirus sofrware, Antivirus software helps to protect a computer system from viruses and
other harmful programs. One of the most common ways to get a virus on our compuier is to
download a file from the Intemet that is infected. Antivirus software scans our online activity
to make sure we are not downloading infected files. Antivirus software also helps to detect
and remove viruses from our computer system if we do get infected. Some of the commonly
used antivirus are Norton, Kaspersky, Avira, Avast. Mcafee etc.

Anti-Spyware: Anti-spyware is a type of software that is effective to detect and remove
unwanted spyware programs. Removing spyware can be difficult as often the program
installs itself again as quickly as we delete it. To counter spyware, we need (o use a
dedicated spyware management tool. Some antivirus softwares are bundled with the
spyware management tools.
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»  Prevention from Trajan Horse: To keep our system safe from Trojan horses, we should
never download or install sofiware from a source we don’t trust upon, Never open an
attachment of run a program received via email from unknown or onfrusted sources. Make
sure a Trojan antivirus is installed on our computer and having a valid license.

o  Prevention from Phishing Scam: In order to protect yourself from these Phishing Scams,
don’t follow the link and login only from the official website.

29 CYBER CRIME & CYBER ETHICS
2.9.1 Cyber Crime:

Cybercrime is a crime thal involves a computer
and a network, The computer may have been
used to commmit the crime and in many cases, it
is also the target. Cybercrime may threaten a
person or a naiion’s security and financial health.
Cyber Crime is an unlawful act wherein the
computer is either a tool or a target or both.
Cyber Crimes can involve criminal activities that
are traditional in nature, such as theft, fraud,
forgery, defamation and mischief.

Any offenses commitied against individuals or
gronps of individuals to hanm the reputation or

Fig 2.27 Cybercrime

cause physical or mental trawma through electronic means can be defined as Cybercrime. Electronic
means can include but are not limited 1o, the use of modern telecommunication nerworks such as the
Internet (networks including chat rooms, emails, notice boards and groups) and mobile phones (Bluetood/

SMS/MMS).

We can categorize Cyber Crimes in two ways:

«  Computer as a Target: Using a computer to attack other computers. For Example: Hacking,

Virus/Worm attacks, DOS attack etc.

«  Computer as a Weapon: Using a computer to commit real world crimes. For Example:
Cyber Terrorism, IPR violations, Credit card frands, EFT frauds etc.

2.9.1.1 Preventive measures against Cyber Crime:

Anyone using the internet should exercise some basic preventive measures. Here are some measures
you can take to protect yourself against the range of cybercrimes.

. The user must use a full-service internet security suite.

The user must use strong passwords for various online websites,

2
3. Keep your software updated.
4

Keep your personal and private information locked down.
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7.
8.

9.

It’s a good idea to start with a strong encryption password as well as a virtual private
network.

You can teach your kids about acceptable nse of the internet without shutting down
communication channels.

Keep yourself up to date on major security breaches.
Take measures to protect yoursell against identity theft:
If you believe that you’ve become a victim of a cybercrime, you need to alent the local police.

2.9.2 Cyber Ethics

Cyber Ethics is the conduct of acceptable usage of online resources by a user. Cyber ethics refers o
the code of responsible behaviour on the internet. It is to be ensured that users understand their
responsibilities for conducting themselves online.

2.9.2.1 Principles of Cyber Ethies:

Don’ts:
[ ]
[ ]

a's;
L ]

Do not use a computer to cause harm to other people.

Do not interfere with other people’s computer work.

Do not snoop around in other people’s computer files.

Do not use a computer to steal unauthorized information.

Do not copy or use proprietary software for which you have not paid.

Do not use other people’s computer resources without proper authorization.

Do think about the social consequences of the act that you are doing online,

Do always use a computer in ways that ensure regpect for your fellow humans.

POINTS TO REMEMBER

Li

2,

3

E-mail allows us to send and receive messages to and from anyone with an email
address, unywhere in the world.

A CAPTCHA is a type of test used in computing to determine whether or not the
user is human.

All emails received are stored in the inbox.

Google Apps is a suite of Web-based applications from Google that includes e-mail.
calendar, word processing, spreadsheet and presentations.

Cloud networking refers to manipulating, configuring, and accessing the hardware
and software resources remotely,
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6. Cloud Prinfmg-t_tnahles USErs tcr;gilrt documents and other materials remotely on any
device associated with the cloud (network).

7. TheInternet is indeed private and secure, but there are a number of serious security risks.

8. Phishing is an e-mail fraud method in which the wrongdoer sends out legitimate-looking
email in an atiempt to gather personal and financial nformation from recipients.

9. Cyber Ethics refers to the code of responsible behaviour on the internet.

10. Cyber Crime uses a computer as a Target or/and a computer as a Weapon.

11. Google Drive is a service offered by Google that allows us to store and share files online

EXERCISE

Que:l Multiple Choice Questions

1 “Gmail’ is a free email service provided by

A, Yahoo B.Google
C. Rediff mail D. Hotmul
n A is a type of test used in computing to determine whether or not the user is
human.
A, CAPTCHA B.DERTSA
C.HEPTCHA D. NEPHCA
m is a type of malware designed to provide unauthorized, remote access to a user's
compuiter.
A, Spyware B. Trojan
C, Malware D. Horse
v 15 a computer program that replicates itself into other computer programs.
A, Spyware B. Virus
C. Phishing D. Malware
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V' __ isanIndiandigitization online service provided by the Ministry of Electronics and
Information Technology (MeitY), Government of India under iis Digital India imitiative.
A, DigiLocker B. DigiProgram
C. DigiHacker D. DigiBanker
Que:2 Write True/False

I  Spywareis an e-mail fraud method in which the wrongdoer sends oul legiimate-looking
email in an atlempt to gather personal and financial information from recipients.

I  Google Drive does not allow us to store and share files online.
I The best way to deal with the threat of a computer virug is 1o use antivirus sofiware.
IV The Web threat is any threat that uses the World Wide Web to facilitate cybercrime.
V' Google Meet is a video conferencing service by Google.

Que:3 Short Questions Answer

Deline E-mail.

—

M Give the names of any four Google apps”?
MM Define Cyber Ethics?
IV ‘What is Digil ocker?
V' Whatis Cloud printing?
Que:d Long Questions Answers?
1 Whatare Google Apps? Explain any two Google Apps.
T Whatis Google Drive? Write various benefits of Google Drive.
M Write about various methods of Internet Security.

IV Whatis Cyber Crime? Write various preventive measures against Cyber Crimes,
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| Lab Activity |

Give the name of different apps whose icons are shown below:
“

@
&

C
o
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MICROSOFT EXCEL (PART-1)

—[ Objective of this Chapter: }

3.1 Introduction of MS Excel

32  Common uses of MS Excel

3.3 How o Start MS Excel

3.4 Components of MS Excel Window

3.5 MS Excel Terminology

3.6 Working with Datain Excel Worksheers

3.7  Operations on Workbooks and Worksheets

ey

INTRODUCTION

We have sudied Word processor program in our previous classes. As we know, Word Processor are
used to prepare and print Applications, Letters or other Text based written documents. For the best
use of word processor in different fields, there are a lot of 1ools and automations available.

Other than these types of documents, if we are going to prepare our school result, annual report of a
company, invoice for any sale counter or any other these type of data related documents where more
emphasis is given to comrect and effective computation rather than just style,we use spreadsheet packages.
The working area in these types of packages is divided into rows and columns. Spreadsheets are used
for monitoring and analyzing the data, and present the data in pictorial form by using chans. Let’s leam
about one of this type of spreadsheet package known as “MS Excel”.

A1TINTRODUCTION OF MS EXCEL

Microsoft Excel is u spreadsheet program used for organizing und calculating numerical data. We can
use it to organize our data into rows and columns and to perform mathematical caleulations, We can
easily represent our dara in such a form which is needed for bener representation. We can have a lotof
automatic calculations in excel. We can format our data in any style and layout to meet our all
requirements, Excel can also produce a range of charts and graphs that can be used to present the data
in a graphical manner. We can explain some of the best leatures of MS Excel as follows.
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Easy Data

Conditional
Faormating

Key Features
of
MS EXCEL

Application . Data
of Formulas Validation

Easy Store
and Find
Data

Fig 3.1 Features of MS Excel

3.1.1 Features of MS Excel

Microsofi Excel spreadsheet package provides some of the features as described below:

Easy Data Analysis: MS Excel provides very advanced tools like Sorting. Filtering, Charts,
Pivot Tables, Goal Seek etc, which helps in analyzing the data very elfecavely.
Conditional Formatting: We can format our data based on different rules and condinons.
Ithelps in highlighting the facts from data or information.

Data Validations: This feature enables us to vahidate data based on certain criteria while
entering,

Easy to Store and Find Data: There 15 no limit to the amount of information that can be
saved in a spreadsheet. If the information is stored in any of the word processor or text file,

finding any particular picce of data may take more time. However, this is not the case with
excel spreadsheets, Finding data is casy.

Application of Formulas: Performing calculations m MS Excel are easier and less time-
consuning by using different formulas.

Data Protection: Sheets of MS Excel can be protected using passwords for different
ACCESS.

Organized Data: It is convenient to store our different data in multiple worksheets
which can be added in a single MS Excel workbook,

3.2 COMMON USES OF MS EXCEL

Following are the some common uses of MS Excel:

Iy
2)

a4 &

Excel can be used for mathematical calculations.

In Excel, data can be represented in a graphical format with the use of Charts.
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3)  We can also prepare school Timetable.

4} Salaries of employees can be calculated.

5) Results of students can also be prepared in Excel.
33IHOWTO START MS EXCEL
To open MS Excel easily, one of the following methods can be nsed ;-

o Sunfff> AllPrograms - Microsoft Office  Microsoft Office Excel 2010

OR
*  Type “Excel” in search bar. Excel program will appear in the start menu. Press enter buiton
after selecting EXCEL program. We can directly click on Excel program also from the
program ment to open it.
3.4 COMPONENTS OF MS EXCEL WINDOW

The following figure shows the various components of MS Excel Window:
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Fig 3.2 Different Components of MS Excel Window
Let's understand each part:

. Quick Aceess Toolhar:

We shall see this toolbar on the left-upper comer of the screen. Tts purpose is to display the most
frequently used commands of the Excel. We can customize this toolbar based on our choice.
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2. Title Bar:

The header or title bar of the spreadsheet located at the top of the window. Almost all the applications
are having this part as an interface, It presents the name of the active filename and Program name itself.

J.Control buttons:

These buttons are present in the upper-right of the window that allows us to modify the minimize,
maximize/Restore and close the workbook.

4.File Tah:

This tab of MS Excel represents a menu which is used to perform file related operation. Some of
the basic operations present in this menu are to create new excel documents, open an existing
file, save, save as, export, print file, ctc.

S Tabs:

T T W W W
Home | Insert  Pagelayout  Formulas  Data  Review  View

Under the title bar of MS Excel, the name appeared for each related tab. These tubs are called
Menu bar; and consist of a File, Home, Inseri, Page Layow, Formulas, Data, Review, View,
Help, and a Search Bar with a light bulb icon. These menus have sub categories that simplify the
distribution of tools and commands used for different purposes.

i Ribbon/Toeolbar:

-]| :’:‘:r Cabnt NS "y B e e H '_ﬁ o e ‘Jr [ gr A
P sy B F R N A EEE ER Eeiones W% %2 <--::_:_: l-g-'m'-_-r G s
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There are series of elements those are part of each menu bar. On the selection of any Menu/Tab, a
series of command options/icons will be displayed on a ribbon. For example, if we press the “Home™
tab, we will see cut, copy, paste, bold, italic, underline etc. commands. Toolbar/Ribbon is a group of
organized commands in three sections.

*  Tabs:These are the top section of the Ribbon and contain groups of related commands.
Home, Insert. Page Layout, Formula, Data etc. are the examples of tabs.

*  Groups:These orgamze related commands; the name of each group appears below the
Ribbon. For example, a group of commands related 1o fonts or group of commands related
to alignment, etc.

«  Commands:These appear within each group as mentioned above.

7. Dialog Box Launcher:

Il‘h $ Cut
— 3 Copy ~
Paste
. J Format Painter
Clipboard

This is a very small arrow locaied in the lower-right corner of a command group on the Ribbon. By
clicking this arrow. we can open related dialogue box to perform advanced operations.

@FD

" c3 v(

This is a first part of formula bar which shows the address of active cell, row or column. We can also
make any selection using this part of MS Excel.

8. Name hox:

9. Formula bar:

sius -

This part of MS Excel used to display cell contents or formula written within a cell. We can also
edit the contents of an existing cell using this bar, This bar is an area just below the ribbon area.

1. Scrollbars:

<] E 0

These are the slider appeared on right and bottom side of our spreadsheet. It allows us to slide
both the vertical and horizontal view of the spreadsheet. We can use the mouse wheel w
automatically seroll up or down or use the arrow keys for this purpose.
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11. Spreadsheet Area:

.,
1
sl |
et B N
O Soresbbestires

Tt is the working arca where we enter our data, Tt constitutes the entire spreadsheet with its rows,
columnns and cells. Each spreadsheet area having column header is known as Column Bar and display
at top and row header at left side of the screen known as Row Bar. Columns are represented using
Alphabets like A, AB.BCC etc. and rows on the other hand are represented by numbers starting from
l. The active cell is represented using a bold rectangular area in the spreadsheet and the blinking
vertical bar called “cursor” is the insertion point. It indicates the insertion location of the typing.

12.Leaf Bar:
4 Hl Sheetl /Sheet? / Sheet3 ﬁb/

This part of the MS Excel screen is used to display sheet name. Tt appears at the bottom of the
working area. We can have multiple worksheets in one MS Excel file known as workbook. This
sheet bar explains the spreadsheet that is currently being used. We can alter several sheets at our
convenience or add a new one using this part of MS Excel.

13.Status Bar:

oy |

also displays other very important information related to our spreadshect. This area of MS Excel
screen also shows the information if anything goes wrong, or the document is ready to be delivered
or printed. Status bar displays quick calculation of the selected digits, like sum, average, count,
maximum, minimum and etc. as per our settings. We can configure the status bar by night-
clicking on it. We can insert or remove any command from the provided list.

14.View Buttons:

Paga Layoul View
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Itis a group of three buttons arranged at the Ieft of the Zoom control and close to the right-bottom of
the screen. We can see three different types of MS Excel sheet views with the help of these buttons. Al
these views of MS Excel are as under:

»  Normal View:This displays the Excel page in normal view.

*  Page Layout View:This displays the exact view of MS Excel sheets as these are going to
be printed.

*  Page Break View:This shows page break preview before printing to adjust page layout
easily.

15.7Zoom Conirol:

% O—0—®

Zoom control is located at the lower-right area of the window, It allows us to ZOOM-IN or ZOOM-
OU'T a particular area of the spreadsheet. Tt is represented by magnifying icons with the symbols of
maximizing (+) or minimizing (-) which allows you to manipulate them by clicking on any of these icons.
In the recent version of Microsoft Excel 2010, it allows us to zoom out by 10% and zoom up to S00%.

16, Active Cell:

An Active Cell is a cell of spreadsheet in which we are currently working. The active cell is always
represented by a bold rectangular box.

3.5MS EXCEL TERMINOLOGY
Following are the terms commonly used in Excel:
1. Workbook:

A workbook is a collection of the worksheets, By default, each workbook contains three worksheets.
We can add hundreds of worksheets in a single workbook.

2. Worksheet:

Worksheet is one spreadsheet of MS Excel which contains columns and rows. We can insert worksheets
in workbook by pressing the button “Tnsert New Worksheet™ from leaf bar.

3 Row:
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A row 18 acollection of all adjacent cells which are referenced by one single row number. When we
click on any row header, all the cells which belongs to that particular row are get selected and one big
rectangular area got highlighted. Whole collection of these cells is called row. Rows are named as
1.234....... .500n

4. Column:

A colurn is a collection of all adjacent cells which are referenced
by one single columm name. When we click on any colunm header, || ° " pam
all the cells which belongs to that particular columon gets selected
and one big rectangular area got highlighted. A column is used to
represent a particular field of data. Whole collection of these cells
is called colurn, Colurans are named as A B,CD...... . AAAB,.

. 5O 011

> il o

Column
" ;.

.'\—-_-.n—'-'-'-

T

8. Cell: ( Cell

A cell is a smallest rectangular part of our spreadsheet in
which our data is entered. A cell is an intersection of a row
and a coluran. Each cell is identified by a cell address.

f—

s Talle =
6, Active Cell: - Aoy
- e B ~Ka

This is a cell of spreadsheetin which we are currently working. A bold .h f;: —
rectangular box around the cell identifies an active cell. Contents of active Mk
cell are always displayed in formula bar and the address of active cell is ,Q:‘ff@ S

always displayed in Name box. : |

7. Cell Address:

Every cell in Excel worksheet has a unique address. A cell address has - b oa —
a column letter followed by a row number. For example, Al is the ﬁ e - a.;
R
intersection of the column A and row 1. The combination of a column - ’ e
coordinate and a row coordinate make up a cell address. £ ,_u:::f e
L Adress —

Comparison between Worksheet and Workbook:

As we have siuclied both these terms of MS Excel. Let's see how worksheer i3 different from Workboolk,
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Worksheet Workbooks

I. Worksheet refers to a spread-sheet of MS | 1. Workbook is a File created in MS Excel

Excel which consists of Rows and which may consist of number of
Columns. Worksheeiz.
2. There can be many worksheets in one | 2. No workbook can exist within a
workbook of MS Excel worksheet as worksheet is a part of
workbook.

3. Workbooks are saved individually with
the extension .xlsx

4. Workbooks are used to have different
type of data to be stored in different
sheets as a one file.

3. No worksheel can be saved without
workboolk.

4. Worksheets are used to have our data of
one type in the form of spread-sheet.

3.6 WORKING WITH DATA IN EXCEL-SHEETS

Agwe have studied the basic Tunctions of worksheet of MS Excel. I allows a series of functions o be
performed in a worksheet. Let's understand these functions as a graphical presemation as under:

3.6.1 Basic lunctioning in Worksheet:

Following figure shows the basic functions on Data that can be performed in the Excel Worksheet:

Entering Data Editing Data

Selecting Data Deleting Dala

Fig 3.3 Basic functions in Worksheet

e Entering Data:We can enter data in any of our cell of worksheet. For entering new data in
a cell, firstly place the cursor in the cell in which we want to enter data. Type the required
data to be entered into our cell. We can press enter key to complete the entry of data into
one cell and moving to next cell of same column, We can use tab key also to complete the
entry of daia and move to the next cell in the same row. We can press Alt+ Enter key if we
want to change line within cell itself and keep entering the data. If we need to delete data
during the data entry, then we can use delete or backspace keys accordingly. To change the
active cell position arrow keys are used. However, we can use arrow key in edit mode of a
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cell which got active by pressing F2 key. Data entry within a cell may contain two types of
data:

#  Entering Formula or Function: Aswe already know, Excel is used for mathematical
calculations using Formula or Functions. We can enter any formula just followed by
equal (=) sign. For Example: =A1+B1

#  Eniering Contents other than formula or function: We can also stove our contents
to deseribe our data or facts. We can enter any type of a data without using any sign
before contents, For Example: “Computer”.

Editing a Cell Data:When we enter data into a cell, it may be needed to change already
entered data, We can edit the data by pressing F2 after selecting that particular cell or just
double click within the cell. We can also edit the contents of cell by using the Formula bar.

Deleting Data: We can delete the contents of a cell. To delete the entire contents of one or
more cells, we can just press delete button from the keyboard after selecting the particalar
cells. In the case when partial contents of a cell are required to be deleted then we canuse
F2 key or double click of mouse on the cell and the cell will be converted into edit mode.
We can use arrow keys in edit mode of cell and use delete or backspace key to delete the

required contents.

Selecting Cells:When we wish to perform any function or format on a group of cells, we
must first select those cells by highlighting thern. We can use Mouse for selecting the cells.
We can also use shift and arrow keys in combination for the same purpose.

3.6.2 Entering Same Data in a Row or Column:

We can enter the contents of one cell to other adjacent cells in either row or column using several ways.
Some of the ways are as under:

L Using Fill Commantd: We can enter same contents in multiple cells vsing fill command as:

2.
3

Select the cell whose contents are 1o be copied along with the blank cells.
Goto 1o Home=> Edit Group=» Fill option:

There are a lot of options available for this purpose like DOWN, RIGHT, UP, LEFT,
SERIES etc.

Select our required option. For example, if same contents are to be copied into a
column downward then select DOWN option,
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Fig 3.4 Entering same data to multiple Cells using Fill Tool

Our contents would be copied in all the selected cells.We can also use the following Shorteut keys for
this purpose:

»  Fill Down 3 Cul+D

> Fill Right $ Cul+R

[1. Using Copy and Paste:We can copy the contents of one cell to other cells using copy and paste
option also. We can use this comrmand as follows:

1. Select the cell or cells having the contents to be copied.

2. Select “"COPY" option from Clipboard group of HOME Tab. We can also use shortcut
key. 1.e. Cirl + C.

3. Select the cells in which the contents are to be copied.

4. Now, select “PASTE” option from Clipboard group of HOME Tab. We can also use
shortcut key, i.e. Ctrl + 'V,

P
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Fig 3.5 Entering same data to multiple Cells using Copy and Paste Option

Note: We can also use Paste Special option for more advance options. We shall discuss
these options in next chapter.

Il Using Fill Handle: This option of MS Excel is used for several operations. We can copy
sare contents in multiple cells as under:

1. Enter our contents in a cell to be copied into multiple cells.

2. Select the cells where contents are entered.

MICROSOFT EXCEL (PART-1) 8 53



3. Now hold the fill handle of the selection and drag the mouse in required direction. i.e.
Column or Row.

4. Our selected contents would be copied into all the cells as we drag.

4 A A A 4 A

1 |Computer Ml' Computer

: Computer
" Computer

= O U B W N
= O U B W N =
=~ " U 5 W R -

Fig 3.6 Entering same data to multiple Cells using FFill Handle

Note: If our entered data represents a series item already saved in MS Excel then the fill handle
option will automatically enter the series. In such a case if still sarne contents are required to be
mpii:ﬂﬂwn we must enter the same content in at least two cells and fill handle is to be used after
selecting both or all these cells.

3.6.3 Working with Series in Excel Worksheets:

Series is a collection of data represented by a specific category, patiern or formula. MS Excel provides
a wide variety of series of data to be entered into cells, such as Series of Numbers, Name of Month,
and Name of Days Series etc. Let's understand how to work with such series using Fill Handle option:
I. series of Month/T¥ay Names:Fill Handle creates the series according to the selected cells. We
can create Month/Day Names series as under:

L Enter the series item in the starting cell. Irem can be any value of the series. Our series
would start from the given item. For example, if June is entered into a cell then the
series of Month-Names would start from June and move to next month in iterative
manner for as long as we drag it. Similarly, Series of Day-Names would start from
Tuesday if Tuesday is entered into a cell to create the series.

ii. Hold the Fill Handle and drag it in any direction, i.e. Row or Column.

iii. Our particular Series will be filled in the dragged cells. Each item of series will be
entered into a single cell,
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Fig 3.7 Creating Month Name Series using Fill Handle

Note: If our selecied cell content does not belong to any of day/month series, the same contents
of the selected cell will be copied as we have studied earlier.

il. Series of Numbers:We can also create Number Series using Fill Handle option. Number Series
are the series with numerical Growth. We can use following steps for this purpose:

. Enter our numbers at least in two cells as shown in the following figure.
i. Selectboth or all the cells.
ii. Hold the fill handle and drag it in any direction. i.e. Row or Column.

iv.  Our particular number series will be entered in dragged cells. The growth of the senes will
be calculated by MS Excel itself. For example, if we enter 2 and 4 in two adjacent cells and
use fill handle on these cells then the series would be 24,6.8,10 . ... .so0mn.

A__ A A A A A 4 A
1 2 1 2 1 2 1 2
2 a 2 4 2 1|_ 2 4
e Tl
4 4 4 4 8
5 5 o 5 10
6 6 6 6 12
T 1 7 74

Fig 3.8 Creating Number Series using Fill Handle

Note: We must take care of numerical growth for all the items to be generated automatically.
MS Excel only generates Arithmetic growth-based series.

3.7 OPERATIONS ON WORKBOOK AND WORKSHEETS

We have already studied about worksheets and workbooks in previous section of this chapter.
We have also discussed the differences between both these terms. We can perform different
operations on workbooks and worksheets, Let’s study about these operations in detail.
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3.7.1 Operations on Worksheets

As we know, Worksheet is a spreadsheet in MS Excel which can be used to record our data or other
objects. We can perform several operations over the worksheets which are contained within a
workbook. Some of the basic operations to be applied on Worksheets are as given below.

Inserting new Worksheet:

Each worksheet is used to store one type of data. To have Different data to be stored as one file, we
have to insert multiple sheets in MS Excel file which is also known as Workbook. We can insern new
worksheet using “Tnsert Worksheet™ option of Leaf bar shown at Left bottom corner of work Area.

Insert worksheet

4 < » ¥]| Sheetl /Sheet2

Renaming Worksheet:

Renaming operation on worksheet is also required sometimes when we want to represent particular
data among different sheets within a workbook. To rename a worksheet, we can follow some steps:

I.  Rightclick on Sheet Leal which is required (o be renamed.

2. Select Rename option from pop-up ment appeared.
3. Typethe new name and press Enter 1o Finish.

24
135 et I :
1 | B
47 Benama l 16
18 Move or Lopy... i 1?
g G yiew Code | * ::
= Qy ProtectSheet.. | 20
13 Tab Calor * ! il
» b | .
- - | 2
A e
IR “f:";:i;i!;l- i~ 17 R 3 Sheets %)

Fig 3.9 Renaming an existing worksheet
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Removing Worksheet:

If we have any sheet which is no longer required to be there in a workbook then we can remove the
worksheet. This option can be very useful to have only the meaningful worksheets within a workbook.
We can remove an existing worksheet using following steps:

1. Rightclick on Sheet Leaf which we want to remove.
2. Select Delete option from pop-up men appeared.
3, Ourselected sheet will be removed and respective leaf will no longer available.

[
i

M 1
1 T : 3
:.';- ng E_'
19 ! Move of Copy... i g
20: «:i‘ Wiews Code . !ﬂ
Al |y Protect Sheet . 21
23 Tab Coloe » iz'
23 Hide 3
24 24
E‘ I Selert All Sheats I H
R [ B : —
N M

Fig 3.10 Removing an existing worksheet

Copying a Worksheet:

Copying a worksheet is a common operation over worksheets when we have to create same
worksheets [or number of purposes. We can copy an existing worksheet and can change that
copied sheet as we want. Let's understand the process of copying a sheet:

1.  Right click on gheet leal which we want to copy.

Select Move or Copy option from pop-up menu appeared.
Move or Copy dialog box will appear.

Click on “Create a copy” option at the lower left corner.

Select the location of sheet from Before Sheet list of dialog box.
Press “OK" button,

o B s fa R
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3.7.2 Operations on Workbooks

"o v W] sheet2 [ she

=0

Asg we know, Workbook is a file created in MS excel. We can perform several operations over the
worksheets contained in a workbook. We can create new workbook. It can be saved permanently 1o
be used in luture, opened when needed and can be duphicated 10 have a copy of it. Let’s discuss all
these operations in details.

Creating New Workbool:;

Everytime we open MS Excel, it opens the default blank workbook for the user to work in. We can
also create a new file when we are already working in a workbook. We can use following steps for
creating a new File:

1. Click File tab and a Pane will appear.

2. Click New.
3. Now alist of available templates will be displayed. We can select the required template or
Blank workbook to be used.

4. Click New. Excel will create anew file and file will be opened.
Note: We can use Curl + N as a shorteut for creating a new file in MS Excel.
Saving Workhook:
When we are working with a workbook, it is very important to save our work after a short interval of
time. This task of saving workbook is different when we save first time as, it asks for filename for the
first time. Each of our MS Excel file is saved with .xlsx in Office 2010 or later version. Before office
2007 (Office 97-2003) all files were being saved with .xls extension. When the filename is given, we

use save command all the tine, our file remain updated in previous file already saved. We can save our
file using following sieps:

1. Click File tab and a Pane will appear.
2. Click Save. The Save As dialog box will appear.

3.  Gotothe directory/drive in which we want to save our [ile.
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4,
5.

Type suitable name for file in the File Name feld.
Click Save. Excel will save our file.

Note: We can use Cirl + 8 as a shortout for saving a file in MS Excel.

Opening an Existing Workhook:

When we want to continue our work in a workbook which is already saved then we have to open it
first. We can do this when we start MS excel using “Recent list” or “Open Workbook™ option. We can
also open a workbook when we are already working in a workbook. Let’s see the list of steps for

opening a workbook.

1;

e o G A

Click File tab. a Pane will appear.

Click Open. The Open dialog box will appear.

Go to the directory in which our file is already saved.
Select our file to be opened.

Click Open. Excel will open our selected file.

Note: We can use Ctrl + O as a shorteut for Opening an existing file in MS Excel.

POINTS TO REMEMBER

1;

10,

Microsoft Excel is a spreadsheet program used for organizing and calculating numerical
data,

Salaries of emaployees and Results of students can be prepared in MS Excel.

Worksheet contains columns and rows. We can insert more worksheets in workbook
by pressing the button “Ingert New Worksheet".

A cell is an intersection of a row and a column.
Row is a collection of all adjacent cells which are referenced by one single row number.

Column is a collection of all adjacent cells which are referenced by one single column
number.

Each MS Excel file is saved with .xlsx /.xls extension.

Active cell is the cell in which we are currently working, A bold rectangular box
around the cell identifies an active cell.

Each cell is identified by a cell address. The cell address of our active cell always
being displayed in Name Box.,

We can use Mouse for selecting the cells. We can also use shift and arrow keys in
combination for the same purpose.
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11. We can edit the contents of a cell by pressing F2. We can also use double click of mouse in
the cell for this purpose.
12. MS Excel worksheet can be viewed in Normal View, Page Layout or Page Break Preview.

EXERCISE

Oue:1 Multiple Cheice Question :

I A warkbook is a collectdon of the

A. Cell B. Row
C. Column D. Worksheet
M Acellisan intersection of a and a
A. Row,Column B. Row,CellAddress
C, Column, Formula Bar D. None of these
M Fill handle in MS Excel can be used for
A. Copying the contents of a Cell B. Entering Number Series
C. Entering Custorm Series. D. All of the above.
IV The Extension of MS Excel file is
A. .docx/.doc B. xlsx/.xls
C. .ppd/.ppt D. xt
V' Which one of the following is not a view of MS Excel?
A, Page Layout B. Page Break Preview
C. Normal D. None of these

Que:2 Write the Shorteut keys for following Lasks:
I ToOpen anexisting file in MS Excel
I ToSaveafilein MS Excel
M ToCreate a new [ile in MS Excel
IV ToFill Down in MS Excel
vV  ToFill Right in MS Excel

60 & MICROSOFT EXCEL (PART-1)



VI To Copy contents in MS Excel

VI To Paste contents in MS Excel
Que:3 Write True or False:
T Address of Active Cell always displays in Name Box.

0 All Columms of MS Excel are represented by numbers starting with 1.

I Cell containing formula displays the result of the fornmla, whereas the formula itself displayed
in Fotmula Bar.

MS Excel is a widely used Word Processor.

We can insert Number Series in MS Excel using Fill Handle.

< 4

Querd Short Answer Type Questions:
I Define MS Excel.
M Whai are the uses of M5 Excel?
M Explain Ribbon in MS Excel.
IV What is Name Box?
V  Explain Rows and Columns in MS Excel.
(mne:5 Long Answer Type Questions:
I What are the Basic Operations [or MS Excel worksheet?
T Explain the Features of MS Excel.
M Write the differences between Workbook and Worksheet.

| Lab Activity !

1. Fill in the name of various parts of MS Excel Window.
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2.  Prepare the following table as directed:
1 Use Series Opton for Sr. Ne column.
I Use Fill handle to enter Day and Type.

A 8.l ¢ |l b |
1 Sr.No. Day Type Subject
2 1 Monday Theory Hindi
3 2 Tuesday Practical Punjabi
4 3 Wednesday Theory English
5 4 Thursday  Practical Math
6 5 Friday Theory Science
7 6 Saturday Practical SST
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Microsoft Excel (Part-2)

Objective of this Chapter: }

4.1 Formatting in MS Excel
4.2  Inserting row. column and other objects in MS Excel

INTRODUCTION

In the last chapter of MS Excel, we have stndied the different parts of MS Excel window and different
options for working with data in MS Excel. In this chapter we are going {o leamn about formatting tools
tobe used in MS Excel. We can make our data more readable and effectively representing the information
from facts of data. We will further read about different objects which can be added in our worksheet.
Let’s begin with learnmyg about formatting tools.

4,1 FORMATTING IN MS EXCEL

MS Excel sheets without formatting are very difficult to understand. Formatted data and cells
can be useful to get attention to specific parts of the spreadsheet and make the spreadsheet more
visually appealing and easier to understand. There are many tools in MS Excel which can be used for
formatting text and cells. These tools can change the color and style of text and cells, aligning texis
and applying special formatting to numbers and dates. Some of the formatting tools are as under.

4.1.1 Changing the text styles:

MS Excel offers lots of different options to change the text styles. Some of these are as under:

Font Size
hCaIibri *i1] ‘v A‘ A Font Color
Bod —+B 7 U~ |~ | & AF |
- | Border Text Background Color

Underling

Fig 4.1: Text Styles
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I. Font: A Fontis basically a style of text being typed. We can also change the language of text being
typed. Some basic fonis are Arial, Times new Roman, AnmolLipi ete.
A . W s ~=

COI'I"IFI'UI'EI' Enhiari Lighe e wafirag A

Calpbin By

Aschen fold l’
Rachoo-Light i
AARED

o oW b wru—-k
ﬂmmthdL

Fig 4.2: Font Text Styles

1, Size: As perits name, this option of text style increasesor decreases the size of text being typed. We
can have our contents in different sizes in a single worksheet to make it more effective.

4 A T8 DR a___A
1|Cummer Ll A= 1 | Computer
2 = '-‘“L'i;.l. w = 2 |
s 3
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5 n 5
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Fig 4.3: Size Text Styles

A Font Color: Using this option, we can change the color or our contents in MS Excel. There is a wide
range of colors to be used for Foreground of text.
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Fig 4.4: Font Color Text Styles
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4. Text Background color: This option of MS excel Allow User to change the background color of
text.

i A EA - === A A
T
1 |Computer ':"""*::_ 1T 1 |Computer
2 I 2
3 " 3
| o illiNiin 9
4 | il.lnd.—'ﬂ-(nh-r‘
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6 | e _I_.]-.'u.-::l;.:::... 6 !
o 7

Fig 4.5; Text Background Color Text Styles

5, Basic styles: There are some other styles also available to be applicd on text contents. Such as
Bold which makes our text a bit sronger than regular, Ttalic which is for making the text a little
slanted, Underline, which shows a line under the text to make them more emphasized.

A A . A AN
1 [computer | 1
E.#l Calibri B SLAS & le]
E] e 3

B I - [F] = O - - it
v > u -] = A- |-
5 Fant » 5
& &
’ 7

Fig 4.6: Applying Bold, Italic and Underline Text Styles
Note: We can use shortcut keys for these text styles which are as under:
Bold: Cul + B, Ttalic: Cirl + T, Underline: Ctrl + U
4.1.2 Changing the Cell styles:
Cells are the primary element of a spreadsheet. All the contents are all arranged in cells. There
are several optons for changing the styles of cells too,
1. Cell Borders: We can use this option to have airactive presentation of data in spreadsheet
and highlighting the valuable contents. We can use Border option from Font group to apply
border to a cell following sports are used to apply cell Border,
1. Select the required cells and press the arrow key of Border button.
2. A dropdown menu appears. It displays the different options for borders to apply.
3. Select one or more option for a single selection.

We can use “More Borders™ option to have advance setting of border using Format cell dialogue
box.
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Fig4.7: Changing Cell Border

2, Changing cell width: Using this option for a cell style, we can change the width of a cell. This width
will be applied for entire column. Steps to change Cell Width:

&

2.

Select one or more columns.
Click on Format button in the Cells group of Home tab.

3. A dropdown menu will appear. Choose column width option which will open “Column
Width” Dialog Box.
4. Enter the value of Colommn width.
5. Press OK button to apply cell width.
ﬁ%:l—.?,—: —
# e - Wil 1
gy T Column Width 7 ¥
O ) N
o Solumn width | 15 i
T ]| cancer |
[ 1 T
Fig4.8: Changing Cell Width
3. Changing cell height: This option for a cell style can change the height of a cell. This height will be
applied for entire row, To change Cell height :
I, Select one or more rows.
2. Click on Format button in the Cells group of Home tab.
3. Adropdown menu will appear. Choose Row Height option which will open “Row Height”
Dialog Box.
4. Enter the value of Row Height.
5. Press OKbutton to apply cell height,
66 B
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Fig 4.9: Changing Cell Height
Note: We can alternatively change the width or height of a cell by dragging the column boundary
at column header and row boundary at row header.

4, Merging Cells: By mean of merging the cells, we refer to joining two or more adjacent cells as a
one region. We can merge any number of cells forming a rectangular area. If the cells being merged
have contents, afier merging the information in the upper lefi cell will be the only information rempaining
in the merged cells. We can merge cells as follows:

. Select the cells to be merged.
2. Clickon “Merge and Centre” from Alignment Group of Home tab ribbon.
3. Select further options of Merging from drop down menu appeared.

The selected cells will get roerged.

a A B c - A & €

Y [E rEUter Taucet ] 1 [ Computer Education I
2 &

3 i

4 , 4

5 B Meege Cells 5

: . = un:_lﬂﬂgl Ctlls_ :

Fig 4.10: Merging the cells

The "*Merge Across” Option will merge each row of selected cells into a larger cell. We can also
unmerge the already merged cells using “Unmerge” Option from the drop down.

5. Aligning Text: We can align the contents of a cell by using the Alignment group in the Home
tab of ribbon. Contents can be aligned to the top of the cell, the bottom of the cell or the center of

the cell. They can also be aligned left, right and center, just like the text in a word processing
program like MS Word. For aligning the text, we can use steps as follows:

1. Select the cells.

2, Choose the required alignment option form home tab ribbon.
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The effect of each alignment option will be displayed on selected cells.

| A A A
Computer
; Computer *EEE o £ Wiap Text ’ ;
3 === EE EMege&Conter - 3
4 4
g Aisgneent [ <
& &
7 Fig 4.11: Aligning the textincells 7

6. Changing Orientation of Text: When we are designing the report having of a lot of data to amrange
our whole report on a single page, we have to compress the columns or rows in as minimurn size as
possible. Sometimes, we have columns where column header is Large than the data written under that
particular field. For example, Marks Obtained field will be wide enough but all the marks will not be
such long. In this case, we may require to change the orientation of our text written in the header. We
can change orientation of text within a cell as under:

1. Select the cells whose orientation is to be changed.
2, Choose “Onentation” option of alignment group of Home Tab.

3. Different orientation options will be displayed in appeared drop down menu appeared.
Select the required orientation,

Selected orientation will be displayed on selected cell.
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Fig 4.12: Changing Text Orientation

Now, as we can see in the piciure shown in above figure, we can easily compress the size of

column containing Marks Obtained as our column header has been vertically oriented.

7. Wrapping Text : When {yping within a cell, sometimes our contents go out of cell's width.
According to the requirement of our report, we don’t need to increase the column width. In
such a case, we have to wrap text within a same cell. For this purpose, we can use Wrap
Text option of Alignment Group in Home Tab Ribbon after selecting the particular cell or
the range of cells.
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Fig 4.13: Wrapping cell contents

8. Applying Number Formats: We can change the appearance of numbers in MS Excel without
changing the values. The actual value is always displayed in the formula bar. The default format for
displaying numbers is “General™. In this format style, All the numbers. dates are right aligned but all the
contents that contain text are left aligned. To change the number formats, we can use following steps

1. Select the cells to change the number formats.

Click on “Number Format”™ option of Number Group of Home tab ribbon,

3. A Dropdown menu will appear. Select the particular number format io be applied.
4. The Select Format will be applied on selected cells.

Note:We can have more options related to formatting by clicking the “More Number Formas™
button at the bottom of the dropdown. This will launch the Format Cells dialogue box for
different formatting tasks.
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Fig 4.14: Applying cell formats
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4.1.3 Conditional Formatting:

Conditional Formatting is a tool in MS Excel that enables applying particular formats 1o a cell or range
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of cells depending on the value under specified condition. This tool is very useful as it can highlight the
respective cells with certain formats to show valuable facts. For example, while preparing the result of
aclass, we can highlight cells who secured marks greater than 80%. We highlight cells with a certain
color or other formatting,

Conditional formartting applies one or more rules to any cell or range. We can use following sieps o
apply conditional formatting :
I. Select the required cell or range where conditional formatting is to be applied.
2. Click on Conditional Formating button from Home tab ribbon.
3. Dropdown menu will appear and lot of pre-defined rules for conditional formatting will be
displayed. Choose the required rule. We can use Highlight cell rules like Greater Than, Less
Than, Between, Equal to, Duplicate Values etc.
4. Dialog box related to selected rule will appear. For example, if we choose Greater than
option then “Greater Than” Dialog Box will appear.
5.  Enter the values for the given rule.
6. Press OK to apply specified Conditional Formatting.

i i S M =

4 A e reE 4 = Marks Ob
Marks Ob ml.— fs | . T FDm %)

{‘Hl [P _

l*

[N]SR S ;__'_.L:..u..., !

F'n-l--

'?5 ’ =

] o s

e 13 -
ﬁ 19 Ums s

] ey o

o i A Ln B b P e

]:"1-54.15: Applying conditional formatting with highlight cell option

Some other commonly used conditional formatting rules are Top/Bottom rules like Top 10 Ttiems, Bottom
10 Ttems, Above average ete. The steps for applying this type of rule will remain same.
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Fig 4.16: Applying conditional formatting with Top/Bottom option
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We can also create new rule for conditional Formatting using “New Rule™ Option.
A A
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Fig 4.17: Applying conditional formatting with New Rule Option
1.1.4 Formatting as Tables:

When we are going to design a report or any other tabular data representation in MS Excel, we have
several pre-defimed formats. Once we have entered information imto a spreadsheet without any formatting,
the information is not going to be as effective as a well formatted information is. Formatting our spreadsheet
can not only improve the look and feel of our spreadsheet, but it also can make it casier to use. To apply
this style of formatting, we can use following steps:

I. Selectthe cells to be applied formatting upon.

2. Click on “Format as Table” from Home tab.

3. Anew dialogue box will appear which shows a lot of different formats.

4. We can easily click the required format to be applied on the selecied cells.
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Fig 4.18: Formatting as table

4.2 INSERTING ROWS, COLUMNS AND OTHER OBJECTS IN MS EXCEL

MS Excel provides the facility to add a variety of objects within an excel worksheet. Each one of them
is having its own importance. When we prepare a report, we need to add cell, row or columns within
the entered data. e can insert new cells, columns, or rows in the worksheet without going through all
the trouble of moving and reatranging several individual cell ranges.
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To insert new cells, rows, or columns in an Excel worksheet, Select the cell/cells, rows, or columns
where we want to insert a new cell or number of cells. Click on Insert option of Cells group in Home
Tab ribbon. Select the desired option frormn the dropdown menn appeared.

A A B C
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4.2.1 [Inserting Celis:
Select the cell where new Cell is to be inserted. Select Insert >Tnsert cell from Home tab ribbon. Click
on the required option and press OK.
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Fig 4.19: Inserting new Cell

4.2.2 Inserting Rows:

Select the cell where new Row is 1o be ingerted. Select Insert = “Tngert sheet rows” from Home 1ab
ribbon, New row will be added on the place of our selected cells.

4.2.3
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Fig 4.20: Inserting new Row

Inserting Columns:

Select the cell where new column is to be inserted. Select Insen = “Insert sheet column' from Home
tab ribbon. New column will be added on the place of our selected cells.
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Fig 4.21: Inserting new Column
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Note: To insert an entire column or row into the worksheet, we can right-click on the column
header or row header on the worksheet window frame and then select Tnsert from the shortcut
menu (or choose Insert Sheet Rows or Insert Sheet Columins trom the Insert button’s menu).
Keyboard shortcut for quickly inserting any of these objects is pressing + (plus) in combination
with Ctrl key after selecting the required object. i.e. for inserting new line, select the line where
insertion is required and press Ciel and + key together.

4.2.4 Using Autohum:

Functions in MS Excel are pre-defined formulas that are used to perform calculations. MS Excel
provides a wide range of formulas ke sum (SUM), average (AVERAGE), count (COUNT.
COUNTA), maximum (MAX) and minimum (MIN). Each of these functions is having its own specific
operations to be performed. We can Apply any of these [unctions using “AutoSum” option from
Editing group of Home Tab ribbon. We can use arrow key of AutoSum option to use more functions.
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Fig 4.22: Inserting lunction in worksheet

As shown in the figures above, the range of function to be applied on is picked automatically. We can
change the range in desired manner, We can use more functions too with the help of “More Functions™
option of dropdown menu. We will discuss the use of functions in next chapters.

4.2.5 Inserting Charts
Chart 15 a graphical presentation of data written in a worksheet. Charts are useful m better understunding
of information represented by data values. There are dilferent chart formats available in MS Excel

such as Bar, Column, Pie, Line, Area, Doughnut, Scatter, Surface, or Radar charts. We can easily
create chart using following steps:

1. Select the required group of cells.
2, Click on any type of chart from “charts” group of Insert Tab.
3. Thechart will be appeared in the currently active sheet.
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Fig 4.23: Inserting Charts

The chart appeared will be designed with standard Layout. We can edit the style of cham using chart
Style Button. There are further lot of option regarding chart elements. We can use them as per our
requirement. Chart designs will be shown in the design tab. We can also change the design of chan with
the optiong of the ribbon.

POINTS TO REMEMBER

10,

1%

12,

74 B

We can make our data more readable and effectively representing the information from
facts of datausing Formatting options.

Fonts, Size, Font Color, Text Background Color, Border and other styles are some of the
basic Text Styles.

We can add Cell Borders, change cell width or height, Merge cells, Align Texts, Change
Orientation of texts, Wrap Texis, Change Number Formais as a cell style in MS Excel.

Conditional Formatting is a tool in MS Excel that allows applying formats to a cell or range
of cells depending on the value.

There are lots of pre-designed styles to be applied as a Table in MS Excel.

We can create own style including number formats, Alignment, Font, Border, Fill Style,
Protection etc. which can be applied to any group of data.

We can add any of our object like cell, row or column with keyboard shortcut pressing +
(plus) in combination with Cirl key after selecting the required object.

Each newly created workbook is contains of three worksheets by default in it.

We can add new worksheets in & workbook using “Insert New Worksheet™ Button.

SUM, AVERAGE, MIN, MAX, COUNT elc. are some of the examples of functions
being used in MS Excel.

Chart is a graphical presentation of data written in a worksheet which are useful in
better understanding the information represented by data values.

There are different chart formats available in MS Excel such as Bar, Column. Pie, Ling,
Areq, Doughnut, Scatter, Surface, or Radar charts
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EXERCISE

Que: 1 Muliipul Choeice Questions :

I

By default, each new workbook in MS Excel 2010 contains  number of worksheets.
A5 B. 2

C, 255 D.3

Which objects can be added in a worksheet”

A, Cells B. Charts

C. Rows D. All of these

Which are the valid types of Charts in MS Excel.

A, Bar, Column, Pie, Line B. Area, Doughnut, Scatter
C. Surface, Radar, Bar. D. All of the above.

Which function is used o find minimum mumber from the given range.

A. AVERAGE B. MIN

C. MAX D. RANK

is a powertul tool of MS Excel used to have graphical representation of our data in
MS Excel.

A. Data Validation B. Conditional Formatting
C, Chans D. None of these

Que:2 Write True or False:

I
m
m

v

v

New cell, row or column can be added by using Ctrl and + keys from keybourd.
SUM and MIN are examples of Chart Types in MS Excel.

Cell Borders, change cell width or height, Merge cells. Align Texis, Change Orientation of
text, Wrap Text etc. are examples of cell styles.

Conditional Formatting is a tool in MS Excel that allows applying formats 1o a cell or range
of cells depending on the value.

Formatting options effectively represents the information from facts of data.

Querd Short Answer type Questions:

I
1
m
v

What do you mean by Formatting?

Which type of formatting can be used as Cell Styles?
What do you mean by Merging Cells?

Define alignment and its types.
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V' What are Charts?
Que:d Long Answer type Questions:
1 Whatis conditional Formatting? Explain its different options.
II 'Whar are charts? Give the name of any five types of charts.
T Explain any three objects which can be added in MS Excel worksheet.

| Lab Activity !

1. Put the following items in their respective fypes:
I SUM
PIVOTTABLE

TYPE OF CHART MS EXCEL FUNCTION

FONT
VI  TEXTCOLOR

INSERTAHLE OBJECT FPORMAT STYLE

AVERAGE
CHART
AVl ITALIC
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2. Prepare the following “Detail Marks Card™ Format in MS Excel by applying required

formatting siyles
GOVERNMENT SENIOR SECONDARY SCHOOL
CITY NAME
DISTRICT NAME
Pre-Board Examinalion
Roll No 30 Student ID 258965
Name of Student KAMALPREET
Father Name SHIVPREET
Mother Name MAVLEEN
Class 9TH Date of Bith 270872006 Section 8
UID No 4528 69854587 Gender MALE
— ~siail of Marks Obtained
“w : =
2| subject 2 i g
1 |ENGLISH 100 | 40 45
2 |PUNJABI 100 | 40 63
3 [HINDI 100 40 1)
4 |SCIENCE 100 | 40 45
5 |MATH 100 | 40 88
6 |SOCIAL SCI 100 | 40 62
7 |ICOMPUTR SCI 100 | 40 45
8 |OPTIONAL 100 | 40 52
9 |WELCOME LIFE 50 20 44
TOTAL MARKS
Maximum marks Secured
Minimum marks Secured
(Grade : 0-40 : E, 41-60: D, 61-80 : C, 81-90 : B, 91-100 : A)
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Microsoft Excel (Part-3)

,—[ Objectives of this Chapter: j]

5.1 Introduction of Formulas and Functions
5.2 Uses of Formula and Functions

5.3 Sorting and Filtering Data

5.4 Working with Data Tools

INTRODUCTION

We are now able 1o design our required report with different auractive formatting after leaming
previous chapters of MS Excel. We have also studied about different objects. We can add these
objects in our MS Excel worksheet 10 create an advanced representation of our data. This 1s not
all,moreover we have powerful calculations and data manipulation functions to be used in MS
Excel. In this chapter we will have u close look over data munipulation using different Functions
and Formulas,

5.1 INTRODUCTION OF FORMULAS AND FUNCTIONS

As we have smdied earlier thar Excel is a spreadsheet program where one can record data in the
form of tables. 1t is easy to analyze data in an Excel spreadsheet. Formulas and functions play
very important role of MS Excel. These are the key features of every spreadsheet package.

A formula is an expression that operates on values in a range of cells or a cell. A lot of operators
can be used within a formula to describe the required operation to be performed on a group of
particular data,

A function is a predefined formula that performs calculations upon specific values in a particular
order. MS Excel spreadsheet programs include common functions like Sum, Average, Count, If,
SumlIf, CoumtlIf, Max, Min, etc.

Let’s discuss about both these elements of MS Excel in detail.
5.1.1 Elements of Formulas:

A formula is an expression which is used for calculation, These expressions are user-defined and
can be as small as one single operation and can be complex enough to perform some advanced
calculations. These expressions can be designed using constant values, cell references and
operators. We have already studied about lot of operators to be used in a formula. Each expression
can be understood as two parts:
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o  Operators: This part of expression defines what to do on available data. We can
use symbols representing different operation known as “operators” for defining
operation of expression. In the fig. 5.1 + sign represents Operator part of Expression.

o Operands: This part of expression defines the values on which the given operation is
to be applied. Each different operator is having particular operand requirement. i.e.
Some operators require one operand and some on the other hand require two or more
operands. In the given figure, Al and 20 both are representing Operand part of
expression.

K Operands

Al + 20

+ = == = (Jperators

Fig. 5.1
5.1.2 Operators psed in MS Excel Formulas
Operators are the symbols which represent a particular operaion to be performed in a particular
application. MS Excel follows general mathematical rules over operators for calculations. The
precedence of application of operators in an expression would be Parentheses, Exponents,
Multiplication and Division, Addition and Subtraction etc. There are four different types of
calculation operators being used in MS Excel are arithmetic, comparison. text concatenation
and reference.

1. Arithmetic operators

These operators are used to perform basic mathematical operations. The list of these operators is
as under:

Symbol | Arithmetic operator | Meaning Example | Result
+ plus sign Addition =3+3 6
- minus sign Subtraction =3-3 0
Negation =-3 =3
. asterisk Multiplication =3*3 9
/ forward slash Divigion =3/3 I
T percent sign Percent =30% 03
N caret Exponentiation =33 2
Table 5.1: Arithmetic Operators

2. Comparison operators
We can compare two values with the following operators. When these operators are applied,
only logical values are given as a result. i.e. either TRUE or FALSE.
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Symbol | Comparison operator Meaning Example
= equal sign Equal to =Al=B1
= grealer than sign Greater than =A1=B1
A less than sign Less than =Al<Bl1

>= greater than or equal to sign | Greater than or equal to =Al>=Bl
= less than or equal to sign Less than or equal to =Al<=Bl
< not equal to sign Not equal to =Al<>BI

Table 5.2: Comparison Operators
1. String convatenation operator

Strings are also known as text contents. We can use the ampersand (&) to concatenate (join) one
or maore text strings as a single text.
ymbol | Text operator | Meaning Example Result

& Ampersand Connects, or concatenates, ="North” & “wind”| Northwind
two values to produce one
continuous text value

Table 5.3: String Concatenation Operators

5.1.3 The Operator Precedence in Excel:

Sr No Operator
| Exponentiation (%)
2 Multiplication (*), Division (/)
3 Addition (+), Subtract (-)
! Concatenation ( & )
5 All Comparison Operators

Table 5.4: Operator precedence
5.1.4 Cell Referencing:
Cell reference is an another name of an address of a particular cell, group of cells or a range. MS
Excel is a powerful tool which provide a lot of caleulation functions and formulas to be applied
over any single or multiple cells, The way of representing the cell addresses within a formula or
function is called “Cell Referencing”. The basic concept behind the use of cell referencing is
that, when a cell reference written in 4 cell as a part of any function or formula and if thas cell 18
being copied or filled (o another cell then the references given in the cell also changed accordingly.
This feature 15 very useful for application of formulas over multiple cells without making a lot
of changes. Bul, Sometimes the references are required to be same fully or partially after being
copied. In such a cuse, different Lypes of referencing are being used.
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Let’s discuss the different types of cell referencing.
Note: When any fornula is written in the cell and we press enter key after completion of the
‘formula then only result is displayed in the cell itself. The formula wﬁ_ttgnis displayed in the
formula bar. If we want to see all the formulas written in all the cells then we can use Curl +
~ (tild sign) key from the keyboard. We can use this shortcut key again to remurn back in
previous state.

s Relative References:

This is a defavlt referencing in MS Excel. When cell/cells represented by relative referencing
copied to another location, they change based on the relative position of rows and colurons. For
example, if we copy the formula=A1+B 1 from row 1 to row 2, the formula will become =A2+B2.

4 A B € A4 A EEECEES 4 A B c
1 Markil _iﬂ‘lau! 1 bdarksl Marks? Taotal 1 Marks

2l s [euem Bl s [ ‘223

35 8 35 85 8 (25

445 o ’ 48 85 A las

565 68 5 6 68 5 lss

662 35 662 35 6 |82

T2 & 75 & s

8 8 8

Fig 5.2: Example of Relative References

Relative references are especially convenient whenever we need to repeat the same calculation
across multiple rows or columns.

Note: In this tvpe of cell referencing, No row or column is fixed.
s Abzoluie Reference;

Sometimes, we may do not want a cell reference to change when copying/filling the contents of
a cell/cells. Unlike relative references, absolute references do not change when copied or filled.
We can use an absolute reference to keep a row and/or column constant. An absolute reference
is designated in a formula by the addition of a dollar sign (§) before both column and row. Now,
if the cell will be dragged, the absolute references will not be changed. We can see the use of
absolute referencing as follows:

A A B F 4 A ¥ < A A g e
1 Girace Marks= |5 | 1 Grace Markss 5 1

2 Muorks Total 2 Marky Total 2 Mar

3 (65 I ABSCS] ! 1 Es.s un.n!;-ca! + 3|65

4 15 ’ A 25 ’_4 25

5 34 5 34 134

B oas &8s 6 |85

L T a5 T |45

B n [.--' cmmmu:w BT T

885 N\ absolute J 9 9 Biles

Fig 5.3: Example of Absolute References
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As we see in the fig. 5.3, references $C$ 1 are in absolute form. So, after filling the cell formula
in another cells, the reference remains unchanged. Bux, for another reference A3 which is relative
by its type, it changes as per filling of formula in next row. This 18 a basic use of absolute
referencing,
Note: In this type of cell referencing, both rows and columns of a particular reference are
fixed.
s Mixed Relerence:

As its name implies, this cell referencing is a mixwure of both absolute and relative reference
because, only one out of a row or a colwmn remain fixed while copying. This type of reference
is used in special kind of situations where operations are associated with particular row or
column in an advanced manner. In other words we can say that an absolute reference in Excel
refers to a reference that is “locked” so that rows and columns won't change when copied. Such
as:

! | S

T s Lum e ) T e
T il R I A )
¥l iy LS A ;.'.3.]
e o E 2 wNw
i 3 W NN e
¥ ) EER ]
s ! RN )
- S (e
! ; R A AL
03 i 5w nm
’ L T

11
Fig 5.4: Example of Mixed Reference
As we can see in the fig, 5.4, the column A of first reference and row | of second reference are
made fixed with dollar sign. When the particular cell is filled in other cells of different rows
and columns, the fixed row and columns are not changed.
Note: In this type of cell referencing, only one clement cither row or column of a particular
reference are fixed.

5.2 USES OF FORMULAS AND FUNCTIONS
In previous sections of this chapter, we have discussed about formulas and functions. Each
formula and function is having different operation to perform and different syntax to be applied.
We will learn the methods of applying formulas and functions in this section.
5.2.1 Using Formulas
5.2.1.1 Simple use of Arithmetic Operators:
This type of formulas is having different arithmetic operators applied on one or two values,

This is a simplest type of formula which performs basic calculations: Some examples of this
type of formulas are as under in fig. 5.5
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A k| B C b E

1 Nol No2 No3 Formula Result
22 8 4 =A2«B2 10
34 &4 7 =A3+B3+C3 15
46 6 1 =Ad4+B4-C4 11
59 2 B =AS«104C5 27
B'5 3 5 =AG+BECH+3 6

Fig 5.5: Example of Simple use of Arithmetic Operators

Explanation:
S.No | Formula Description
1 =A2+B2 Only one operation with two cell reference
2 =A3+B3+C3 Only one operation with more than two cell reference
3 =A4+B4-C4 Muluple operations with more than two cell reference
4 =AS5+10+C5 Only one operation with cell reference and constant values
5 =A6+B6-C6+3 Muliiple operations with cell reference and consiant values

Table 5.5: Explanation of Simple use of Arithmetic Operators
5.2.1.2 Advanced use of Arithmetic Operators with eperator precedence:

We can design more advanced formulas with more than one operator within a single expression.
In such a case, we have to take care of operator precedence which is the order of execution of
operators when multiple types of operators are used within a same statement. Let's discuss this
fact with a particular example:

y A B
1 Formula Result
2 =5+2*3 11

3 =(5+2)*3 21

4

Fig 5.6: Example of Operator precedence

As shown in fig. 5.6. same values and operators* are used. But the result with and without
parentheses is absolutely different. We must understand the reason behind it. The root cause of
this difference is "Operator precedence”. The default precedence of operators from high to low
is considered as show in the table 5.4.

In the case, when this default precedence is to be managed according to our requirements then
we must use parentheses within our expression. Let’s have a look of some advanced use of
formulas with the use of precedence,
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4 A B ¢ D

1 Valuel Value2 Formula Result
2 2 7 =(A2*10}+2 22
313 B ={A3+B3}*10 70

4 4 6 =A4*2+B4*5 3B
56 5 =AS*B5+AS 356
6

Fig 5.7: Example of Advanced use of Arithmetic Operators

Explanation:
S.No | Formula Description
| =(A2*10)+2 | In this example, two operators are used. * is having highest precedence

g0 the result will remain same with and without parentheses.

2 =(A3+B3)* 10 | Here + operator is put in parentheses which is having lower precedence
aver *. Here the result will be changed if parenthesis are not used.

3 =A4*2+B4*5 | If two operators with equal precedence are put in single formula then
both these would be executed at a same time. So, here + will be executed
after execution of both * operators.

4 =A5*B5+AS5 | Here again * will be executed prior to + operator.

Table 5.6: Explanation of Advanced use of Arithmetic Operators
3.2.1.3 Using formula for calculating the percentage

Calculating percentage is one of the most useful tasks to be used in any of the application. For
example, if we are going to design a resulf card in MS Excel then this operation is also required.
As we already know that we can calculate the percentage using following method.

(Marks Obiained)

Percentage of Mark = - x 100
Total Marks

We can apply this formula in MS Excel data of student marks as follows:

A A B C (0] E F c
Name Marksl  Marksl  Marksl Total Parcentage

1 (Max 100) (Max 100} (Max 100) Max300
e |Ram 45 45 i _1_5‘!.__[?.|.F5’:ﬁ?_q111.’§'§‘_.
3 Gagan 25 84 84 193

4 John 62 55 99 216

5 | Arshid 45 65 64 174

3

Fig 5.8: Example of finding Percentage using Formulas
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Here the formula written above is shown in the MS Excel Worksheet. The results would
appear as per fig. 5.8 shown below.

A A . B | & | Db B [N G
Name Marksl  Marksl  Marksl Total Percentage

1 (Max 100) (Max 100) (Max 100) Max 300

2 |Ram 45 a5 74 164 | 54.66666667
3 |Gagan 25 84 B4 193 54.33333333
=) e T e
4 |iohn 62 55 99 216 w2 |
5 |Arshid 45 65 64 174 58

E | g

Fig 5.9: Example of filling Percentage formula in a group of cells
8.2.1.4 Using caret (") operator:

This operator is used to find the power of any given value. This operator is applied berween two
operands. Such as, if this operator is applied as =A"B, then it will calculate A®. For example, if
=273 is written then 2? become 8 and it would be return as a result. Let's understand the use of
this operator in MS Excel. This is an alternate of POWER function of MS Excel.

LA B e D | E
1 Value Power Formula Result

2 |- - =42 16

3 3 2 =A37B3 9

4 |- 3 =2AB4 8

5

Fig 5.10: Example of caret ( * ) Operators
5.2.1.5 Using ampersand (&) operator:

This operator 18 used to join two string values, This operator can be applied on lext data values
only, We can use more than one ampergand (&) operators within a single statement. We can
write & operator between two string values to operate upon. This 1s an alternate of
CONCATENATE function of MS Excel.

A B C D
1 String 1 String 2 Formula Result
2 Ram Singh =A2EB2 RamSingh
3 Ram singh =A3E" "&B3 Ram Singh
4 John - =A4&" smith" john smith
5 ="Computer"&" Science" _1Eumputer Science
6

Fig 5.11: Example of ampersand (&) Operators

Note: CONCATENATE function joins the given strings without adding anything before or
after the given strings. No blank space or other symbol like comma or dot will be added.
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5.2.2 Using Functions:

We have already discussed that a function is a predefined formula that performs calculations
using specific values. MS Excel includes many functions that can be used to perform required
calculations over given value for a range of cells. We can classify functions in several categories.
In this section of chapier, we will read about some main categories of functions in MS Excel.

Let’s study about the common types of functions in detail.
5.2.2.1 Mathematical Funetion
These functions are mainly used for mathematical calcnlations, Such as:

1. SUM Funetion: This function is mainly used for finding the sum of values provided
in given cells or range. We can use this function as:

=SUM (<values for finding sum>)
A B C D E F G H

1 Nol No2 Ne3 No4 NoS Noé  Function ~ Result
2 |2 4 5 8 6 9  |=SUM(A2:F2) |34

Fig 5.12: Example of SUM funection
. COUNT Function: This function can be used 1o count the number of cells that contain
numbers, Tt will leave the cells having non-numeric values from being counted, We
can use this function as:

=COUNT <valoes to be counted=)

Al BE|C i D] &|E G H
1 Nol No2 No3 No4 No5 Nob Function  Result
22 4 B A 9 |=COUNT(A2:F2) |3

3
Fig 5.13: Example of COUNT Runction

1, COUNTA function: This function can be used when we want 1o count all the cells
having any type of contents. Only those cells will be left from counting m a range that
are empty. We can use this function as:

=COUNTA (<values to be counteds)

Al Bl el D ELTF G H
1 Nol No2 No3 No4 NoS Noé Function _ Result
22 a B A 9 [=COUNTA(A2:F2) S
3

Fig 5.14: Example of COUNTA function
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IV. COUNTBLANK funetion: This function can be used to count only the blank cells in
a range selected. We can use this function as:

=COUNTBLANK i{<=values to be counted:>)

A B C D E F G H
1 Nol No2 No3d Nod4 NoS MNob Function Result
2 |2 4 B A 9 [=EUUNTBLANKME;F2:| i1

3
Fig 5.15: Example of COUNTBLANK fanction

V. AVERAGE Function: This function can be used when we want to get the average
(arithmetic mean) of the specified group of cells or range. We can use this function

ds!
=AVERAGE (<values to find average=)
A B c o E F G H
1 Nol NoZ No3 Nod No5S Nob Function Result
212 a4 8 6 5 9 [sAVERAGE(AZ:F2) 'S. 6666666

3
Fig 5.16: Example of AVERAGE [unction

V1. MIN Function: This fanction will be used when we want 1o find the minimum number
from a group of cells or range selected as a resull. We can use this function as:

=MIN(=values, out of which minimum ao is to find>)

A B C D E F G H
1 Nol No2 No3 Nod4 No5 Nob Function H Result
22 2 8 & 5 9 [-minNazF2) 44

Fig 5.17: Example of MIN function

VIL MAX Function: This function will be used when we want to find the maximum
number from a group of cells or range selected as a result. We can use this function as:

=MA Xi<values, out of which muaximum no is to find>)

A B C D E F e H
1 Nol ND_E_HEJ_N_GIQ- NoS No6 lf!.l_r!;ﬂp_r_l Result
22 4 8 6 5 9 [=maxazr2) |o

3
Fig 5.18: Example of MAX function

VI RANK Function: This funcdon will provide the rank to the selected cell or value
within a selected range. We can use this function as:
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=RANK (<group of all values> , <valoe whose rank is to find>)

4 A ] [ =
Nos  Formula _Resuit
A [-mankaziasisasi) s
[=RANK(AZ 5A52:54512)
I=MNI|:{A4.5-151-5A512I
7 I-MNM.&S,SASELNIH
5 I-MNHIM,MSI'NH}
B Ismunr,sn.sz-s.niuh
B I-MN!{-I#.‘S&SJ.SASIIP
a9 =RANK(AS SASZ:5A512) 1
4
B8
i

-

1N
2 [a
5
a4

LA - I )

L=RANK(AL0,5AS2:5A512) 8
I-MHKI%'I. 1,5A52 SAS12} 2
“RANK(ALZ SAST: SAS12) B

Fig 5.19: Example of RANK function

IX. LARGE Function: This function will give the Nth Largesi no from a group of cells
or range. We can use this function as:

=LARGE (<group of all values> , <value of N to find Nth largest No=)

4 A B C
1. Mos Formuls Regult
24 =LARGE[SAS2:SA%121) [0
35 =LARGE(SAS):5A512.2) &
4 =LARGE[SASZSASIZY) 8
5.7 =LARGE(SAST:SAS12.4) B
65 =LARGE[SAS2:SA5125) 7
78 =LARGEISASZSASIZE) 5
a8

9.9

104

i &

24

Fig 5.20: Example of LARGE function

N, ROUND Function; This function is used to round a number to the given numbers of
digits. If we give number of digits in negative then it will round the number before
decimal point with 10s, We can use this function as:

=ROUND (<value><significance of round off>)

4 A B C
Nos Formula Result
4.76584 =ROUND(A2,2) 4.77
454341 =ROUND(A3,2) 454
4532.652 |=ROUND(A4,-2) 4500

ol W A -

Fig 5.21: Example of ROUND function
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5.2.2.2 Conditional Functions
These functions are used to perform calculation based on some condition. We can use any of the
compariscn operator within these functions. Somie of the conditional functions are as under:
. IF Function: This function is used to perform some particular operation based on a
comparison operator. It's main function is decision making within MS Excel worksheet.
We can have some of the use of this functions as shown in fig. 5.21
Simple Use of TF Function: IF Function can be applied simply by giving one comparison
operator anc based on thar operator, two different operations or values can be given.

Such as:

A B C
1 Marks Formula Result
2 |65 =IF(A2<40,"FAIL","PASS") |PASS
3 25 =IF(A3<40,"FAIL","PASS") FAIL
4 45 =|F(A4<40,"FAIL","PASS") PASS
5 90 =IF(A5<40,"FAIL","PASS") PASS
6 33 =IF(A6<40,"FAIL","PASS") FAIL

Fig 5.22: Example of Simple if Function

Using Complex conditions used in [F Function: IF function can also be used for any
complex operation to be applied in MS Excel, For example. we can use this type of IF
function for providing Grades in a Result Sheet. i.e. A,B,C or D.

A B C
Marks Formula Result
65 =|F(A2<40,"D",IF(A2<60,"C",IF(A2<80,"B","A"))) |B
25 =|F{A3<40,"D",IF(A3<60,"C" IF(A3<80,"B","A")))
45  =IF(A4<40,"D" IF(A4<60,"C" IF(A4<80,"8","A")))
90 =|F(A5<40,"D" IF(A5<60,"C" IF(A5<80,"B","A")))
33 =IF(A6<40,"D" IF(A6<60,"C",IF(A6<80,"B","A")))

4 O N B W R -
o >» O O

Fig 5.23: Example of complex TF function
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I1. SUMIF Function: We can find the sum of any specific value from the given range or
group of cells by using this function. We can use this function as:

=SUMIF (<group ol values> , <value as a criteria>)

A | C
I Mos Formuls Rl
El  [-sumiFArniae) [
15

4 4

57

B 5

18

i &

8

m'a

"8

124

Fig 5.24: Example of SUMIF function

L COUNTIF Function: We can count the number of cells having any specific value
from the given range or group of cells by using this function. We can use this function as:

=COUNTIF (<group of valuess | <value as a criteria>)

A B L
1 N IUHIIL'I.._H! Rsapuby
2[4 [-COUNTIFAZ ALLE) |3
P 5
4 4
7 |
B 5
T8
BB
9
104
e
12 4
e

Fig 5.25: Example of COUNTIF function
5.2.2.3 String Functions

These functions are used on text data only. There are lots of different operations which are
generally required to be performed on text data. Let's discuss some of the string functions these
are being used in MS Excel:

I.  LEN Function : This function is known as Length function. We can find the no of
characters including spaces and symbols within a siring using this function. We can
use this function as:

=LEN (<String value>)

A g c
1 String Formula Result
2 |PERSONALITY  [=LEN(A2) |11

3
j Fig 5.26: Example of LEN function
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II. LEFT Funection: We can have left part of string for any length provided by the user
with the help of this function. We can use this function as:

=LEFT (<Siring value> . <length in numbers>)

A B C
1 String Formula Result
2 |PERSONALITY =LEFT(A2,8) PERSONAL

3
Fig 5.27: Example of LEFT function
[, RIGHT Function: We can have right part of siring for any length provided by the
user with the help of this function. We can use this function as:
=RIGHT(<String value> , <length in numbers>)

A B C
1 String Formula Result
2 [PERSONALITY  |=RIGHT(A2,8) |SONALITY
3

Fig 5.28: Example of RIGHT function

IV. MID Function: In case, when a part of siring is required the specific character from
the middle of string 1o the specific number of characters of a swring, then this function is
used. We can use this function as:

=MITD (<String value> , <Starting position>,<reguired lengths)

A B C
1 String Formula Result
2 |PERSONALITY =MID(A2,4,5) |SONAL
3
Fig 5.29: Example of MID function

V. LOWER Function: This [unction of MS Excel will convert the characters of whole
string to the lower case. We can use this function as:

=LOWER(<String value>)

A B c D
1 String Formula Result
2 [computer [=LOWER(A2) |computer

3
Fig 5.30: Example of LOWER function
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V1. UPPER Function: This function of MS Excel will convert the characters of whole string
to upper case. We can use this function as:

=UPPER (<String value=)

A B C |
1 String Formula Result
2 |Computer |=UPPER(AZ) |cOMPUTER

3
Fig 5.31: Example of UPPER flunction
VII. PROPER Function: This function of MS Excel will change the case of whole string.

The first letter of each word would become CAPITAL and all rest of the letter will become small
afier using this function. We can use this function as:

=PROPER (<String value>)

A B E
1 String value Formula Result
2 THis STRing 1s NoT proPER =PROPER{AZ] This String is Mot Proper
3 COMPuter =PROPER[AZ) Computer

4 |Th|'!. 5 very USEFUL FuncTION (=PROPER[AM) This I Very Useful Function
5

Fig 5.32: Example of PROPER function

VIIL TRIM Function: Trim Function is used to delete th extra space from the string. This
function will not delete the single space between the words and will delete all the extra leading
and trailing spaces in the string.

=TRIM (A2} = TRIM (<String value>)

String Value Formula Result
This string is very useful Trim (As) This string is very useful
Fig 5.33

5.2.2.4 Date Funetions:

These functions are special ones which are used to manipulate daies in MS Excel. We can use
several functions for different purposes. Let's understand these functions with examples.

L TODAY Function; This date function would return the system date as a result. The
format of date appeared can depend upon the system setting for Date and Time option. We can
use this function as:

=TODAY!( )
A ! B =
1 Formula Result
ALl
2 [=Topav() | 6/24/2021
3 [System Date)

Fig 5.34: Example of TODAY function
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1L NOW Function: This function will return the date of a system in conjunction with the

current time. This time will be updated automatically when the sheet is opened or the formula is
refreshed by editing it. We can uge this function as:

=NOW( )

A B C
1 Formula Result
2 [=NOW() 6/24/2021 18:13
3 (System Date & Time)

Fig 5.35: Example of NOW function

ITI. DAY Function: This Function will return only Day part of the date given as an arguoment.
We can use this function as:

=DAY (=date value=)

A B
1 Formula Result
2 |=DAY(TODAY()) [24

1
Fig 5.36: Example of DAY function

IV.  MONTH Function: This function will return only Month part of the date given as an
argument. We can use this function as:

=MONTH (<date values=)
A B C

Formula Result
=MONTH(TODAY()) | 6

-

Fig 5.37: Example of MONTH function
V. Y EAR Function: This function will retwn only Year part of the date given as an argument,

We can use this function as; =YEAR (<date values)
A B |
1 F_g_rm_qla_ Result
2 [=YEAR({TODAY()) | 2021

3
Fig 5.38: Example of YEAR function
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5.3 SORTING AND FILTERING DATA

Sorting and Filter are very useful option of MS Excel. Both options are having their own
importance, We will discuss both these options in this section.

5.3.1 Sorting Data

By the mean of sorting data in MS Excel, we refer to rearranging the rows based on the contents
of a particular column. We may require to sort a group ol data to Keep it in an ordered manner.
The process of sorting data in MS Excel can be applied in different ways. Let's discuss the
common methods as under:

This is a simple-st form of sorting data in MS Excel. In this method of sorting data in MS Excel,
the selected data is being sorted in the particular order using last column of the selection. We
cannot manage multiple columns in this method of sorting. To apply sorting we can use following
steps.

1. Select the required dara to be sorted.

2. Click "Seort & Filter” bution from Home tab ribbon.

3. Select the sorting order from the Dropdown menu appeared.
Our selected data would be get soried,

A B
i
Ram
Sundl
Harish
Hutin
A Py
Togesh
Nowea)
dahn

iy

Fig 5.39: Exnmple of Sorting us!n-g Home Tab Ribbon

Here, we can see that the selected data has been sorted in ascending order according to the
Marks colwmn i.e. Last column of selection.

1
£

Jpeepgees

L5
§
e
il
£
Er\-

2
F

Mgy

& O }
-i Towl i

H-r i + 5
|-l [ TR

?Eiﬁiiii!if--
zusa :j renfo
$EEEEEfES

T B AR TV et )
- e D O e e R W

Sorting Data using Data Tab:

If we want to sort this data according 10 Subjects then we have (o use another method. We can
use Sort Opﬂnn of Data Tab ribbon after selecting the data as follows:

- ra

I i) s 5705 T @ e

o j e —gae o

- o = D]
Fig 5 40 Exmnple of Applying Sorting from Data Tab Ribbon
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After this process, when we press OK button then the selected data will be sorted according to
Subject column in an ascending manner. The daia afier this sorting will look like this:

A B C D

1| SrNo Name Subject Marks
2 3 Ram English 25

3 3 Aman English 95
4 7 Yogesh  English 42

5 6 Sunil Math 66
6 8 Yatin Math 85

7 9 Neeraj Math 65

8 4 Harish Science 34
9 1 John Science 37
10 2 Smith Science 85 |

Fig 5.41: Output of Applying Sorting from Data Tab Ribbon

Here, our data is sorted as per our selection i.e. according to Subject column. But we can have
further requirement to sort our data according (o Name when the Subject remain same in the
given order. For this purpose, we can use option of adding multiple columns in our sorting
dialog box as shown below:

1B b b || - P e =

o Mamm bt Markn

1| Wi
2| E] Amiis Engist k-]
1 & Ram Rnghish h
4| F Yogesh  Keghish a4
@- B Newnmj M L4
L i Surul Narh T
v LY Yatin Matm 3]
] 4 Harish  Sciencw k]
i 1 sk fiipriom A
w2 Samith A lmm UL

Fig 5.42: Example of Applying Sorting according to multiple columns

Now, the resultis sorted by subject in an ascending order. But, when the subject column remains
same then further our data is sorted according to Name column in an ascending order.

Note: if column names are not shown in the column list of Sort dialog box, make sure we
checked “My data has headers” option at top right of the box. This option will make first row
of our selection as column names. If it is not checked then columnl, column2, . . .. will be
displayed in the place of column name in column list.
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5.3.2 Filtering Data

Filter option of MS Excel can be used to selectively show our data in a worksheet after hiding
particular parts of unwanted data. This option of data manipulation is very important to the
applications point of view because we can have only data of our interest rather than the whole
data. For example. from a data of all students and all subject. we can filter only one needed
subject from the data to be displayed. We can use this option as under:

1. Prepare our data as per the availability of different options.
2. Select the data to be filiered.

3. Select “Filter option”from Data Tab Ribbon.

4.  Filter Option will be applied as shown below:

[ B C o
1| SrNo Name  Subject  Marks | s L B
2| 5 mm g 25 | 1| SrNo Name  Subject . Marks
36 Sunil Math 66 | - 25 H s LI :‘m" ::
4| 4  Harjsh Science 34 Lo S e 3 fadt 3
5B Yatin  Math S o IR 2
6l e o s g e e o
7| T Yogesh  English a " =" | :‘ ; 7 Yog 42
5 9 MNeera) Math O HEE L =
9 1 John  Scenee 37 ] LE A R
[} | z Smith Science 85 P — 10 2 Smith Seience s

Fig 5.43: Example of Applying Filter Command
Filtering by Data Items:

As we can see in the figure shown above, an arrow option will start displaying with each selected
columin, We can click on any of the particular arrow of required column to filter our data according
to which the selection is to be made. We can use different options for filtering. Such as, we can
select the require data from the list by ticking only particular values selected for a particular
column. The list of all distinct values will be shown automatically in this dialog box.

A B C D e S
1 SrNo Name Subject . Marks I | SrNo Name  Subject , Marks
2| 5 Ram 25 3 6  Sunil _Mlth 66
6 Sunl 66 S| 8 VYatin  Math 85
4| 4 Harl 34 L] 9  Neera) Math 65
5 8 Yau = 85 1
6| 3 Am ™ g5 |® 12
T T Yo a2 13
B 9 Nee R 65 14
90 1 John  summe 3 15
W, 2 Smith  Science 85 | 16

Fig 5.44: Example of Filtering using List Items
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As we can see in above result, only those rows are displaying which are having only math value
within a select column i.e. Subject.
Filtering according to range of data:

Using this option of filter, we can have all the rows as a result of filter which are having data
value in a particular range of data. In the data selected, we will apply this option on Marks
colunmn. We can use this option as follow:

i A B e D E
@ 1 Sr No . Name _Subject . Marks
2 5 Ram ENgl s wiomee
3 Sunil M3t s cmrmn
4 4 Harish :5_CiE1!. el B —
5 8  Yatin Mat = Bl e
5 3 Aman ._Eng_l; -'é: o B s
7, 7 'Yogesh  Engl &% S—
8 9  Neeraj Mat == e
9 1 John Sciele—r——o —
10 2 ‘Smith Science 85
@Cuﬂvrﬂ Antof e ! -
ﬂﬁ:ﬂl:‘:‘l.ﬂhﬂ'*
i grester than oF equdta ~ | 3 v
. Bae OO
i beds Eman &1 eguial i w{ b 3

Ukie * & iepresdnd sy ringhe chassiles
Wie * ta repriaent any vends of charadten

i

Fig 5.45: Example ol Filtering using Custom Auto filter Option

As we can see, a new dialog box “Custom AuvtoFilter” appeared. We can create required filter as
one or two conditions with different options and using “and” , “or” operators between those
operators. As we have selected greater than or equal to 50 and less than or equal to 80 as our
filter criteria. The result will be as per shown below:

A . C D
1| SrNo  Name  Subject . Marks
3 6  Sunil Math 66 |
8| 9  Neeraj Math 65

11

Fig 5.46: Result of filter used as a custom auto filter
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Filtering by coler:

Sometime, we are having our data highlighted with different colors and we may require to filter data
according the colors. Both fill coler and text color can be used for this option. We use this type of filter
by choosing “Filter by color™ option from filter menu and then clicking the particular color. Such as:

A H [ b A 1] C D
1 w No  Namo Sulrest htaris 1 8 Mo Name Subyect Plarks
: Engliah s 2 5 Ram Engiinh it
3 Math G& 4 4 Harish' | Szience E2 1
4 = =y 34 B 9 Mearaj Math &5
5 = BS ‘ ] 1 Jokn Sclence L 7
L Englesh 85 1
[} j_ Engliasn a2 12
4 =F hdath a% 13
9 i T Seignca 37 [
1 2 ScHmae BS 15 |
ar

Fig 5.47: Example of Filtering using Color

As wecan see, only those rows are selected for display which are having selected color (Yellow)asa
fill color in thar pariicular column,

Note: Filter on color can be applied on one color at a time. We cannot apply multiple colors
for one filter,

5.4 WORKING WITH DATA TOOLS

We have already studied very tools being used in MS Excel. All these tools are on the top to

their user point of view. MS Excel provides some more advanced data tools too which can be
used in some special type of operations. Lel’s have a look over these tools.

L. Text to columns: This option of MS Excel can be used to split our contents according
to a tixed length or any particular symbol (like comma or space or any other) into
different cells. This option can be applied by using “Text to Columns™ option from Data
Tab Ribbon after selecting the cell having contents to be split, Such as;

A Jeikid

1 _Rum Sham, inder. Moban

=] - S T ) e

Fig 5.48: Example of applying Text to column option
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We can see, our contents are showing in the 2 of 3 step in different columns. We can change the
delimiter if these are not in required manner, Then go to Next step and press finish afier selecting the
requited data format.

Carcen e i Calumed Wiasen - Bag el § T =
I'“HIHHFHLII“H'!HB‘EMIHIHHM'“
Corfumn ke farmal
™ ® Canara) .
GONFTN [OMETEs e S U numbeL SE erery
5 - Leak - 1o Habry Al ety safurs b e
Date - mCH Advarard

() 0 R s (i)

Daitinatsar: 4487 ®)
e ]

Pl
'_ rery
L £ 3
.

r A 8 < o E
1 [Ram Sham  Inder  Mohsn

2

3

Fig 5.49: Finishing Text to column option and output
Now, as we can sce, our selected cell contents have been copied into different cells based on cormma
telimi
2. Remove Duplicates: This option of MS Excel can be very useful when any of our cell is
having values written for more than one time and we have t create a list with all the values
exactly once, We can do thig by using this option of Data Tab Ribbon. We can use “Remove
Duplicates” option from Data tab ribbon after selecting the cells to do the needful.

==l %
I. ..... .
2 :
‘é ||"' . !
Owis  Comabeisie |
ylaalinn - et ] Ii
- Daka Tueh f : i |
Romsin Dhupelsivs . i Fip———n - 8
|| Onlete i 1 vy i 1 e e — q
| | i - 1 .ﬁ. -

| Wong e o b b ik

| whmgid b aPATRE b iy L]

" ariwmann L
o

Fig 5.50: Example of removing duplicate values
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Note: In some cases, we have duplicare values in one column but these are associated with another

column for their uniqueness to be considered. We can apply this feature on more than one column also
to have uniqueness based on mpltiple columns.

3. Data Validation: This option is very useful in those cases where we have any column in
which only some particular values are allowed to be entered. For example, we can apply this feamre
on marks column where the marks must be in the range of 1 to 30. If the value entered does not
meet the given eriteria, a specific error message will be displayed. We have several options regarding
this tool of MS Excel. We can apply this tool by selecting Data Validation option from Data Tab
Ribbon after selecting the required column or cells.

A A &
o iy 1 Marks
S =, e et . =
paaaEl - B e i i e 2
[ Marks Data  Consolidate | - — - 3 14
Validation * o o 43
’ T4 Dits Yalidatior. e ’ e S
B Cincle invalid Bate i i ﬁ e
= v a T P R e e B T St
8 Sl oo Crei e e aes e o — IR

Fig 5.51: Example of applying Data validation

As we can see in the figure shown above, i the value (like 36) given out of specified set of values
then given error message will be displayed. We can leave the cell blank either. If we do not want to
allow blank cells to then untick the “ignore blank™ checkbox on setting tub of Data Validaton dialog
box.

Note: We can also add input message for our data validation applied cells to tell the user
about given criteria of valid values for that particular cell.

POINTS TO REMEMBER
1, Function is a predefined formula that performs calculations upon specific values in a
particular order.
2. We can have SUM, AVERAGE, COUNT, IF, SUMIF, COUNTIF as examples of
functions available in MS Excel.

Formula is an expression that calculates values in a cell or in a range of cells.
A formula can be designed using any type of operator. Such as =A1+10.
Each formula and function must begin with equal to (=) sign.

o e o

Operators are the symbols which represent a particular operation to be performed in a
particular application, Arithmetic, Comparison, Reference are some examples of MS
Excel operators.

7. Examples of Arithmetic operators are +,-,/,*, %, *,
8. Examples of Comparison operators are = >, >= , <, <=, <,
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10,

11.
1

13.

14,
13

16.

17.

18.

15,

The way of representing the cell addresses within a formula or function is called “Cell
Absolute referencing, Relative referencing and Mixed referencing are some of the examples
of cell referencing.

Each expreszion of formnila can be represented as a combination of Operators and Operands.
Operator precedence is the order of execution of operators when multiple type of operators
are used within a same statemnent.

Main categories of functions in MS Excel are Mathernatical Functions, Conditional Functions,
String Functions, Date Functions.

IF, SUMIF and COUNTIF are some examples of Conditional Functions in MS Excel.
Serting is a command used for rearranging the rows based on the contents of one or more
particular columns,

Filter option of MS Excel can be used to selectively show our data in a worksheet after
hiding particular parts of the unwanted data.

Text to columns option of MS Excel can be used to split our contents according to a fixed
length or any particular symbol into different cells.

Remove Duplicates option of MS Excel can be very useful when any of our cell is having

values written for more than one time and we have to create a list with all the values exactly
onee.

Data Validation option is very useful in those cases where we have any columm in which only
some particular values are allowed to be entered.

@
EXERCISE

o,

Oue: 1 Multiple Choice Question @

|

Each function or formula must start with symbol in MS Excel.

A + B. =

C. & D. A

Which function of MS Excel can be used to find mimimum numbers from given range?
A, MINIMUM B.MID

C. MIN D. None of these
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m

Ampersand (&) symbol is an lternate of function in MS Excel.

A.SUM B. AND

C. CONCATENATE D. POWER

Which data tool can be used to have only disunct values in a particular column?
A, Data Validation B. Text to Columns
C. Formula D. Remove duplicates
Which one is an example of Arithmetic Operator?

A+ B.%

G D. Allof these

Que:2 Write Troe or False:

I

< 2 B =

We cannot count blank cells in MS Excel.

Formula is an expression of operators and operands to perform calculations.
SUM function can be used 1o perform addition of values in a particular range.
Text to columns option can be used o split our contents in multple cells.
NOW function returns current daté and time in MS Excel.

Que:d Short Answer Tvpe Questions:

< 2 5 42"

V1.

Write arithmetic operators being used in MS Excel.
What do you mean by Data validation?

Give the name of any three mathematical functions.
What is sorting in MS Excel?

Define formula.

Provide the name of various conditional functions used in MS Excel.

Que:d Long Answer Type Questions:

I
m
m

Whatis Cell Referencing? Explain its types.
Define any 3 String Functions.
What is Function? Explain any two mathematical functions with suitable exaraple.

102 @
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| Lab Activity |

1. Apply all the given formulas or function in MS Excel and write the output:

=SUM(34,45,67,65,34)

=MIN(54,67,1,34,67,1,2,1)

=COUNT(2.4,6,A,3,D,A,5,6)

=COUNTA(2,4.6,A,3,D,A,5,6)

=LEN(“I LOVE COMPUTER”)

=MID(*MYSELF",3,3)

=RIGHT(*AUTOMATIC",5)

=NOW()

=TODAY()
=“MY"&" “SELF"

= hn‘,w,!&“ H&hSELF' L]

=PROPER(“I aM a GOOD stUDent”)

=SUM(3,4,5)+LEN(*GOOD")

e

=473

=MIN(3,9,8,0)+MAX(0,5,2.4)
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2. Enter the required formulas in “Detail Marks Card” prepared in chapter 4 as shown
helow.

GOVERNMENT SENIOR SECONDARY SCHOOL

CITY NAME
DISTRICT NAME
Pre-Board Examination
Roll No 30 Student 1D 258965
MName of Student KAMALPREET
Father Name SHIVPREET
Mother Name NAVLEEN
Class 9TH Date of Bith 277082006 Section H
UID No 4528-65985-4587 Gender MALE
Detail of Marks Obiained
sl ... |§|3 | N
& E & 5
a
1 |ENGLISH 100 40 45 45 D
2 [PUNUABI 10| 40 [ 63| 63| c =
m

3 |HINDI 100 40 56 56 D 3

4 |SCIENCE 10| 40 | 45 | a5 | © E

5 IMATH 100 40 88 39 F

6 |SOCIAL SCI 100 40 62 62 C

7 |COMPUTR SCI 100 40 45 45 D

8 |OPTIONAL 100 40 652 52 D

9 |WELCOME LIFE 50 20 44 88 B

TOTAL MARKS 359
Maximum marks Secured F 88 |
Minimum marks Secured |
(Grade 0-40 E 40-60.D, 60-80.C, 80-90.8, 90-100. A)
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Microsoft Excel (Part-4)

,_[ Objectives of this Chapter:} o
6.1 Setting Page Layout in MS Excel
6.2 Working with dilferent views in MS Excel
6.3 Protecting Sheet and Workbook.

%

INTRODUCTION

We all have become able to prepare any kind of MS Excel worksheet with rich formatting, Data tool,
Functions and formulas and other kind of operation needed to represent our data in required style. In
this last chapter related 10 MS Excel, we are going 1o lean about Page layout and security options used
for our workbook. This is very important chapter because all these objectives related 1o this chapter
are concerned with finalizing MS workbook to be printed or shared. Let's understand all the related
tools in detail,

6.1 SETTING PAGE LAYOUT IN MS EXCEL

These options or tools being used in MS Excel are mainly concemed with printing of our worksheet.
Page Layout tab provides some commands which let us control the way our content will appear on a
printed page. These commands may include several options like Margin, Page orientation, Paper size,
Print area, header/footer and other printing related tasks, Some of the page layout options, such as
print titles and page breaks, can help make our workbook easier to read. We can explain these tools in
details as follows:

6.1.1 Margin

Margins are the empty

il T — '.'I—-_'PTF - -
gpace between the i___ﬂfﬂﬂ_fmj_l‘!iﬂ,..r" = .n....................... el P _‘:_'__ Top Mm:
worksheet data and the ey S
w
left. right, top, and ol
bottom edges of the - _:?’.‘ﬁ:.."_"[' -
printed page. We can = Ty f= [ | —

) L [ l. o Fhesi [siwialug ok !,a- = N "\
adjust margin to add o Mamn_ S CH 1 | | g
more or less space | e Hi
around user contents - OE O
on all the sides. We T B B
can  understand oot Margn L. LT ______r._.;,..__j-—_—;i; Bottam Margin
different margins a S :
under: § Fig 6.1 Different types of margins in MS Excel
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We can remove any of the marging shown above by setting as zero for its value. Let’s understand the
different wavs to manage Page Margins in MS Excel.

6.1.1.1 Setting Margins:

We can change any of the margin according to our requirement in MS excel. We can change margins
from Page Layout Tab as described below:

A pplying standard margin:

This is a simplest and fastest method of setting the margins in MS Excel. There are some pre-
defined margin templates to be applied. We can use Margin option from Page Setup group in
Page Layout Tab.

Insert Fage layout | Formulas Data

e 0QE

EMugim nentation Size Print. Breaks Ga
- - - “_.TEB' -
———  Last Custom Setting |

Top: 0.39" Bottom: 0.33° |
Left: 0.25° Right: 0.25 |
Header, 0.3° Footer 03" |

! | Nomal '

[ Top: 0.758" Bottom: 0.75
Left: 0.7 Right: 0.7°
Header: 0.3° Footer: 0.3°

I Ty Wide
il Fifi B Top: 1* Bottom: 1°
| | Left: 1 Right: 1
g Header 0.5 Fooler 0.5

7
— Marrow f
[ Top: 075 Bottom: 0.75 |

Left: 025 Right: 025"
Header: 0.3 Footern 0.3
Custom Margins... :|

Fig 6.2 Pre-defined Margins of MS Excel
We can see in the figure above, some of the margin templates are:

i, Lasi custom selting: We can apply any size [or margins in MS Excel using “Custom
Margins” option at the bottom of margin menu. Once we set any margin using this
option, the user given marging become the sizes of this template and we can apply the
same margin for any of the other worksheet with this option.

il.  Normal: This i1s the default margin for every MS Excel Worksheet. It is having top
and bottom margin as 0.75", Left and Right margins in this teraplate are (0.7". Header
and Fooler margins are pre-defined as 0.3" in size.
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iii.  Wide: Thisis the largest size template for margins of MS Excel Worksheet. Itis having all
the margins pre-set as |" but the Header and Footer margins are pre-defined as 0.5" in size.
iv. Narrow: This is the template with smallest sizes for marging in MS Excel. Itis having top
and bottom margin as 0.75". Left and Right marging in this template are 0.25" and Header
and Footer marging are pre-defined as (.3" in size.
Once we click on any of these options. the selected size for marging will be applied to the current
worksheet of MS Excel workbook.

Note: If we are working in more than one worksheet of one MS Excel workbook then we have
to apply the margin serting for each sheet.

fi.1.2 Orientation

Page Orientation refers to how output is to be printed on the page/pages. We can use our page
either in vertical or horizontal direction. MS Excel provides two orientations for our page. i.c.
Portrait and Landscape.

e (1) Portrait Orientation is used in the case when we have a report which is longer
than a page and less number of columns then we can use portrait orientation for
our page layout.

e (2} Landscape orientation option of Page Layout is very useful when we have to our
worksheet in wider format and number of columns are more 1o print.

Landscape

Portrait
We can use these options of MS Excel using following way:
Changing page orientation from Page Layout Tab Ribben:
This is a very easy method of setting the page orientation in MS Excel. We can use Orientation
option from Page setup group in Page Layout Tab to change the page orientation in MS Excel.
Such as:
Formulas Cats Baview

) & = = =

ize Frumt Breakts Baikgrowund Pruomt
AFem = - THllei

Fortrait

5 ¥ G 2]
! I @ SECONDARY SCHO(

Fig 6.3 Page Orientation option of MS Excel
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As we can see in the figure above, the menu appeared after selecting orientation option will
display both Portrait and Landscape option. We can choose any one layout from this menu. The
curtently selecied orientation will be displayed highlighted already in the menu.

6.1.3 Size

Size option of Page Layout Tab is used when we want to adjust

the contents of a worksheet on a specific size of paper. On the ™= &= f=e
basis of amount of information and the layout size of our contents, L;:-r :’% mﬁ H:fﬂ E
we can change different sizes such as Letter, A4, Legal, different - L
types of Envelops etc. To have our printing on a specific size of ]| asar

paper with full page utilization we can change the size of paperas (] . :
follows. . .

Changing Size from Page Layout Tab Ribbon: 0 tescutme = !
This method of choosing ihe required paper size in MS Excel is i g

very fast and easy. We can use Size option from Page Setup | . M :

group in Page Layout Tab to change the page orientation in MS L seram

Excel. It will display all the pre-defined options of Paper Size ' i

available in MS Excel. We can see the menu appeared when we e I

choose Size Option from Page Layout Tab in the given ligure. s 1959

As we can see in the given figure, the menu appeared afier T

selecting Size option will display all the size options to be used e =
as a paper size. We can choose any one size from this menu. et Papen oo

The current selected Paper size will be displayed highlighted Fig 6.4

already in the menu.

h.1.4 Print Area

Sometimes, we may require printing of only a specific part of a worksheet, To make this task
easily, we can use Print Area option of Page Layout Tab, Once a print arca specified, we can sce
the printing contents and its layout can be viewed with the help of print preview.
Set Print Area :
This option of MS Excel Page Layout Tab will let us define a new print area. We can have our selected
ares as a print area by following given steps.

e  Select the required area to be marked as a print area.

e C(Click of Print Arca option of Page Layout Tab.

e A dropdown menu will appear. Select Set Print Area option from dropdown menu
appeared,
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Onur selected area will be marked as print area. We can see how our printing will look like by using Print
Preview appearcdafrer selecting Print Gpunni}f File Tab.
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Fig. 6.5 Setting Print Area

As we can see in the Print Preview option, only the selected part or workshect which is set as Print
Arcais displaying as a printing content.
Clearing Print Area;
Onee a print area is set in a worksheet, no other content will be printed for as long as print area exists.
If we want our whole sheet to print again then we can clear any existing print area using Clear Print
Area option of the same menu of Print Area of Page Layout Tab.
Note: It multiple regions are selected for print area then each of the different region will be
selected as a different print area and will be printed on different page.
6. 1.5 Page Break
Page Break option of Page Layout Tab is very useful to split our contents o be printed among
different pages. Sometimes we see the page break option similar to the print area but both are
nol same as when we insert page break at a location then it splits the whole worksheet as a
different page/pages from that point. All the contents remain printable but on different pages.

Print area on the other hand prints only the selected part of worksheet and all other contents are
skipped from being printed,

Page break is always inserted at top left corner of active cell. We can insert a page break using
following steps.

e Place the active cell accordingly to the desired location where Page Break is 1o be
inserted.

e Click on Breaks option from Page Layout Tab.
e  Select Insert Page Break from the menu appeared,
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After these steps, we can see the page break effect in print preview option.
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Fig 6.6 Applying Page Break

We can see in the Print Preview option, our contents have been split among 4 pages and contents of
first page are displaying in the print preview. We can remove existing page break with the help of
Remove Page Break option of the same menu of Break option of Page Layout Tab after placing our
active cell on the existing page break.
Note: If we want to remove all the page breaks existing in a worksheet then we can use Reset
All Page Break option of the same menu appeared afier clicking Break option of Page Layout
Tab.
1.0 Scaling

Scaling refers to compress or expand the size of contents when printed on the specific paper
size. This option is very wseful when we have to a large worksheet to be adjusted on one or
more pages when printed. We can also do vise-versa. i.e. A small content is to be expanded
over multiple pages. We can use this option using Print Preview Option as follows :—

Setting Scaling using Print Preview option
This option is very easy when we have to adjust our whole contents on page or one aspect

either row wise or column wise on one page. We can use this option by clicking Scaling option
displaying as a last option of Print Preview menu, Such as:
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Fig 6.7 Setting Scale option using Print Preview

As we can see in the figure above. there are some of the different options.

]

4.

Fit Sheet on Oue Page: This option of scaling a worksheet on one page. Tt will reduce
the scaling percentage automatically as mouch as our contents becore fit on one page.

Fit All Coluwmmns on One Page: This option of scaling will fit all the colurons on one page.
It will reduce the scaling percentage as much as whole contents become horizontally fit on
one page. The vertical length of the contents can be on any number of pages.

Fit All Rows on One Page: This option of scaling will fit all the rows on one page. It will
reduce the scaling percentage as much as whole contents become vertically fiton one page.
The Horizontal length of the contents can be on any number of pages.

No scaling: This option of scaling will reset the existing scaling to [00%.

We can select the required option of scaling and the print preview will be updated accordingly.

6.1.7 Setting Header and Footer

In the case when we require 1o add any particular content on the top or bottom of each page then we
can use this option of MS Excel. This option is very useful to add any important information like page
number, file name or any other custom message. We can use this option from Page Setup dialog box. Tn
this dialog box, Header/Footer Tab let us specily the required Header or Footer. we can use this
option as under:
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Fig 6.8 Setting Header/Footer

In the Page Setup dialog box, we can use Custom hHeader or Custom Footer buttons o give a
custom message to be displayed at top or bottom respectively. By chicking any of the button,
respective Header/Footer dialog box will be opened, It will display three sections as Left, Center
or Right. We can add contents to be aligned according to any of these options. We have other
options like Insert Page Number, Inert Number of Pages. Insert Date, Insert Time. Insent File
Name, Insert Picture etc. on this dialog box. We can add any of these options also as a header ar
footer.
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Fig 6.9 Choosing pre-defined Header/Footer

Another option for header or footer is applying any of the header/footer from pre-defined template.
We can select required template to easily apply header or footer.

When we have given all the options for header/footer, we can apply the header or footer by
clicking OK button.

1.8 Setting Page Lavout using Print Preview Window

Page Layout settings can also be changed through Print preview window. We can change almost all the
settings from this window. When we choose Print option from File tab, then following windows appeared
which also displays Print preview.
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Fig 6.10 Setting margins using Print Preview

Orientation:We can change page orientation when we print or seenthe prini preview
of our worksheet. To apply page margins using this way, we can use print preview
option displayed when we go to prini option of File menu, We can see the Page
Orientation option just above the Paper size option, Both portrait and landscape
options will displaywhen we click on this option. We can change the required
option and the changed page layout setting will be displayed in print preview
showing in the same screen.

Size:We can change page size also when we have finished the spreadsheet creation
and want to see the print preview of it. We can see the paper size option just above the
margin option. All the paper sizes will display when we click on this option. We can
change the required option and the changed paper size will be displayed in print
preview showing in the same screen.

Margin:In some cases, we may require to adjust the margin with the help of mouse.
To apply this way of setting margins in M5 Excel, we can use print preview option
displayed when we go to print option of File menu. We can see the dotted lines in this
print preview window of print option. If these lines are not showing there then we can
press “Show Margins™ button displaying at right bottom of the print menu. These
dotted lines can be moved with the help of mouse to adjust any of the margins being
displayed. When we change uny of the margin such a way, the print preview will be
updated accordingly.

Scaling:As we have discussed earlier in this chapter, Scaling is the process of
compressing or expanding the contents 10 be arranged on a specific page. We have
already discussed about this option in previous section of this chapter. We can change
any type of scaling we want from the scaling option shown as last option of Print
Preview Window,
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6.2 WORKING WITH DIFFERENT VIEWS IN MS EXCEL

View in any of the software refers to the way of how our working area in the application software
should look like. For example, when we start ereating any worksheet in MS Excel then it is convenient
to see the maximum working area. It is also very important to have our work done in such a size and
layout that is able to be printed on desired number of pages. To keep all these things on track, we can
use following different views available in MS Excel. Each one of them are very important as they have
different methods to represent our contents. We can use them at any specific time in a same spreadsheet
to have best management on our contents to the printing point of view. Let’s discuss different views
available in MS Excel to have best use of it.

There are five different types of views available in MS excel.
1. Normal View (Detault View) 2. PageLayout View
3. Page Break Preview 4,  Custom Views
5. Full Screen View

We can explain each one of these views as under:

| Normial View: This is a default view of MS Excel. When we open MS Excel then itis automatically
displayed in Normal View. This view is the easiest view to use for managing data, creating formulas and
formatting rows and cohumns. In this view of MS Excel, all the rows and columns header are displayved
just adjoining 1o the respective row or column, This made it more easy to work with these becanse we
can easily identify the name of row or column, This view gives the best zoom level to work with. So, for
the purpose of creating a new spreadsheet or editing an existing spread sheet with best use of formulas
or functions, this view is very much useful. We can change our view to Normal view from the View Tab
ribbon. The option to activate this view is located as a first option on this ribbon. We can see our
spreadsheet in Normal view as under.
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2. Page Layout View: As we can understand from its name, this view is basically concerned about
displaying our contents page wise to have best layout of our contents on each page. We use this view
of M5 Excel to add design elements to the headers and footers of a worksheet, such as company
logos, page numbers, document names, dates and times. These elements are notusually visible in other

view types, but will print with each page of the workbook. The main aim of using this view is to have
best

management of our spreadsheet on particular pages when printed. We can change our view to Page
Layout View from the View Tab ribbon. The option to activate this view is located as second option on
this ribbon. Our spreadsheet will look as follow when it is displayed in Page Layout View.
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Fig 6.12 Page Layout View

3. Page Break Preview: This view of MS Excel is mainly concerned with Printing of our
worksheet, This View is a very powerful print preview that allows us to manually move page
breaks and reorganize a worksheet into pages for printing. We can break off columns or rows in
exactly the best location by moving the blue lines which represent Page Break in MS Excel
2010. The arrangement of our contents on different pages will be exactly same as the sheet will
look like after printing. This View of MS Excel can be seen by selecting Page Break Preview
option of View tab ribbon which is located as third option on it. The screen will display as
shown in following figure when viewed in Page Break Preview.
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Fig 6.13 Page Break Preview

4, Custom View: We have discussed all the three views of MS Excel with having particular
importance of each other. But, if none of the views listed above is exactly what we are looking for,
MS Excel has added a further customizable view type, named Custom Views. This option allows
us to set the exact view and print settings we prefer and allows us to apply this view to other
worksheets, if required.

5. Full Sereen View: This view of MS Excel can be used with any of the currently active view.
The main advantage of using this view is that it can be used for maximizing our work area by hiding
everything else. We can see just the work area of spreadsheet along with row or column headers
when the sheet is viewed in this view. Let's have full screen from Normal view by clicking Full
Screen option of View Tab Ribbon.

Note: We can return to our previous view from Full Screen View by pressing ESC key from

6.3 PROTECTING WORKSHEET AND WORKBOOK

Protection in MS Excel refers to restrict our workbook or worksheet from unauthorized access.
For this purpose, we can:
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6.3.1 Protecting Worksheet:
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Fig 6.14 Sheet to be protected

Protect Sheet option in MS Excel is used to safeguard the data in our worksheet with the help
of setting up a password in it. We can lock any row, column or cells from any of the operation
been performed by unauthorized person. To prevent other users from viewing hidden
worksheets, adding, moving, deleting, or hiding worksheets, and renaming worksheets, we
can also protect the structure of our MS Excel workbook with a password too. The method of
protecting a worksheet can be a series of steps o be performed. Let's have a look on the
method of protecting & Worksheet in MS Excel.

When we are working with a worksheet, by default all cells are locked. It means that il we
protect the sheet as such, all the cells will become locked. 1f it is so then the sheet is not so
useful. To have best use in a protected sheet, we can unlock any group of cells. The unlocked
cell will be uble to be changed even in protected sheel, We can use the values of these unlocked
sheets in the formulas in locked cells also. It will increase the usability of MS Excel Worksheet.
We can protect the sheet as follows.

As we can see in the given figure 6.14, some cells are highlighted with vellow color. We can
create a Detail marks card of any student by changing these yellow highlighted cells only. Rest
of the cells are either pre-defined or automatically calculated. So, to have the best use of this
excel worksheet is 1o protect it from any accidental change,

First what we have to do is, Unlock the highlighted cells. For this purpose, select the cells and
then launch format cell dialog box from Font group of Home tab ribbon.

Note: We can select multiple cells with different location by pressing the Curl key while
clicking on the cells.
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Fig 6.15 Unlocking the required Cells
As we can see in the figure above, In the Tab “Protection”, Locked option is checked for the

selected cells. To keep these cells unprotecied even in protected sheet, remove the tick from this
option by clicking on it. Press OK button when the tick is removed.

Now, it is time to protect the sheet from unauthorized access. We can do this by selecting “Protect
Sheet” option from Review tab ribbon,
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Fig 6.16 Protecting Sheet

the “Protect Sheet” diulog box will appear. As we can see in the fig. 6.15, Two options ure
already checked which means that we can select any protected cell. No other operation can be
performed on protected cells. We cun optionally give password to the protection option so that
no unauthorized person can unprotect it. When we press OK Button, it will ask the password
again to confirm, Fill the same password and press OK again.

Now our sheet become protected and no change is allowed other then those yellow highlighted
cells. This is the main use of this feature 1o restrict the sheet from being changed.
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Note: When a sheetis needed to be unprotected again. We can choose Unprotected Sheet option
which will be appeared on the place of Protect Sheet when the sheet was not protected. If we have
given password while we protected the sheet. Tt will ask for that password. Such as:

17 e e Sty (A vt - Bl e B ——— — -
. — i . — o ey - P
AW ¥ s 3 . e i & -n - -
y Rl R SSNSESI . D g
e L R BT P ot ETE]
1 T
Fremeg g Lt sy
[ ] * Rkt
= I I!-irii i'.l L " | o] ’ - — T T T
i
§ A |
§ Tl g 1D T
s o e
4 Faha ligss
(RN
W Tisge we Dile iS00 | S Teelen i |
& Dnu A48 A bt Gl T
B o o,
.; 3 A
L ¥ Emmrdi s |
x ¥ EFF | i | A im (3 -
S ki - Sevsl | |
s 1 [FLRLAR [ e | e e £ -5 — el
|
= i | oah | ) & 1] a I I
5 1 |BOERCE | om e s [} |
= o neEE b -
L] o St .-_‘..'_:. | |
B |BOCHL BO LIE ] | = L |
o Bl Sl |
o T [COMPUTE S0 i | an [ m | o |
= o [oennpal w | [a] w| o
e S e 4 | o |Ar) e !}
& e el e i
Bilih =il bl

Fig 6.17 Unprotecting Sheet
After giving correct password the sheet will become unprotected when we will press OK button.

7.3.2 Protecting MS Excel Workbhook:

This option of MS Excel is ulso very useful to the protection point of view which can be used by
selecting a password to open an existing workbook of MS Excel. We can use Tool option of Save

As Dialog box for this purpose. Such as:
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Fig 6.18 Protecting Workbook
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After entering the password for both Open and/or Modify option, press OK button. Now Confirm
Passward opiion will be appeared for both these passwords. Afier confirmiation, the file will be saved
with protection optior.

Opening a protected Workbook : When we open a protected workbook, A “password” dialog
box will appear to authenticate the user.

If authentication is successful then workbook will be opened, otherwise an error message will be
displayed for the same.

-

Password

Sukdhi (DMC Format]. sy’ is protected.

Password:

Fig 6.19 Opening Protected Workbook

Now, we are capable enough to create a worksheet, applying formatings, creating own formulas,
uging functions, inserting different objects and finally protecting our workbook or worksheet in
several types. We can use all these options to have best use of MS excel spreadsheet in our day-
to-day activities.

POINTS TO REMEMBER
1. Page Layout tab provides some commands which let us control the way our content
will appear on a prinied page.
2. Margins are the empty space between the worksheet data and the left, right, top, and
bottom edges of the printed page.
3. Page orientation refers to how output is printed on the page. We can use either in
horizontal or vertical direction.

4. Two page-orientations are Portrait and Landscape,

5. Size option of Page Layout Tab is used when we want to adjust the contents of a
worksheet on a specific size of paper,

6. Page break option is very useful to manage our contents to be split among different

pages.

7. Scalingrefers to compress or expand the size of contents when printed on the specific
paper size.

8. View in any of the software refers to the way of how our working area in the application
software should look like.
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9.  There are mainly three views in MS Excel: Normal View, Page Layout View and Page
Break Preview.

10. Full Screen View of MS Excel can be used in any of these three views to have maximum
working area by hiding all the menus, ribbon and bars.

11. Protect Sheet option in MS Excel is used to safeguard the data in our workbook or
worksheet with the help of setting up a password in it

12. Protect Workbook option of MS Excel is very useful 1o the protection point of view
which can be used by selecting a password to open an existing workbook of MS
Excel.

13. Heuder/Footer option is used to add any particular content on the top or bottom of
each page in MS Excel.

(“5‘" EXERCISE
Oue: 1 Multiple Choice Question :
I  Which option belongs to Page Layout Tab?

A. Page Orientation B. Paper Size
C, Print Area D. All of these
T Which one i3 not a view in MS Excel?
A. Formula View B. Normal View
C, Page Layout View D. Page Break Preview
il is the empty space between the worksheet data and the edges of the
printed page.
A. Paper Size B. Print Area
C. Margin D. Print Preview
v appears on the top of each page in print preview and printed sheets.
A. Footer B. Header
C. Bottom Margin D. None of These
V' We can lock our cells from being accidently changed with the help of ___ Option.
A, Save As B. Save
C. Print Area D. Protect Sheet

Oue: 2 Wreite Troe or False:
I Workbook cannot be protected in MS Excel.
I We cannot remove Page Break once inserted.
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Il Page Orentations are of two types: Portrait and Landscape.
IV Margins can be on top, bottom, left, nght header and footer of a page.
V' We can use Print Area option to print a specific part of a Worksheet.
Que:3 Short Answer Type Questions:
I Whatdo you mean by Margin?
Write a short note on Page Orientation.
What do vou mean byScaling?
Give names of views in MS Excel.
What is the use of Page Break?
Que:d Long Answer Type Questions:
I Whatdo you mean by Page Layout? Explain three Page Layout options.
T Explain any two Views of MS Excel in detail.
Il What is Header and Footer? How will you apply Header and Footer in Excel?

| Lab Activity !

1. Designthe given format of Detail Marks Card and Protect it in such a way that only yellow
filled cells are able to be selected or changed. Our active cell should not be entered in any

< 2 g5 H

other cell.
2. Protect this workbook with a password to open it, The password to open this workbook
should be “LetsExcel”.
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E-GOVERNANCE

r—[ Objectives of this ﬂhapter}
7.1 Inroduction
7.2 Characteristics of Good Governance

7.3 E—Governance

7.4 Governance vs, E-Governance

7.5 History and development of E — Governance
7.6 Objectives of E - governance

7.7 E-Governance Models

7.8 Services of E - Governance

7.1 INTRODUCTION

Before we start learning E-Governance, we must know the meaning of governance. The concept
of “governance” is not new. It is as old as human civilization.”Governance” means the process
of decision-making and their implementation. Various actors are involved in governance. An
analysis of governance focuses on the formal and informal actors invelved in decision-making
and implementing the decisions. Government is one of the actors in governance. Other actors
involved in governance vary depending on the level of government. Following figure shows the
various levels of governance:

.||

National Level

State Level

Local Level

{ Urban (Municipality)
Rural (Fanchavat]

Fig 7.1 Levels of Governance
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7.2 CHARACTERISTICS OF GOOD GOVERNANCE:

Good governance is the processes of making and implementing decisions in a preferred way. It's not
about making “correct’ decisions, but about the best possible process for making and implementing
those decisions. Following are some of the important characteristics of a Good Governance:

L,

Good governance i3 answerable to the commmunity, for the consequences of decisions ithas
made.

Good governance is transparent which means that people are able to clearly see how and
why a decision was made.

Good governance follows the rule of law.

Good governance is responsive which means that government always tries to serve the
needs of the entire commumity timely and appropriately.

Good governance is effective and efficient in implementing decisions and follows processes
that make the best use of the available people. resources and produce resulis that meet the
needs of society.

Good governance is participatory. Anyone affected by or interested in a decision have the
opportunity to participate in the process for making that decision. This can be done in
several ways such as by providing community members with information. ask for their opinion,
given the opportunity to make recommendations or, in some cases, be part of the actual
decision-making process.

Responsive
Administration

Good

Excellant Public Transparent
Sarvices G overnance Administration

| |
i Administration
\ )

Fig 7.2 Characteristics of Good Governance
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7.3 WHAT IS E-GOVERNANCE:

E-Governance stands for Electronic Governance. The application of Information Technology (IT) and
communication for the purpose of govemance is commonly known as E-Governance. Using E-
Governance, government provides various types of services online to its citizens at their door step. E-
Governance has made the working of government more efficient and more transparent to its citizens.
Success or failure of any government depends on following major factors:

1. The way the govermment works.

2. Transparency inits working and information.

3. Communication to its citizen.
In E-Govemance, government makes best possible use of Information Technology to communicate
and provide information to citizens and businesses.

There are four pillars of E-Governance:

1.  Connectivity: Connectivity is required to connect the people o the services of the
government,

2.  Knowledge: Here, knowledge is referred to as IT knowledge. Government employees
and skilled engineers make it possible to work E-Governance in an efficient way.

X Data Content: To share information over the internel, government maintaing its
database which should have the data related 10 government services.

4. Capltal: Capital refers to the investment made by government to provide their services.

Due to widespread demand of E-governance and exponentially increasing size of data, new
technologies like Open source solutions and cloud computing need to be used in the working of
government. Today, electricity, water, phone and all kinds of bills can be paid over the internet.

7.4 GOVERNANCE VS E-GOVERNANCE:

We can differentiate governance and e-governance as given in following table.

GOVERNANCE E-GOVERNANCE
» Governance refers to the process of decision- |« F-Governance refers to the use of ICT
malking and their implementation without the in enhancing the range and quality of
use of ICT. - information and services delivered to

the public. in an effective manner.

o Itusesone-way communication protocol. o Ituses two-way communication
protocol.
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7.5 HISTORY AND DEVELOPMENT OF E - GOYERNANCE:

In India E-Governance originated during the seventizs. At that time government adopied its
applications in the areas of defense, economic monitoring and planning. The ICT was used to
manage data related to elections, census, tax administration etc. After that, with the efforts of the
National Informatics Center (NIC) all the district headquarters were connected during the eighties.
From the early nineties, e-governance has used IT for wider sectoral applications with emphasis
on reaching out to rural areas,

Earlier, a talk between a citizen and the Government takes place in a government office. But with
the advancement of Information and Communication technologies, work culture of government
offices have enhanced. Information and Comvmunication Technologies has made it possible to
locate service centers near to clients. Such centers may consist of an unattended kiosk in the
covernment agency, a service kiosk located close to the client outside the government agency. or
the use of a personal computer at home or office.

In all the cases public traditionally look for information and services addressing his/her needs. In
both cases quality and efficiency are of greatimportance. Therefore, the establishment of E-
Governance requires a good knowledge of the needs that exist in the society and that can be
offered using ICT.

7.6 OBJECTIVES OF E - GOVERNANCE:

The objective of E-Governance is to support and simplify governance for all parties - government,
citizens and businesses. In other words, E-Governance uses electronic means to support and
encourage pood governance. Therefore, the objectives of e-governance are similar to the objectives
of good governance.

The main objectives of E- Governance are:

1. To satisfactorily fulfill the public’s needs and expectations by simplifying their interaction
with various online services.

2. To facilitate a speedy. transparent, accountable, efficient and effective process for
performing government administration activities.

Here we can say that e-governance is more than just a Government website on the Intemet. Political,
social, economic and technological aspects are determined in E-Governance.

7.7 E-GOVERNANCE MODELS:

E-GOVERNANCE services can be shared between Government and Citizens, Businessman,
Government and Employees. These four models of e-governance are as:-

I. Government locitizens (G2C)

II. Government to businessman (G2B)
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III. Government lo employees (G2E)

IV. Government to government (G2G}

G2C |

/" E-GOVERNANCE

™.  MODELS

Fig 7.3 E-Governance Models

1. Government to Citizens (G2C):
This model of e-governance refers to the governiment services which are shared by citizens. In this
model, citizens visit the official government web-portals for accessing various types of services. This
model sirengthens the bond between government and its citizen. Type of services which are provided
by this model includes:

«  Payment of online bills such as electricity, water, relephone bills etc.

¢  Online registration of applications for different services like passport regisiration, applying

various types of licenses.

« Copics of land-record.

o Online filing of complaints.

e Availability of any kind of online information.
Il. Government to Businessmen (G2B):
Through this model, bond between private sector and government are strengthened. Tt is used by
businessinen to communicate to the government. Type of services which are provided by this
model includes:
Collection of taxes.
Rejection and approval of patents.
Payment of all kind of bills and penalties.
Sharing of all kind of information, rules and data.
5  Compluints or any kind of dissatisfaction can be logged.

B W 3 =

L. Government to Employees (G2E):

This model increases the transparency between government and its employees. Here, employee
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can keep a check on the functioning and working of government or vice-versa. Information shared by
this model includes:
o Al kind of data submission (attendance record, employee record eic.) from various
rovernment offices.
¢  Employees can file all kinds of complaints and dissatisfaction.
¢ Employees can access any kind of rule-regulation and information.
» Employees can check iheir payment and working record.
+ Employees can send all kind of applications online.
IV. Government to Government (G2G):
This model refers to the services which are shared between the governments. There is lots of information
that need to be shared between various government agencies, depariment and organizations, These
types of services or information includes:
| Sharing of information between police department of various state.
2 Exchange of government documents including preparation, approval, distribution, and
storage of all governmental documents, is also done through e-governance.
3 Most ol the finance and budget related activities are also performed through this model of
e-gOVeInance.
7.8 SERVICES OF E - GOVERNANCE:
Today area ol e-governance is very wide. E-governance services are provided by the center, state and
local governments for various sectors. From urban areas 1o rural areas, e-Governance has spread its
root everywhere. Either it is public or private sector, common man or businessman, all are heavily
dependent on e-governance services, Here we will go through different areas where e-governance is
widely used,
7.8.1 E-Governance Services at National Level:
E-governance services at national level are provided by Center Government of India. In a fast-growing
and demanding economy like India, e-governance has become essential. The rapid growth of digitalization
has led to incorporate technology into governmental processes. Some of the important E-governance
services at national level are:
 Banking Services.
o  Aadhar services.
»  Passport Services.
o Immigration & Visa Services.
»  Filing of mcome tax returns.
«  Payment of various types of taxes.

» Central Excise and Cusiom services.
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Digital land management systems.

Voter card services.

PAN Card services.

Digital India initiative.

National Portal of India.

Conducting various types of on line Entrance Tests by National Testing Agency (NTA).

Various projects at National Level:

1.

IRCTC (Indian Railway Catering and tourism Cooperation Itd. ) Offers online rail ticket
booking, and checking of ticket reservation status.
e-Pramaan is a National e-Authentication service which provides a simple, convenient and
secure way for the users to access government services via internet/mobile as well as for the
government to assess the authenticity of the users.

UMANG (Unified Mobile Application for New-age Governance) is a common, unified
platform, aggregating major government services (of Center, States, local bodies),
inclhading important utility services, to facilitate single point access through mobile
app anytime, anywhere.

DigiLocker ig an initiative of Ministry of Electronics & IT (MeitY) under Digital
India programme. Targeted at the idea of paperless governance, DigiLocker is a
platform for issuance and verification of documents & certificates in a digital way,
thus eliminating the use of physical documents.

7.8.2 E-Governance Services at State Level:

E-governance services at state level are provided by State Governments. In Punjab, to implement
the E-Governance projects for the overall benefit of the citizens Punjab Government has
established a society named Punjab State e-Governance Society (PSEGS). Its primary object is
to set up the necessary administrative, financial, legal and technical framework, implementation
of mechanism & resources in the State of Punjab.

Some of the main BE-govemance services at state level are:

e-District services such ag licenses, Complaints, electricity and water bill payments,
birth/death/caste/income certificates etc.

Agriculture services like providing information on quality pesticides, seeds, soil health,
market prices etc.

Commercial Taxes services like sale tax, development tax etc.

CCTNS-Police is an initiative in the depariment of Police in increase awareness of
various laws among public.
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Land Record service includes e-registries, e-fard, e-stamping etc.
Road Transport service is related to the management of state highway projects.

Employment Exchange serviee includes employroent assistance to both employers and
unemploved candidates.

Various projects at State Level:

I;

2.
3.
4.
o A

HRTC (Himachal Road Transport Corporation project) is for online bookings, cancellation
of seats, for enquiry about departure of buses, availability of seats and buses etc.

SAMPARK by Chandigarh government.
E-Suvidha by the government of Uttar Pradesh.
E-SEVA (Electronic seva) by Andhra Pradesh.
E-Mitra by the Government of Rajasthan

7.8.3 E-Governance Services at Local Level:

E-Governance at local level in a state may refer to the services provided by local bodies in different
sectors of rural and urban areas. In urban areas, these services are provided through Municipal
Corporations and Municipal Councils, whereas in rural areas, these services are provided through
Panchayats. All these services in rural and urban areas are controlled as per State and Center guidelines.

Some of the main E-governance services at local level are;

7.8.3.1 E-Governance Services in Urban Areas:

1.
2.

7

House Tax Assessment, Billing and Collection.

Maintaining records of Land & property. Certificates like Land sale Permission, Legal
heir certificate.

Issue of Passport Verification Certificate.
Issue of Birth or Death Certificates.

Registration & Attorneys of properties such as computerization of the Document registration
work at Sub Registrar Office.
Provide services such as issuance of certificales, issuance of orders in respect of Social

Security Schemes such as old age pension, widow pension, freedom fighter penston
efe.

Review and approval authority for site plans

Various projects in this area are:

I-q

SDO Suite by Assam government.

7.8.3.2 E-Governance Services in Rural Areas:

l.
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Conducting various welfare schemes for the poor and needy sections of the society,
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2

3,

To provide wage employment to the needy from amongst the poorest section of the rural
society.
Rural water supply and sanitation.

Various projects in this area are:

3
2.

E-GramVigwa Gram Project by Gujarat.
Rural Digital Services.

POINTS TO REMEMBER

¥
'

10.
1l
12
13.

“Governance” means the process of decision-making and their implementation.
Good governance is the processes of making and implementing decisions in a
preferred way. It's not about making ‘correct” decisions, but about the best possible
process for making and implementing those decisions.

E-Governance stands for Elecironic governance. The application of Information
Technology (IT) and communication for the purpose of governance is commonly
known as e-governance.

There are four pillars of E-Governance: Connectivity, Knowledge, Data Contents
and Capital,

Governance uses one way communication protocol whereas e-governance uses two
way communication protocols.

E-GOVERNANCE services can be shared between Government and Citizens,
Businessmen, Govermment and Employees.

G2C model of e-governance refers 1o the government services which are shared by
citizens.

G2B is used by businessmen to communicate (o the government.

G2E model increases the transparency berween government and its employees.
G2G model refers 1o the services which are shared between the governmenis,
E-governance services at national level are provided by Center Government of India.
E-governance services at state level are provided by State Governments.

E-Governance at local level in a state may refer to the services provided by local
bodies in different sectors of rural and urban areas.
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EXERCISE

Que:1 Multiple Cheice Questions:

144

Which is/are the levels of E-Governance?

A, National Level B. State Level

C. Local Level D All of the above
Which of the following is not a pillar of E-Governance

A. Capital B. Knowledge

C. Delay in Work D). Connectivity
E-Governance Services can be shared between Government and
AL Cltizens B. Government

C. Busincssmen D. Allof these

maodel of e-governance refers to the government services which
are shared hy citizens.

A G2B B. G2E

C.G2G D. G2C

E-governance services at National level are provided by
Government of India.

A, Local B. State

C, National D. All of these

Que:2 Write the Full Forms of the Following:

G2C I G2G I G2E IV G2B VIRCTC

Que:d Short Answer Type (Questions:

1
il
I
v
A

Define Good Governance,

What are the different levels of E-Governunce?
Write the name of Four Pillars of E-Governance,
Differentiate Governance Vs, E-Governance.
Write about the G2C model of E-Governance.

Que:d Long Answer Type Questions:

I

1
m
IV

132 §-

Write the main characteristics of Good Governance.

What is E-Governance? Explain the four models of E-Governance,

Make a list of various Services provided at National level of E-Governance.
What are the E-Governance Services in the Urban Areas?
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DATABASE MANAGEMENT SYSTEM

,—[ Ohjectives of this Chapter: ]
&. I Introduction
8.2 Data and Information

8.3 Database Terminology

8.4 File Processing System

§.5 DEMS

8.6 File Processing System vs DBMS
8.7 Componenis of DBMS Environment
8.8 Database Operations

8.1 INTRODUCTION

A daabase management system is an important tool for enterprise organizations that operate digitally
and rely on consistent. clean data to make decisions. While databases are cssential for data storage, it's
the DBMS that helps database users to modify, manage and make proper use of data of organizations.
DBMS systems are essential for businesses because they offer an efficient way of handling large amounts
of data. In this chapter, we will cover various aspects of databases and the systems to manage these
databases.

8.2 DATA AND INFORMATION

Data and information have an important role in the world of database management systems. So, first of
all we discuss these two basic concepts:

e Data (or Raw Data): Darta is raw and unorganized fact that requires processing to
make it meaningful. Various types of facts, figures, statistics ctc. that have no
particular meaning by themselves are known as Data.

Raw Data

Information

Raw Data |—1 > 'mml > {Processed Data)

Raw Data e

Fig:8.1 Concepts of Data and Information
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e Information (or Processed Data): Information is a set of data which is processed in a
meaningful way according to the given requirement.In simple words, we can say that

Information 14 the processed data.
Data vs. Information:
Data Information
* Data is raw and unorganized fact that » Information is processed data that does nol

requires processing o make it meaningful, | require any processing tomake is meaningful.

= Data does not have any specific purpose | * Information carmes a meaning

+ Data alone has no significance. * Information is significant by itself

* Dala is measured in bits and bytes. * Information is measured in meaningful
units like time, quantity, etc.

8.3 DATABASE TERMINOLOGY

Before going to discuss in detail about DBMS, it is necessary o know about various concepts and
terms that are used in context with database management systems. Some of the essential and imporiant
terms and concepts are explained belovw:

e  Atiribule: Itis the smallest unit of named data in a relational database. It may consist
of bits or bytes. It represents one piece of information about an object. Every atnbute
in a table has a unique name and a data type. This data type defines the type of values
that can be stored in that column. An Atribute is also known as a field or column or
data-item in a table.

o Hevord: Ttis acollection of named dats-items which represents a complete unit of information
in the table. A Record is also known as a Tuple.

Attributes
Roll No | Name Marks
101 Ram Singh 452
102 Mohan Lal 412 Record
103 Gurmeet Kaur | 512
104 Paramveer 402
Table: Students

Fig:8.2 Concept of Table, Atribute and Record
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o  [able: Table is the main component of database. It1s used 1o store data. A Table containg
rows which are called records. There may be more than one table in arelational database.
A table usually has a name. Every row in a table contains the same set of colurmms. A table is
also known as a Relation.

« Database: A database can be defined as the organized collection of interrelated data.
Dutabases are used to store the vast amount of data in various organizations, A datubase
provides organized struciure to store data electronically. Generally, data in the database

is organized into rows, columns and tables so that it can be easily accessed, managed
and updated.

8.4 FILE PROCESSING SYSTEM

File based systems are an early attempt to computerize the manual filing system. In this system,
data or record were stored in the form of flat files. These files can be created in simple text
editors. such as notepad ete. The information was stored with each field separated by space, tab,

comma, semicolon or any other symbol.

All files were grouped according to their categories; files use only related informations and each
file is named properly, For example; for storing Student information, Student files for each class
were bundled inside different folders to identify it quickly. Now, if we want 10 see a specific
Student detail from a file, what do we do? We must have to know which file will have the data,
we open that file and search for his details. Here we see the files: we can open it and search for
it. But imagine if we want to display student details what we will do. It is really a difficult work

to do. Now how will we open a file, read or update it?

These kinds of problems were arising in file processing system. Now we are going to discuss the
drawbacks of file processing system as follows:

e File Processing systems lead to duplicacy.
«  Datais isolated and separated in different files
« Poor data security 18 there in File Processing Sysiem.

o In the files, datu are stored in specific formal. say tab, comma or semicolon. If the
format of any of the file is changed, then the program for processing this file needs 1o
be changed.
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8.5 DBMS

DBMS stands for Database Management System. To overcorme all drawbacks of file processing
system, a new system called database management system was developed. A database management
system (DBMS) is a system software. It is used for creating and managing databases. The DBMS

provides us the facility to create, retrieve, update and manage data of the database. In simple

terms, we can say that DBMS is a software layer that prevides an interface between user and the

databasze.

%
=)
S

Fig: 8.3 DBMS relation with database & users

8.5.1 Advantages and disadvantages ol DBMS:
Advantages of DBEMS:

Redundancy is being controlled in DBMS, By having centralized database most of
the redundancy can be avoided,

When the same data is duplicated and changes are made at one site, which is not
propagated to the other site, it gives rise to inconsistency. These kinds of situations
can be controlled in DBMS.

Data is shared by multiple applications or by multiple users in DBEMS.

We don't have to worry about the loss of data because DBMS provides Backup and
Recovery options.

In DBMS, there 15 Restriction on unauthonized access to the database,

DBMS systems provide mechanisms to provide concurrent access of data to muluple
users.

Disadvantages of DBMS:

136 &

It is complex, so users must have to get training to use the database.

Higher impact of a failure so there is the possibility of data damage.

The cost of DBMS varies significantly, depending on the environment and functionality
provided, There is also the recurring annual maintenance cost.

An extra hardware 15 necded,

Conversion cost is very high of the DBMS.

It is not easy 1o move it Lo another locations due to hardware and software specifications.
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¢  DBMS is an extremely large piece of software. It requires substantial amounts of memory
in our PC o run efficiently.

8.6 FILE PROCESSING SYSTEMyvs. DBMS
There are following differences between DBMS and File system:
File Processing System DBMS

« File system manages and organizes the files [« DBMS is a software for managing the
in 4 storage medium within a computer. | database.

+ Redundant data can be present in a file {+ In DBMS there 15 almost no redundant data.
system.
* File system doesn’thave a crash recovery |« DBMS provides a crash recovery mechanism.
mechanism

* It doesn’t provide backup and recovery |. provides backup and recovery of data even
of data if it is lost. if it is lost.

* There is no efficient query processing in |« Efficient query processing is there in DBMS.
file system.
* There is less data consistency in file |4 [; has more complexity in handling as
system. compared to file system,
* Itisless complex as compared to DBMS. |. pRMS has more security mechanisms as
* File systems provide less security in| compared to file system.
comparison o DBMS.
* Tt is less expensive than DBMS, * It has a comparatively higher cost than a file
system.

In short. we can say that DBMS is better than the File based system for managing data.
8.7 COMPONENTS OF DBEMS ENVIRONMENT

DBMS components define and regulate the collection, storage. management and use of data
within a database environment. There are the following components that exists in the DBMS

environmernt:
ell

Fig: 8.4 Components of DBMS Environment
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Following is a brief description of these components:
a. Software:

Software refers to the collection of programs used with in the database system. It inclodes the operating
system, DBMS Software, application programs and utilities.

o  The operating System manages all the hardware components. It helps o run other
software on the compuers. UNIX, LINUX. Microsoft Windows etc. are the popular
operating systems used in database environment.

o DBMS software manages the database with in the database system. Oracle, DB2,
MYSOQL, MS Access and SQL Server ¢ic. are the popular DBMS (RDBMS) software
used in the database environment.

o Application proegrams and utilities software are uged to access and manipulate the
data in the database.

b. Hardware:

This component includes all the physical devices of database system environment. The most
important and necessary componern is a powerful computer system for processing a large amount
of data of organizations. It might be a mainframe computer or minicomputer in large organizations.
DBMS requires large amount of memory, A large secondary storage (HDD or RAID disks) is
essential to store the large amount of data in the database. Similarly, a large main memory (RAM)
is also required to handle the requests of multiple users.

¢, Procedures:

Procedures refer to general rules and instructions that help to design the database and to use a
database management system.

Procedures are used to setup and install a new database management system (DBMS), to login
and logout of DBMS software, to manage DBMS or application programs, to take backup of the
database, and to change the structure of the database, etc.

d. Data
It is the most imporiant component of the database management system. The main task of DEMS
is to process the data. Here, databases are defined, consuructed, and then daia is stored, retrieved

and updated 1o and from the databases. The database contains both the metadata (description
about data or data about data) and the actual (or operational) data,

e, Usery

The users are the people who control and manage the databases and perform different types of
operations on the datubases in the darabase management system.
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There are many types of users who play different roles in DEMS. Following are some of the common
types of DBMS user:

Application Programmers. The users who write the application programs in programming
languages to interact with databases are called Application Programmer.

Database Adminisirators: A person who manages and conirols the overall DBMS is
called a database administrator or simply DBA. The Database Administrator. better
known as DBA, is the person (or a group of persons) responsible for the wellbeing of

the database management system.

End-Users: The end-users are those who interact with the database management
system to perform different operations on data by using the different database
commands such as insert, update, retrieve or delete on the data, etc.

8.8 DATABASE OPERATIONS

Various types of operations can be perfortned m the databases by its different types of users.

Some users perform regular operations on the databases while some users perform operations Lo

control the various activities on databases. All these operations can be classified broadly into

three categories:

Drata Definition Operations; It incluodes those operations which are used to define,
modily or delete the data structures, such as tables etc., in the database. CREATE,
ALTER and DROP are the important commands to perform these operations. All
these commands on databases are usually performed by the Database Administrators,

Data Manipulation Operations: It includes those operations which are used to
perform day to day operations on the data stored in the database, for example: inserting
new records, editing records. deleting records or viewing records etc. INSERT,
UPDATE, DELETE, and SELECT are the important commands o perform these
operations. All these commands are usually performed by the end users of the database.

Data Control Operations: Tt includes those operations which are used to control the
activities on the database, for example: giving or revoking permissions (o user (o
perform selected operations on the selected tables. GRANT and REVOKE are the
main commands to perform these operations, All these commands on databases are
usually performed by the Database Administrators.

Database muanagement systems (DBMS) provides Structured Query Language (SQL) to perform
these operations on the databases.
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POINTS TO REMEMBER

10.

11.

12.

13,

14,
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Data is a raw and unorganized fact that requires processing to make it meaningful.
Information is the processed data.

Attribute is also known as a field or column or data-itern in a table. It is the smallest unit of
named data in a relational database.

ARecord is also known as a Tuple. It is a named collection of data-items which represents
a complete unit of informarion in the table.

A database can be defined as the organized collection of interrelated data.

In File ProcessingSystem, data or record were stored in the form of flat files.

To overcome all drawbacks of file processing system, a new system called database
management system was developed,

DBMS is a software layer that provides an interface between user and the database.

Procedures refer to general rules and instructions that help to design the database and
to use a database management system.

A person who manages and controls the overall DBMS is called a database
administrator or simply DBA.

The end-users are those who inleract with the database management system to perform
different operations on the data by using the different database commands such as
insert, update, retrieve and delete data, elc.

Those operations which are used te define, modify or delete the data struciures, such
as tables ¢ic., in the database are termed as Data Definition Operations.

Those operations which are used to perform day to day operations on the data stored
in the database are termed as Data Manipulation Operations.

Those operations which are used to control the activities on the database, are termed
as Data Control Operations,
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EXERCISE

Que:1 Multiple Cheice Questions:

is a raw and unorganized fact that requires processing to
make it meaningful.

A, Data B. Information

C. Database D. DBMS

A Record is also known as a

A. Column B. Auribute

C. Field D. Tuple

A person who manages and controls the overall DBMS is called a
A DBA B. End User

C. Database Designer D. Programmer
DBMS is a software layer that provides an interface between and
the .

A. Data, Information B.DBA, End User
C. User, Database D. Data, Database

refer to general rules and instructions that help to
design the database and to use a database management system
A Information B. Procedures

C. Application Programs D. Sysiem Programs

Que:2 Write the Full Forms:

I
1
11

DBMS
DBA
SQL

Que:d Short Answer Type Questions

<= dBgF=-

What is record?

Define Database.

Write the name of different types of users of database.
What do you know ubout DBEMS?

Write the name of various components of Database environment.
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Que:4 Long Answer Type (Questions:
I Write the differences between Data and Information.
I Explain the various components of DBMS Environment.
Il Differentiaie File Processing System and DBMS.
I Whatis DBMS? Explain any five advantages of DBMS.

Lab Activity

Write the name of various components of DEMS Environment.

o)
=
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Appendix-1

Lab Activity for Typing Practice in English

Exercise-1

asdfeg :1kjh asdfg dkjh asdfz :dkjh asdfg dkjh asdfg
asdfe dkjh asdfe J1kjh asdfg Jdkjh asdfe J1kjh asdfg
asdfg :dkjh asdfg Jkjh asdfg dkjh asdfg JAkjh asdfg
asdfg :lkjh asdfg Akjh asdfg :Akjh asdfg dkjh asdfg
asdly dkjh asdfg JIKjh asdflg :dkjh asdflyg JKjh asdfy

Exercise-11

Ask Fad Alsas Shad Lads Flags Flask

Jag Fag Fall Hash Glad Galls Salad

Jak Had Gaff Dash Gall Flash Slash

Sad Lad Adds Lash Hall Lakhs Dhalls

Dad Asks Alas Dall Fall Glass Shall
Exercise-111

gwert poiuy gwert poluy gqwert poiuy gwert poiuy gwert
poiuy qwert poiuy gqwert poiuy qwert poiuy qwert poiuy
qwert poiuy qwert poiuy qwert poiuy qwert poiy qwert
poiuy qwert poiuy gwerl poiuy qwert poiuy gwert poity
qwert poiuy gwert poiuy qwert poiuy qwert poity gwert

poiuy  gwert poiuy qwert poiuy qwert poiuy gwert poiuy
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Exercise-1V

awergfa :olupj: awergla :olupj: awergjla olupj:
aweryfa olupj: awergfa ;olpj); awergfa 01upj:
awerqfa :0lupj: awergfa :oiupj: awerqfa olupj;
awerqfa :0lupy): awerqfa :oiupj: awerqfa :olupj:
awergfa :olupj: awerqfa :01upj: awerqfa t0lupj:
Exercise-Y
Fish Dirks Oldest Apple Grade Falls Kodak
Rails Jaded Dead Usual Sales Filed Legal
lease Lakes Agile Isles Ahead Larks Roses
Forks Hedge Skill Rupee Grass Would Alpine
Jaded Liked Equip Quail Jokes Asked Walks
Fiddle Saddle Dead Filed Lakes Lease Legal
Exercise-VI
azxevf Ikmnbj azxevf Ikmnbj azxcvf lkmnbj
azxevt Ikmnhbj azxevl Ikmnby azxevt Ikmnhbj
azxevl Ikmnhj azxevl lkmnbyj azxevl Ikmnbyj
azxevl Ikmnby azxevl Ikminby azxevl lkmnbyj
azxevl Ikmnbj azxeyvl Ikminbyj azxevl Ikmnbj
Exercise-VII
Cat Jack Colour Neither Enemy Boat Calcutta
Not Have Joints Calling Voted Very Vineyard
Met Wind Nerves Enlarge Money Move Material
Men Verb Verbal Someone Marry Give Sterling
Bent Joint Jackets Examine  Thousand  Cylinder Assessment
King Carry Jumbled  Examined  Struggle Possible  Beginning
Zeal Night Booklet Gracious Grizzled  Frequent Meanings
Zero Tonic Cutting  Becoming  Zodiacal  Exponent  Doubtless
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Exercise-VII1

12345 098767 12345 098767 12345 098767

12345 098767 12345 058767 12345 098767

12345 098767 12345 098767 12345 058767

12345 098767 12345 098767 12345 098767

12345 098767 12345 098767 12345 098767
Exercise-1X

1.

0 op0 =) ol B P Gp 3

10.

Type the following sentence 5 times :

Lost lime is never regained

Get-up early and do your work

Today’s youth and tomorrow’s old

Age is a virtue when wisdom is with it.

Measure your word before it goes out of vou

My steps are measure

A friend in need is a friend indeed

Children are innocent and should be guided rightly.
Our Land has great sages who knew the etemal truth.

Truth never fails.

. The Quick Brown Fox Jumps Over A Lazy Dog

Exercise-X

Type the following paragraph 10 times :

Our flag is tri-colour. SAFFRON is the symbol of sacrifice and a string mind. WHITE
15 the symbol of purity, love and peace. GREEN is the symbaol of plenty and joy. We
hoist and salute our flag. We are ready to make sacrifices for our country. We want peace

and progress, We want to be pure.
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Lab Activity for Typing Practice in Punjabi (AnmolLipi)

Home Row Exercise-1

ST

Srezar
Sr=sar
Srzzar
Srzzar
Sresar

HomeRow Exercise-IT

JmHy  wEHOEWY BT

BHY

[ BHE

HHTEW

HETEW

YR

KL= R
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Grosar @ang
Emosar mEnw
Sroswr  wang
Srosar  Bang
Sresar  BEnd

SHE WHOEW

Y HETEW

Y HETEW

BUY HTEW

BHY HHOEW
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Second Row Exercise-1I1

gTE¥EdE

grEd7

FrggE

FTETT

gTET T

grege v i
grgge v f
FrEege v i
grege v
grege w i
gT€. 5 et
g7g 5 TT
- A T T
g¥§. 5 e T
gt€ 5 Y

@reazz €
@reazz @
@reazz @
@reazs @

Greggz @

APPENDIX
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T i

gTEdT

FgrEdg

Frgge

FT¥dT

FTETE

Second Row Exercise-IV

gt@. 5
gT8 &
gT§ &
5¥§. 3

gte. &

S f ouw

T T

&,
"

suy
¥

aj,
L

=

g

gtG. &
: i
97§ &
gt16§ &

gt§ 5

Home Row Second Row Exercise-V

miEg wvEw

Mt gew

wtrE gew

wtre gew

wtE gew

ﬂ[!
¥

o,
¥

al,
L
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Ll

gQoew

foemy Adeesy Telw gfmew

Gazsv=sz
Gazsvez
Gazsvez
Cazsvez

Cazag=sz

sfaee

Home Row Second Row Exercize-VI1

TEmTEAT HUUBE

we@e  wOw
nAfEe THEEH
HeT&e . uee
Gzfr  =bfw

wEgTe
AEweEr

wEaen

Home/Second/Third Row Exercize-VII

HFAdHGHEHA

FOHAGHEHA

HFOHEHEA

HFOHSHEA

HFOHSHEHA

HAITTEZSYE

HAWTEZIE

HMATWTESTE

HMAWTESTE

HMAWTESE

Fourth Row Exercise-VIII

12345 09867 Tl # 4w
“12345 09867 Y% 4y
"12345 09867 Tl# 4w
12345 09867 VL %4 %
12345 09867 T # 4w
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gomsr  Helw

gfgee Z=9Es

AL HER

T_®me wEulse

nHeEE  TO®ER

BEQRY  BEOew
TY ‘FY
Y ‘FY
Y ‘FY
Y Ty
Y Ty

i

- g D

-

o)

HE* ()
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Exercise-IX

ATfER Bud wF e feam
afuges oz Ag® wffomue ifs
HE™ Ham&T GETE et forrfamr
EEI g fefzom aifes fea™m Ut
faet s RECH) WY dHarg
wateefdt Wty HEw s Hates
Ayt A&SIHE UHsens AN AiZHTe
FrHETST niHfear Frev Tt HE=
aar s e i) fazrdt
firtus Ut fegmar TeIT fagem
Exercise-X
et wrateafirdt ufenrar & sy oinge s amurs i © fowr fagemt w2 Jardt fesmar

o it T swe iy, T aree i Sivr 37 Sfdee fi St vt S5 ufont 37 adifsse
firwr 13 7. wgaTie fing & w-fadtar an o wifiar sreene fanre otsr 9 fam ot eeadt
a3 fegrer Snda T fEeede 2 3o fa2 =t Jadft &0 fower soz fur § farr 3
fET Sa ot gt nirust d-ie & wug fai fifse 7F a2 ras 2 damdt i€ 39 e
fa@fa for mecdnwe gog Uaht gRlas ¥ @t 99 & 95 o s Quey
ga=rger )
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Appendix—Practice Lessons for Typing in Raavi Unicode Fonl

Unicode Font “Raavi” in key map
SRR EN R PR R
o o wﬂ‘ Ew a TEJ Y# || uw iwt || o || Pw iw Iw [

q & w o s O (L | 30+ yu ) i o @ p [ = 14 L)

AT sE LR F e - HE 1= Ky LE i E -
e o] s d d o rfs 9 0 b ia kd L= : d Tz i’

F 4 X d cz L bW N M < » 0 rr
s 1 x o M v & b ¥ n# m " e i “ /= et

Home Row Lesson without Using Shift Key

AG 5@ o oW F e c @ Ha I KW LW : B o
Sape 2 ¢ 3 i o 1o g0 hu i@ e T 14 3 <
Skh3baaabdVoqga@edggideheghageesl
dddgucdehgoghizdgecqadsodyazgdadsdd
ed8ccegohbivgdaeeadagaqgdadadeaddyg 3T
Fade3Ivvgabhbhhogeoogqiaddhdocascub
Tdafbhugazbhbhadhbheozheaadguyucsocd 3
BPeg3dhdaqadqiqgeh q2q3 Togad¥¥qgdean
d3dgu2f 01232y qd woagd ufeygldecdqgel g
Beaug@ wzgmaIazlzaeBidifigliary?
dc M @B ddw@edIfugeawmBilgeld wheafo2 I
1 dweddyyzgzfozgeezdfowegewzdfugyg3ss
@ YW ad el @B WIgw@ygeIfRagh 3 a a8 .
fa o 8 9 g0 q 29 329 W 3IWey I vl 93 9d aggd e
2y fyg fuzd 2y 2ad fae o3a fagz fu waae Iy =93 fle faaz By fie
e 793 fe @3 fe day f339 faeq o3 M 393 uod a9 fRag fee f@aq
93 foe Ju d39 foe ofie F9a Fa3 A9d Ju F9 d9 I3 foz fae d9a fum
fee 33 339 g7 wadd day ye 93 fae 3@ foe fom awa fagz K3 da9
fae @9a we vgg faa e g9 Iy Yodd ¢ad ¢ed da ddd da dud fad3
fagq fae 3 | wwe fagz 93 fue awa fee W33 393 F93 day ufewz fee
fagz fafe fuzg @va ulows 239 Yo 999 F9ad Yue Udad o3 faa woa 33
fae aaa wue wue fuz 393 wue fou fag3 A fow d9a 39 ga f939 da
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Home Row Lesson Using Shift Key

AT
2 G

DM
dQ

G
R

13
jd

Ky
kd

L g
|3

4
i ¥

. Ent
ais i 8 ¥

ifo hy

cdP G IcuafRegBeudegzcazsitelatbfe
smeGethesyuafceQuufsyyvayfean?t

cfemseasmegeRIcgesdyeecsaewegy Iy 3
PynGImIgIc@uEunacesytazfresafE
FIUNYI UM S EIRI YT YR I U MSTHE D
Y3 B ununmggeGIdes3nQEG8InmIam I
tee3tQuumacuesneaftesemyaas
W EYHIeGesssedfimMezGdiyraluyan

g weQ nifvz uz »ftz k@ weQ 3 ¢z Q¢ suwuz Gezn uze & el
e waQ uaQ wsus waQ »fQ 36w Qs oftw weQ =& Q3 wwua us
wftQ seuwe wy fogu wfe oy wftg wze wu Q3 fe senft wy wue
ﬁmmmwmmwﬁwﬂewﬁﬁam

BH5 @3 uFe seve »ifeQ fee uze 6w
senfe nfte guyz senfe G2 wfte

2EFEEE

sAgfy
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17 Row (Upper Row) — Practice Lesson using Shift Key

ow || ww || ew r & T8 || Y3 || uw 1w || ow || p3 {= }w |
™ lNeg | we leo |l eat|lcollye!llsallizllez|leallis]l 12l
gt agedle’ o ARE A FERA L L TAFB S

regg@ "ttt . 3@IER,IIIRIRA
g 09 8 AT A ITRATA I T T AITIATES
g sadta’agaad, cvqa,0esaA@, 3
3 FALCFIIIT AT FBRGqAFYEL
R I BRI - B (R B - R (O I - - A |
gaeAd ., .98e 7 gt wvdlzgwe’ aw
IATolBeadgaBeddgcldoBogdogeqy

ot
ux

g@ﬁ.ﬂrgg
24
==
% &
3
M

g
74
=
&




1* Row (Upper Row) — Practice Lesson using Shift Key

R
r ct

ad || wo
qd || wd

oq
0 e

Us
ud

|y
i d

E W
e OF

Tab

p® (7| Ja || W

Py ‘[i i} ]

TR || ¥?
¥ ¥

tg
GsmnguyuesdwessedQrsueAnsusasy
meemydeQouwesddmeudesiesgace
39838383 TUISERERTUESMNIITICTIIETSN
nsfssImddusyngusnsegRneyweesy
A ugITRIUuMITUSTHIQ U B wdA R A
eWIgdannufadyssuysusHgesaddan
sweruRnfwsseIvQusyfuesHIweug
Mgd3wm3dengesdowsyss@assgyd

e u@ew Q0 wy v WG TS Ew SUS e wEH §In oFu usa we

g8 #ig wEH Sws wrPl Sus @3 esr wigu Sus S8 olEu we e wieng
wign v s ay ol 5G e ¥y wigu W wm @Y SN wRIn am wmEs
ol ¥l wiEn usAl W@ wEd e wad W@ diy B@3 wm wiEn wsu os W@
Gu ¥lv =R w0 W QIu vIs Q9 Se wu G0 AU WU wed AR TR
w@ew #erQ WGEa Wl Aws UEe TUS3 werg HI83 whrf wsGH Wy 993
o TS VY Wik YT WYS ¥9n ol §90 ©NIU oW Yus Higs Pigs Vgs

g wju eop eop 58wl wad Fl oordl vwvu ws@el wvu el Aum e
o whis Q9 vensl wwr ves o WlEu oW s sl owd ws Qeu wvu ws
W9u Iy 3 wadl sus HIgs gus oS wus o GQan suuss wie wEd




X

=

£z

eM

B %
b=

M
mHu

e
=

2" Row (Buttom Row) — Practice Lesson without using Shift Key
i - “ 2
Shift =

£ ‘ =1

il

5 ®., 8%, .WT, TESE "BHH &H

EASHAEBE .S EAUEARARACGR.R ., g o
L, ¥ ® . BTWM A "W _.BEH.WBH,

HT.ZBT  HBBEA. , B " HAIITH. . ANAGS
SH, HEAAAAR® L, "AH, BEUB " T.B
EORFIERHEBEE .3 B BR , g0 oo &
AW "B AEEH  , " TREHBH,AABSHAH, ,

H

T EHA T HH R OTEIRRBEE S o0 . BAEH,, B .

wen da1 vl o s Wl dla woe Giz eall wer wal @i oy ¢ R R
Hamdl atad o Gl @ o9 A A W FoEl A e @ ol R Foa
A dl 3 ww e Fa Fa 3 g 3 war da wawd F oW 9N

W gg a4 da 3 o 8 dla W 3
W "I 93 ¥ di3 gign ¢ o Fa e v o Fa Fa 9B 9
Hamdl 331 J 33 Sova @ di3 3 val 9 e e giled o




2 Row (Buttom Row) — Practice Lesson using Shift Key

F Xd CZE || ¥ BE NE ME 3 b | [

e 2 xo || e¥ vE b || nE mR [a ks
¥ B ST TSI B BAEZ o | 6 ¢ EETE | I®H
P EZTETETREIZTIIETEERINET I ESEEERSE®
S BeEI o BTSN ES OB IlEREIRIE
T E® ) )o@ S Koo HETETTEHHFE TP ECS oA
T T HEHREET I EETE | ) g1 e EFTETH R ETT
B S I ER NI dEET T T T ETEELE IAEEE
B P88 ¢ 6o Fow® | E¥)IETILod|lodooo8r

ZETOoOROREHREBIIZTETZNIZTEOET o B ®

3 Row (Numeric Row) — Practice Lesson using Shift Key

gt || @am || #@|| s [[ww || [ E& et | 0] oo ||+
“tllraf[2a (|38 [|ew|[ sy || 6é || 70 llt 9t || oo f| <o || == || Dok

Character with RIGHT ALT Key
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Appendix-II1
COMMONLY USED FULL FORMS

Al ARTIFICIAL INTELLIGENCE

ARPANET ADVANCED RESEARCH PROIJECT AGENCY NETWORK

BMP BITMAP PITURE

bpi BITS PR INCH

CD COMPACT DISK

CPU CENTRAL PROCESSING UNIT

CSS CASCADING STYLE SHEET

CUI CHARACTER USER INTERFACE

DMP DOT MATRIX PRINTER

DOS DISK OPERATING SYSTEM

DRAM DYNAMIC RANDOM ACCESS MEMORY

DSL DIGITAL SUBSCRIBER LINE

DTP DESKTOP PUBLISHING

DVD DIGITAL VIDEO DISK

E COMMERCE ELECTRONIC COMMERCE

EEPROM ELECTRONICALLY ERASABLE PROGRAMMABLE READ
ONLY MEMROY

EMAIL ELECTRONIC MAIL

EPROM ERASABLE PROGEAMMABLE READ ONLY MEMROY

FTP FILE TRANFER. PROTOCOL

GB GIGABYTE

GIF GRAPHICS INTERCHANGE FORMAT

GuI GRAPHICAL USER INTERFACE

HTML HYPER TEXT MARKUP LANGUAGE

IAP INTERNET ACCESS PROVIDER

IBM INTERNATIONAL BUSINESS MACHINE

IC INTEGRATED CIRCUIT

[SDN INTEGRATED SERVICES DIGITAL NETWORK
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ISP INTERNET SERVICE PROVIDER

IT INFORMATION TECHNOLOGY

JPEG JOINT PHOTOGRAPHIC EXPERTS GROUP
KB KILOBYTE

MB MEGABYTE

MIDI MUSICAL INSTRUMENT DIGITAL IDENTIFIER
MODEM MODULATER DEMODULATER

MPEG MOVING PICTURE EXPERTS GROUP

MROM MASKED READ ONLY MEMORY

NIC NETWORK INTERFACE CARD

PB PETA BYTE

PC PERSONAL COMPUTER

PNG PORTABLE NETWROK GRAPHICS

POP POST OFFICE PROTOCOL

PROM PROGRAMMABLE READ ONLY MEMORY
RAM RANDOM ACCESS MEMORY

ROM READ ONLY MEMORY

RTF RICH TEXT FORMAT

SERP SEARCH ENGINE RESULT PAGE

SMTP SIMPLE MAIL TRANSER PROTOCOL

SRAM STATIC RANDOM ACCESS MEMORY

TB TERABYTE

TCP/IP TRANSMITION CONTROL PROTOCOL

ULSI ULTRA LARGE SCALE INTEGRATED CIRCUIT
UPS UNINTERRUPTED POWER SUPPLY

URL UNIFORM RESOURCE LOCATER

USB UNIVERSAL SERIAL BUS

VLSI VERY LARGE SCALE INTEGRATED CIRCUIT
WWWwW WORLD WIDE WEB

WYSIWYG WHAT YOU SEE IS WHAT YOU GET
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Appendix-I11
Commonly used shortcut keys
(MS word)

Shortcut Keys Used for

Crrl+A Sclect All

Ctrl+B Bold the selected text

Curl+C Copy the selected contents
Cul+D Opens the Font Dialog Box
Cul+E Center Align text

Cirl+F Find text

Ctrl+G Goto line/page no etc

Crrl+H Replace text

Ctrl+l Italic the selected text

Cirl4-] Justify paragraph

Crurl+K Create Hyperlink for the selected text
Cul+L Left Align the paragraph
Ctrl+M Increase Indent

Ctrl+N Create a New File

Cirl+0 Open Existing File

Curl+P Print File

Curl+0) Clear Indents and Tabs

Cirl+R Right Align the text

Cul+S Save File

Cul+T Increase Hanging Indent

Cirl+U Underline the selected contents
Ctrl+V Paste the contents from the clipboard
Cir+W Close File

Crrl+X Cut the selected contents

Crirl+Y Redo the last action (if possible)
Cul+Z Undo the last operation
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Ctrl-+1

Single Line Spacing

Ctri+2 Double Line Spacing

Cul+5 |.5 Line Spacing

Crrl+] Increase Font Size

Cirl+] Decrease Font Size

Curl+Shifi+C Copy the Formats of selected text
Cirl+-Shafti+V Paste the copied Formats on selected text
F3 Change Case

E7 Spelling and Grammar Check

Ali+F4 Close Program
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COMMONLY USED SHORTCUT KEYS
(MS POWERPOINT)

Shorteut Keys Used For

Alt + A Go to the Animations tab

Alt + F Open the File tab menu

Alt + F2 or F12 Open the Save As dialog box

All + G Open the Design tab

Alt + H Go to the Home tab

Alt + K Go to the Transitions tab

Alt + N Open the Insert tab

Alt + 0Q Directs to the “Tell me what you want to do” box
Alt + R Go to the Review tab

Alt + 8 Go to the Slide Show tab

Alt + W Go to View tab

Alt + X Go to the Add-ins tab

Alt +Y Go to the Help tab

Alt or FID Turn the key tips to “on' or ‘off”’

Curl + A Select all the objects on an active slide

Cul + Alt + V Open the Paste Special dialog box

Ctrl + B Toggle bold on the selected text

Cirl + C Copy the selected text, object. or selected shide
Ciell + D Duplicate the selected object or a slide

Cid + E Center align the selected text

Cul +F Search in a presentation or use Find and Replace
Ctrl + Fl Show or hide the ribbon

Curl + F2 Print Preview View

Ctrl + 1 Togele italics on the selected text

Ctrl + J Justify the selected text

Ctrl + K Insert a hyperlink

Cul + L Left align the contents

Cul + M Insert a new slide
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Shortcut Keys Used For

Cirl + N Create a new presentalion

Cul + 0O Open an existing presentation

Ctrl + P Annotate using a Pen tool while playing the slideshow
Crl + Q Save and close a presentation

Cul + R Right align the selectd text

Cirl + 5 Save a presentation

Col+T Display the Font dialog box after text or object 1s selected
Ctrl +'U Add or remove underline to selected text

Ctl +V Paste the selected text, object, or slide

Ctrl + W or Cul + F4 | Close a presentation

Ctrl + X Cut the selected text, object, or slide

Cul +Y Redo an action

Cul + Z Undo an action

Delete Delete the selected text, object, or shide

Esc End the slideshow

F5 Play the presentation from the start

5 ¢ Check for spellings

Home Go back to the beginning of the slide

N or Page Down Move to the next slide while playing the slideshow
P or Page Up Return to the previous slide while playing the slideshow
Shift + F5 Play the presentatin from the current shd

‘mifaa fanit, nifaarasr w2 ue farest fegrar’ Ui

APPENDIX # 161



